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Welcome to NetObjects Fusion 1

NetObjects Fusion™ is the first smart Web site production application that 

combines automated site building, database publishing, and professional-quality 

design features. Its visual, site-oriented approach to Web site authoring offers 

unprecedented efficiency and ease of use for users at all levels. 

You can use NetObjects Fusion to design and create an entire site without any 

HTML knowledge. When you preview or publish a site, NetObjects Fusion 

automatically generates the necessary HTML code. You can use NetObjects Fusion 

to design and prototype sites that will later be completed using other tools, and you 

can import sites created with other tools into NetObjects Fusion. NetObjects 

Fusion’s open architecture and support of HTML standards let you create sites that 

use scripts, Java™ applets, Shockwave™, digital video, and other rich media 

plug-ins. 

This chapter provides introductory information about NetObjects Fusion, 

including

● the User Guide

● on-line help options

● contacting NetObjects

● primary views

● preferences

● the NetObjects Web site
elcome to NetObjects Fusion 1-1
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A B O U T  T H I S  U S E R  G U I D E

                  
About This User Guide
This book addresses all aspects of building a Web site in NetObjects Fusion. It is 

organized by the main task areas of building a Web site. Additional chapters 

elaborate on special topics such as data publishing and using special NetObjects 

Fusion components.

Before beginning your own projects, read NetObjects Fusion Getting Started, which 

provides detailed installation instructions, an overview of features, and a tutorial. 

Going through the tutorial is the most efficient way to learn the basics of NetObjects 

Fusion.

All the learning products assume that you are a proficient Windows® 95, 

Windows NT™, or Macintosh™ user. If you need help using these systems, consult 

their respective user guides.

This guide also assumes that you are familiar with the Web and its terminology. For 

general advice about the Web and examples of how to use NetObjects Fusion, visit 

the NetObjects Web site, www.netobjects.com. 

For readability, this manual presents all filenames, pathnames, extensions, HTML 

tags, and URLs in boldface. Example names that you should replace with your own 

appear in italics. For simplicity, path names are shown only in the Windows format, 

which uses backslants, and are not repeated in the Macintosh format, which uses 

colons. This means that if you’re a Macintosh user and you see NetObjects Fusion 

2.0\User Sites\my site, you should interpret this as NetObjects Fusion 2.0:User 

Sites:my site and replace my site with the actual name of your site. Also, if you have 

upgraded your copy of NetObjects Fusion, its folder name might include an 

incremental version number that does not appear in pathname examples.
-2 Welcome to NetObjects Fusion



 

G E T T I N G  H E L P

                 
Getting Help
NetObjects Fusion offers many on-line help options. 

Help for Windows Users
NetObjects Fusion provides a full Windows help system to assist you while creating 

your site. This help system includes:

● a Windows Help version of the NetObjects Fusion User Guide

Select Help Topics from the Help menu to launch the help system and display the 

main table of contents.

● context-sensitive help

– To view help for objects in the workspace and controls in dialogs and 

properties palettes, right-click the item, then select What’s This? from the 

pop-up menu. 

Alternatively, to view help for dialog and palette controls, you can also click 

the question mark icon in the title bar and then click an item to display help.

– To view help for menu commands, highlight the command and press F1.

NetObjects also provides help on its Web site, which you can access from within 

NetObjects Fusion by selecting Help Overview from the Help menu. This displays 

the NetObjects Help Overview HTML page which appears in your browser. This 

page contains links to all the NetObjects Fusion support options, which include on-

line documentation, active newsgroups, usage notes, FAQs, and technical support.

Help for Macintosh Users
NetObjects Fusion provides a full AppleGuide help system to assist you while creating 

your site. To begin, choose NetObjects Fusion Guide from the ? menu. In the Guide 

window that appears, choose a method by which to search for information.

● Click the Topics button to choose a topic from a list.

● Click the Index button to choose from a list of defined keywords.

● Click the Look For button to enter and search for any word that interests you.
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Contacting NetObjects
There are three convenient ways for you to contact us. 

● Visit our Web site at www.netobjects.com for the latest information on 
NetObjects Fusion. The support section of our Web site contains many resources 
such as frequently-asked questions and detailed usage notes. See “Using the 
NetObjects Web Site” on page 1-10 for more information.

● Visit our e-mail based news groups, which you can access through the support 
section of our Web site. Review the various discussion threads for the topics that 
interest you.

● If you have a question on how to use NetObjects Fusion that is not covered in this 
manual, on the Web site, or by the news groups, send it via e-mail to 
support@netobjects.com.

NetObjects Fusion Primary Views
NetObjects Fusion uses five different views to let you design, create, and manage the 

various aspects of your site. They are arranged to guide you through the main steps 

of building a Web site. Changes made in one view are reflected in the others. 

● Use the Site view to create the overall site structure.

● Use the Page view to add content and special designs to your pages. 

● Use the Style view to apply a site-wide visual theme.

● Use the Assets view to manage your files, links, data objects, and variables.

● Use the Publish view to stage or publish your completed site.

In each view, you can double-click the title bars of the Tools or Properties palettes to 

reduce them to just their title bars. And, you can use the Undo command repeatedly 

in Page view to step back through a series of changes.

Moving Around in NetObjects Fusion
As you construct your site, you can move freely from page to page and from one 

view to another using the control bar, menu commands, and keyboard shortcuts. 
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Open any view at any time by clicking one of the view buttons in the control bar at 

the top left of the screen. The buttons on the right of the control bar provide 

additional shortcuts.

Figure 1-1. Control Bar and Secondary Control Bar

To create a new object specific to the current view, click the New button. 

In Site and Page views, New creates a new page; in Style view, it creates a 

new SiteStyle; in Assets view, it creates a new asset.

To search the entire site for any named NetObjects Fusion object (a page, 

layout, style, data list, and so on), click the Go To button and enter the 

name of the item you want to see.

To return to the previous view, click the Last button. The Last button is 

not a sequential “Back” button; clicking Last twice redisplays the current 

page or view. This button allows you to quickly switch back and forth 

between two pages.

In the Site view, you can immediately open a Page view by double-clicking a 

page icon. In Page view, you can quickly follow a link to its destination page by 

holding down the Alt key (Windows) or z key (Macintosh) and double-clicking the 

linked object.

In the Page view, use the buttons at the lower left corner to move from page to page. 

You can move up, down, left, or right within your site without leaving the Page view.

Figure 1-2. Page Navigation Buttons

Site filename

Menu bar

Control bar

Secondary control 
bar

New LastGo toPreview

Go to sibling page to right

Go to sibling page to leftGo to first child page

Go to parent page
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The Go menu provides all the navigation features in one place and shows equivalent 

keyboard shortcuts.

Figure 1-3. The Go Menu

The first five commands open any of the views. The next four commands switch 

between pages. The Go To… command offers a keyword search. The Last command 

opens the last page or view you were working on. Use the Recent… command to 

select from a list of the views and pages you’ve displayed during the current 

NetObjects Fusion session.

Preview
At any time during your site production process, click the Preview button in 

the control bar to quickly check the results of your work.

Preview displays your whole site in the browser you specify in the Preferences 

dialog. To quickly preview just the page you are working on, hold down the Control 

key while clicking Preview. 

If you are optimizing your site for multiple platforms or browsers, hold down the 

Shift key while clicking Preview. On the Macintosh, hold down the Shift key until 

the browser opens. This makes HTML table borders visible in your preview, which 

can help you identify and correct problems. Table borders never appear when you 

stage or publish, but you can also check them in Page view as described in 

Chapter 4, “Designing with Text and Graphics.”

Keyboard navigation 
shortcuts
-6 Welcome to NetObjects Fusion



 

P R E F E R E N C E S

  
Previewing creates folders and files on your disk, but they do not comprise a 

working site. Certain information critical to a published site—for example, relative 

paths for assets—are not included in preview files. By not including this 

information, previewing can display your site for testing more quickly than staging 

or publishing. When you’re satisfied with your preview, go on to stage and publish 

your site as described in Chapter 14, “Staging and Publishing a Site.”

Preferences
You can change your preferences at any time. Changes take place immediately and 

apply to the current site only. Preferences are saved with the site.

To set preferences

1. Choose Preferences… from the Edit menu.

NetObjects Fusion displays the Preferences dialog.
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2. Set your general preferences.

● AutoSave. If you deselect AutoSave, save your site periodically by 

choosing Save Site from the File menu.

● Window Maximized at Startup (Windows) or Use full-sized 

window at startup (Macintosh). If you deselect this option, the site 

opens in the last size you set.

● Choose the Web browser for Preview by selecting it from the 

Browser drop-down list. On the Macintosh, click the Add… button 

to add a non-listed browser.

● Choose whether to Preview the Current Page or the Entire Site. 

Previewing the entire site takes longer but lets you use your site’s 

navigation buttons to move from page to page in your Web browser.

● Choose whether Page view should display text spacing as it will 

appear in either Netscape Navigator™ or Microsoft® Internet 

Explorer™. These browsers space text differently though they use 

identical HTML. 

● To choose an HTML editor, click Browse… (Windows) or Select 

(Macintosh). You can launch the selected editor from within 

NetObjects Fusion by double-clicking on an External HTML page 

in Page view.
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3. To set your Page preferences, click the Page tab.

4. Click the appropriate Font button to set default proportional and 
monospace fonts.

So that your pages appear in your Web browser the way you design them 
in NetObjects Fusion, be sure to choose the same font settings in your 
browser. For example, if you use Times, size 12, and Courier, size 10, for 
your Web browser proportional and monospace fonts, choose the same 
ones in NetObjects Fusion.

5. Set your default page size by specifying a width and height.

When you add a new page to your site, it will have this size.

6. Set Background Image Offset in pixels.

Some Web browsers add a border to the page display, moving any 
background image the thickness of the border, which can vary from six 
to sixteen pixels. If the alignment of foreground page elements with a 
background image is important, use this setting to compensate for the 
shift of your background image.
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Background Image Offset works by clipping the set number of pixels 
from the left and top of the background image. The default settings are 
optimized for Netscape Navigator and Microsoft Internet Explorer.

7. If you wish, select the Auto-resize Margins (Windows) or Drag and 
Drop Layout Borders (Macintosh) option. When set, you can drag the 
MasterBorders boundaries to set margin size as long as no elements are 
in the way. If you don’t set this option, you must use numeric properties 
to set the MasterBorders size, although MasterBorders always expand 
automatically to accommodate any large element you place inside them.

Using the NetObjects Web Site
The NetObjects Web site, located at www.netobjects.com, is the primary 

communication channel between NetObjects and its user community. Frequent 

visits to the site will ensure that you stay on top of the most current product 

information while becoming familiar with the ongoing development of NetObjects 

Fusion.

An ever-changing example of the power of NetObjects Fusion, the Web site is built 

and continuously updated with the application. As you browse the site, notice how 

it takes advantage of the ability of NetObjects Fusion to integrate navigational 

elements with custom navigational needs and interface design.

Visit the following areas:

● About NetObjects

Learn about the NetObjects company, its management team, and job opportunities. 

NetObjects is working with a growing number of key companies in the computing 

and Internet world. The results of these partnerships are important to users of 

NetObjects Fusion, and this and other corporate information is continually 

updated and presented on the Web site. NetObjects press releases appear first on-

line, and a comprehensive index of articles and reviews can help you learn what 

other people think of NetObjects Fusion.
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● Products

These pages describe product features, list comparative analyses, and answer 

frequently asked questions about NetObjects Fusion. Free, downloadable extras 

such as styles, templates, and other design parts are available.

NetObjects also posts “pre-release” versions of both Macintosh and Windows 

applications as soon as the software is stable enough to allow users to work with new 

features and provide feedback and bug reports. 

● Support

NetObjects posts comprehensive usage notes on key product features and 

functionality. Usage notes provide in-depth technical tips, tricks, and solutions for 

high-end Web site development. NetObjects develops these usage notes in response 

to user feedback and to augment the information provided in the user manuals. On-

line documentation includes a browser version of the NetObjects Fusion Getting 

Started manual and downloadable text and Adobe Acrobat™ versions of all manuals.

You can join discussions between other NetObjects Fusion users and the NetObjects 

Support team via the various news groups on the Web site. To help us design and 

ship the best products, we also give you the opportunity to electronically report any 

bugs that you find in NetObjects Fusion.

● Download

NetObjects posts fully-functional, time-limited “trial” versions of its software. Users 

can build sites using trial software and can expect full compatibility with the 

shipping version of the product. 

● Customers

NetObjects continually updates its showcase of NetObjects Fusion users. Read in-

depth profiles of people from all walks of life who are using NetObjects Fusion to 

create Web sites that support their personal, social, or business objectives. You can 

also review a growing index of sites created with NetObjects Fusion to get an idea of 

what other people are doing with the software.
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Constructing and
Managing a Site 2

The NetObjects Fusion Site view is a visual site-structure editor where you create 

the hierarchy of your site’s sections and subsections. You can drag a page or section 

to any location in a site, and NetObjects Fusion updates its links to other pages 

automatically. The Site view lets you focus on organizing and updating the 

information of your Web site by freeing you from the details of files and links.

This chapter describes the Site view and its automated site-building capabilities, 

including

● constructing a site

● site tools

● starting with a blank site

● opening an existing site

● starting with a template

● starting with an imported site

● adding, deleting, and moving pages

● renaming a page

● exporting a site as a template

● importing a template or site

● sharing NetObjects Fusion site files

● working with a site

● printing the site structure

● working with the outline

● site management information

● making a backup
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Constructing a Site
In the Site view, the pages of your Web site are represented by page icons. The Site 

view is where you work on all the pages and their relationships. To add content to a 

particular page, use the Page view to work on one page at a time. When you construct 

a site, you typically go back and forth between the Site view and the Page view. 

A page is always selected in the Site view. The selected page is indicated by a blue 

border. You change which page is selected by clicking another page icon.

The Site Tools
Three tools help you work in the Site view:

Selection. The Selection tool lets you select page icons and drag them to 

new positions. Also use the Selection tool to select and change page 

names.

Zoom In. Zoom in to enlarge the view.

Zoom Out. Zoom out to see more page icons.

You can reduce the Tool palette to its title bar by double-clicking the title bar. 

Restore it with another double-click.
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Starting with a Blank Site
You can start building a new site from one home page.

To start with a blank site

1. Choose New Site… from the File menu.

2. In the New Site dialog, enter a site name.

The site name serves as the file name for storage. It is also the name of 
the subfolder that stores the NetObjects Fusion site (.nod) file and the 
assets for the site.

3. To save the site file somewhere outside the NetObjects Fusion folder, 
click the Change… button to choose another folder. 

4. Click OK.

NetObjects Fusion creates a folder with an .nod file and an Assets folder. 
The default folder location is NetObjects Fusion 2.0\User Sites.

The Site view opens with the Blank Site.nft template and displays a Home 
page. You are ready to begin adding pages to create your site’s structure.

Opening an Existing Site
You can open any site you have named in NetObjects Fusion as an .nod file.

To open an existing site

1. Choose Open Site… from the File menu.

The Open dialog appears.

2. Select an .nod file and click Open.

Note: As you open and close sites in NetObjects Fusion, a list of the most recently 
used site files is created and displayed in the File menu. NetObjects Fusion 
remembers the last four site files opened.
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Starting with a Template
A template is an existing site structure or page design file that has the extension .nft. 

NetObjects Fusion offers a set of templates for sites and pages that you can use as 

starting points for your work. An AutoSite™, located in the NetObjects Fusion 

2.0\Templates folder, provides a complete site structure with designed pages and 

suggested content. A page template is a professionally designed single page or form 

containing generic content that you can replace with your own information. You 

can also start with a template you’ve created yourself as described in “Exporting a 

Site as a Template” on page 2-13. 

You can select any of the AutoSite and page templates that accompany NetObjects 

Fusion when a new site is created. They can also be inserted into an existing site file. 

Note: All new Blank sites you create are also based on a template. When you select the 
default Blank setting in the New Site dialog, NetObjects Fusion bases your new site 
on the Blank Site template (Blank Site.nft) that resides in the AutoSites folder. To 
adjust the default settings of a new blank site, make a backup of the standard Blank 
Site.nft that resides in the AutoSites folder, open a new blank site named Blank 
Site, make the adjustments you want, export the site as a template, and replace the 
default Blank Site template and folder in the AutoSites folder with your own.

To start with a template

1. Choose New Site… from the File menu.

NetObjects Fusion displays the New Site dialog.

2. Enter a name for the site in the Site Name field.
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3. Select AutoSite Template and choose a template from the list.

This list presents the .nft files found in the AutoSites folder. To use a 
template stored elsewhere, select Other Template and browse for the file.

4. Select an AutoSite or page template from the displayed list.

5. To save the site file somewhere outside the NetObjects Fusion 2.0 
folder, click the Change… button to choose another location.

6. Click OK.

NetObjects Fusion creates a folder containing a new .nod file in the 
folder identified at the bottom of the dialog. The default location is 
NetObjects Fusion 2.0\User Sites\your site name.

The Site view opens, displaying the page icons of the site (or a single 
page icon if you selected a page template).

You can now modify the site’s structure by adding, deleting, moving, 
and renaming pages.

Note: The first time you work with an AutoSite or page template, explore the 
individual pages in the Page view before you delete or rearrange them. These pages 
include helpful content.

Select a template from 
the AutoSites folder.

Click to select an 
alternative location 
for site file storage.

Type a site name.

Click to select an AutoSite 
or page template.
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Starting with an Imported Site
The New Site dialog also offers the option of starting with an imported site. If you’re 

new to NetObjects Fusion, this can help you carry forward any sites you might have 

created elsewhere. 

To import an existing site

1. Choose New Site… from the File menu.

The New Site dialog appears:

2. Enter a name for the site in the Site Name field.

3. Click either the Local or Remote Site Import option and click OK.

Click to import via URL.

Type a site name.

Click to import from your 
disk or LAN.
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One of two dialogs appears. They are identical except for the Home Page 
field.

4. For a local site, enter the path to the site’s home page and its domain 
name. For a remote site, enter the site’s URL and make sure your 
Internet access is active.

When importing a local site, NetObjects Fusion needs the domain name 
to resolve relative vs. hard-coded path names.

5. Choose whether to convert the imported pages to NetObjects Fusion 
format.

When you convert pages to NetObjects Fusion format, NetObjects 
Fusion places their content in the Layout area of the corresponding new 
NetObjects Fusion page. The MasterBorders of each new page have the 
characteristics of the NetObjects Fusion 2.0\Templates\Autosites\
Import\import.nft template. When the import is complete, you will be 
able to edit the imported pages in Page view as you would any page you 
create in NetObjects Fusion. For example, you can edit the default 
MasterBorder and see the changes reflected on all pages or create and 
assign a new MasterBorder to different pages as needed.

When you do not convert the imported pages to NetObjects Fusion 
format, NetObjects Fusion imports all the site section’s assets and marks 
each page as External HTML. It does not add SiteStyles or 
MasterBorders and thus preserves the appearance of each page. You can 
manage the page’s location in the site as you would any other page even 
though its icon appears shaded in Site view. However, you cannot edit an 
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external page in Page view; a large X covers the page. If you double-click 
the X, the HTML of the external page appears for editing in the default 
HTML editor selected in the Preferences dialog. If later you decide you 
want to edit the page in Page view, you can use the Import Page 
command, which makes the page internal and adds MasterBorders and a 
SiteStyle.

6. Choose the maximum number of pages to import.

NetObjects Fusion starts with the site’s Home page and stops importing 
when it reaches the end of the site or completes the number of pages you 
specify.

7. Choose how many levels to import.

NetObjects Fusion imports as many pages as possible at a higher level 
before going to a lower level.

8. Click OK.

NetObjects Fusion imports the number of pages you specified from the 
site. Complex pages take longer to import. If you have chosen not to 
convert the pages to NetObjects Fusion format, the pages are stored in 
NetObjects 2.0\User Sites\Site Name\Import\www.domain.com.

9. If you selected the Convert pages to NetObjects Fusion format option, 
switch to Page view and verify that each page appears as you expect. 

Some pages will convert more accurately than others, and pages with 
frames will not convert. Check your pages carefully and make sure no 
imported objects are overlapping by choosing Select Overlapping 
Elements in the Page view Page menu. Adjust font size and style if 
needed, and add NetObjects Fusion navigation bars and banners as 
appropriate to your design.

NetObjects Fusion imports all assets such as Java applets, Shockwave, 
and other rich media. If you have converted to NetObjects Fusion 
format, these should appear in place in Page view. It does not import 
client-side image maps or manage server-side resources. This means that 
if the imported site used a resource on its server such as a CGI script, you 
must manually set up your server with those resources. 
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Adding, Deleting, and Moving Pages
Modify the structure of a site by adding, deleting, and moving pages. NetObjects 

Fusion automatically changes the links between pages when you modify the 

structure.

You can add, delete, and move pages at any time. You can change a page’s location in 

the hierarchy by dragging its page icon to a new location. Child pages of a dragged 

page move along with the parent page.

To add a page

1. In the Site view, select the page you want to be the parent of the new page.

2. Click the New Page button in the control bar, press Insert (Windows) or 
zN (Macintosh), or choose New Page from the Edit menu.

The new page appears just beneath the page you selected. The new page 
is named “Untitled.”

You can create as many new pages as you like.

To delete a page

1. Select the page you want to delete and choose Delete Page from the Edit 
menu or press Delete.

2. Click Yes to confirm the deletion.

Any child pages of a deleted page are also deleted.
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To move a page

1. Select the page you want to move by clicking it.

2. Drag the page to its new location.

A moved page will be either a sibling or a child of a target page.

As you drag the page, NetObjects Fusion highlights the target page in a 
red border and shows whether it will be a child or a sibling page by a red 
triangle on the border.

● A triangle pointing to the side of the target page shows it will 

become a sibling of the target page.

● A triangle pointing to the bottom of the target page shows it will 

become a child of the target page. 

Renaming a Page
You can rename a page to give it an appropriate title that clearly suggests its 

contents.

When you publish your site, NetObjects Fusion uses the page name as the HTML 

filename for the page. Any time you preview, stage, or publish, it converts any spaces 

and non-alphanumeric characters except periods (.) and hyphens (-) in the title to 

underscores (_) in the filename. 

A triangle on the side 
of the target page icon 
shows that the moved 
page will be a sibling.

A triangle on the bottom 
of the target page icon 
shows that the moved 
page will be a child.
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By default, banners and navigation buttons use the page name. If you wish, you can 

specify different names to be used for your title, banner, navigation buttons, and 

HTML file extension by clicking the Custom Names… button in the Page tab of the 

Properties palette.

If you give two pages the same name, NetObjects Fusion adds a numeral to the 

filename when it creates the HTML files. For example, if you have two pages named 

“Great,” upon previewing or publishing, NetObjects Fusion creates great.html and 

great1.html. 

To rename a page

1. Select the page you want to rename.

2. Change the name directly on the page icon or in the Name field in the 
Page tab of the Properties palette.

● To change the name on the page icon, click the page name text to 

highlight it. Then edit the name.

● To change the name in the Name field in the Page tab, click the page 

icon to select it. Then edit the name in the tab.

3. When you are finished, click anywhere outside the page icon or press 
Enter (Windows) or Return (Macintosh).
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To specify custom page names

1. Select the page you want to reference by a custom name.

2. On the Page tab, click the Custom Names… button.

The Custom Names dialog appears.

● If you want the title of the browser window for this page to have a 

custom name, type it as the Title.

● If you want all automatic navigation buttons that reference this page 

to display a custom name, enter it as the Button name. 

● If you want the banner for this page to display a custom name, type 

it as the Banner name.

● To assign a different extension to the HTML file for this page, enter 

it as the Extension. For this page only, this overrides the extension 

specified in your Publish settings’ Configure Publish dialog.

3. When you are finished, click OK.
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Exporting a Site as a Template
You can save any site as a template in order to use its style or content in another site. 

If you use the template when you create a new site, any pages subsequently added to 

the site will take on the SiteStyle of the template. If you use the template to transfer 

pages to another site, the transferred pages will take on the SiteStyle of the other site. 

If several people will be working on a site, you can design a page layout and style, save 

it as a template, and then distribute the template folder and let other contributors 

build their pages based on the original template. Template files have an .nft 

extension. To share a custom SiteStyle, you must distribute your style folder as well.

Note: All .nod files have absolute asset pathing information. This means that 
NetObjects Fusion finds all assets based on their exact address on your hard drive. 
Moving your document to another machine changes the address of your assets. All 
.nft files convert these absolute paths to relative paths. Therefore, saving a site as a 
template (.nft) is the only way to share sites with other NetObjects Fusion users. For 
more information, see “Sharing NetObjects Fusion Site Files” on page 2-18.

To export a site as a template

1. In the Site view, choose Export Template… from the File menu.

NetObjects Fusion displays a Select Folder dialog. 

2. Select the folder in which you want to store the template folder and click 
OK. On the Macintosh, click the Select folder name button.

Note: Do NOT save a template to your desktop or the root of your hard 
disk. Always save it to a separate empty folder. To make your template 
appear in the list of templates available in the New Site dialog, save it in 
the NetObjects Fusion 2.0\Templates\Autosites folder.

NetObjects Fusion creates a new folder using the site’s name as the folder 
name. Into this folder it places a template file with an .nft extension, the 
site .nod file, and an Assets folder containing all the assets of the site.

The current site remains open.
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Importing a Template or Site
To add pages to your site that have already been developed elsewhere, you import 

them as a section. To import the contents of a single HTML file into a blank page, 

use the Import Page command in Page view as described in “Importing Pages” on 

page 4-20.

You can import any of the following into your site: a page template, an AutoSite, a 

NetObjects Fusion template that you or one of your colleagues has developed, or 

pages from an existing site stored either on your local disk or on a remote server. 

Importing NetObjects Fusion templates is a way to consolidate distributed work 

such as when several people develop different parts of a site. When you import 

templates, all imported pages take on the SiteStyle of the current site. So, when each 

person saves his or her work as a template and all the templates are imported into a 

single site for publishing, the published site will have a consistent look and feel 

overall.

You can import templates from previous and cross-platform versions of NetObjects 

Fusion. When you insert a 1.0 template into a 2.0 site, some features are 

automatically converted. For example, headers and footers are converted to 

MasterBorders. 

Importing pages from an existing site can help you take advantage of work you’ve 

already done. For example, if you are new to NetObjects Fusion, you can import 

sites you might have created using other tools. Be aware that importing a complex 

site might take more processing time than you expect. If you created the site in 

NetObjects Fusion, it is far more efficient to import it as a template than to import 

the published HTML pages.

To import a template

1. In the Site view, select the page under which you want to insert the 
template.

The selected page will be the parent of the imported page or pages.
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2. Choose Import Section… from the File menu.

3. To import a page template, select it from the list.

4. To insert an AutoSite or a template you or one of your colleagues has 
developed, click the Other Template option and the Browse… 
(Windows) or Select… (Macintosh) button. Select the template you 
want and click Open.

5. Click OK in the Import Section dialog.

The page or pages you imported appear in the Site view. The page data 
and all assets are stored in your current site folder. The original template 
is still available in case you need to use it elsewhere.

Note: When choosing to insert a template, remember that it begins with a single root 
page. This root page was the Home page in the site from which it was exported. This 
is not a problem if you are adding the template as a branch to your site. However, if 
you want the Home page of your site to look like the Home page of your template, 
open a new site based on the template rather than importing it.

To import an existing site

1. In the Site view, select the page under which you want to insert the site.

The selected page will be the parent of the imported page or pages.

2. Choose Import Section… from the File menu.

3. Click either the Local or Remote Site Import option and click OK.
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One of two dialogs appears. They are identical except for the Home 
Page field.

4. For a local site, enter the path to the site’s home page and its domain 
name. For a remote site, enter the site’s URL and make sure your 
Internet access is active.

When importing a local site, NetObjects Fusion needs the domain name 
to resolve relative vs. hard-coded path names.

5. Choose whether to convert the imported pages to NetObjects Fusion 
format.

When you convert pages to NetObjects Fusion format, NetObjects 
Fusion places their content in the Layout area of the corresponding new 
NetObjects Fusion page. The MasterBorders of each new page have the 
characteristics of the current site’s default MasterBorders. When the 
import is complete, you will be able to edit the imported pages in Page 
view as you would any page you create in NetObjects Fusion. For 
example, you can edit the default MasterBorder and see the changes 
reflected on all pages or create and assign a new MasterBorder to 
different pages as needed.

When you do not convert the imported pages to NetObjects Fusion 
format, NetObjects Fusion imports all the site section’s assets and marks 
each page as External HTML. It does not add SiteStyles or 
MasterBorders and thus preserves the appearance of each page. You can 
manage the page’s location in the site as you would any other page even 
though its icon appears shaded in Site view. However, you cannot edit an 
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external page in Page view; a large X covers the page. If you double-click 
the X, the HTML of the external page appears for editing in the default 
HTML editor selected in the Preferences dialog. If later you decide you 
want to edit the page in Page view, you can use the Import Page 
command, which makes the page internal and adds MasterBorders and a 
SiteStyle.

6. Choose the maximum number of pages to import.

NetObjects Fusion starts with the site’s Home page and stops importing 
when it reaches the end of the site or completes the number of pages you 
specify.

7. Choose how many levels to import.

NetObjects Fusion imports as many pages as possible at a higher level 
before going to a lower level.

8. Click OK.

NetObjects Fusion imports the number of pages you specified from the 
site. Complex pages take longer to import. If you have chosen not to 
convert the pages to NetObjects Fusion format, the pages are stored in 
NetObjects 2.0\User Sites\Site Name\Import\www.domain.com.

9. If you selected the Convert pages to NetObjects Fusion format option, 
switch to Page view and verify that each page appears as you expect. 

Some pages convert more accurately than others, and pages with frames 
will not convert. Check your pages carefully and make sure no imported 
objects are overlapping by choosing Select Overlapping Elements in the 
Page view Page menu. Adjust font size and style if needed and add 
NetObjects Fusion navigation bars and banners as appropriate to your 
design.

NetObjects Fusion imports all assets such as Java applets, Shockwave, 
and other rich media. If you have converted to NetObjects Fusion 
format, these should appear in place in Page view. It does not import 
client-side image maps or manage server-side resources. This means that 
if the imported site used a resource on its server such as a CGI script, you 
must manually set up your server with those resources. 
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Sharing NetObjects Fusion Site Files
You might need to share your site files with others who are using NetObjects Fusion 

on other hardware platforms or who are using current or previous versions of 

NetObjects Fusion.

NetObjects Fusion 2.0 is compatible with any data files created with a previous 

release of NetObjects Fusion. When you open a file created with NetObjects Fusion 

1.0, NetObjects Fusion 2.0 offers you the opportunity to make a backup copy of the 

original file before proceeding. Once NetObjects Fusion 2.0 has opened a 1.0 file, 

the resulting file is not backwardly compatible and can no longer be used with 

NetObjects Fusion 1.0. 

You cannot insert an AutoSite template created in NetObjects Fusion 1.0 into 

NetObjects Fusion 2.0. To make a 1.0 template insertable in 2.0, you must first open 

a new site based on the 1.0 template in NetObjects Fusion 2.0. Then create a new 

template using the Export Template menu command in the File menu. Move the 

new template to \NetObjects Fusion 2.0\Templates\Autosites\ where you can 

access it as you would any other 2.0 template.

To share sites among NetObjects Fusion 2.0 Windows and Macintosh users, you 

must save the sites as templates. Because of relative assets paths and hard disk 

naming conventions, you cannot simply open an .nod file created by a NetObjects 

Fusion 2.0 user on another computer.

Saving your site as a template collects all the assets external to your site and puts 

them in a folder called Assets. This process also updates the assets’ paths within 

your site file. The Assets folder must be maintained and cataloged by NetObjects 

Fusion, which updates associated HTML files. Do not manually add or delete files 

from the Assets folder.

Note: If the site that you wish to save as a template has an internal data object in it, 
the data will NOT transfer if you import the template into a new site. Any data 
stored in internal data objects is lost. 
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To move a file to another computer

1. On the source computer, open the NetObjects Fusion site file (.nod).

2. In the Site view, choose Export Template from the File menu.

3. Select a location to save your template and click OK. On the Macintosh, 
click the Select folder name button.

4. Click OK to confirm the save.

After your template has been saved, a folder is automatically created 
using the same name as your original (.nod) file. The template file (.nft) 
appears in the folder along with an Assets folder.

Note: Once the template has been saved, do NOT change its folder name 
or the names of any files it contains.

5. Copy the new template folder to the NetObjects Fusion 
2.0\Templates\AutoSites folder on the destination computer. If you 
need to copy the template folder to a network server first, make sure that 
the folder and filenames are not truncated or changed in the process.

6. Start NetObjects Fusion 2.0 on the destination computer.

7. Choose New Site… from the File menu.

NetObjects Fusion displays the New Site dialog.

8. Select AutoSite Templates and select the template, by name, from the list.

9. Enter a name for the new template in the Site Name field and click OK.

The site that was created in NetObjects Fusion 2.0 on the source 
computer is now an .nod file on the destination computer.

Note: If your source site included a custom SiteStyle, you must copy its folder from 
the Styles folder on the source computer to the Styles folder on the destination 
computer and import it as described in “Adding and Removing Styles” on 
page 6-14.
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Working with a Site
The Site view lets you work with the structure of your site: how its pages are 

arranged into sections.

When working with the structure, you can use the Zoom Out tool to get an overall 

view of larger sites. When the view is zoomed out, you can continue to change the 

structure by dragging pages. To bring forward a smaller part of the site, use the 

Zoom In tool. 

The Site tab of the Properties palette displays site information: the site name, date 

created, date last modified, and the number of pages in the site. When you enter an 

author name, NetObjects Fusion includes it in an HTML Meta tag that appears in 

each page’s file when the site is published.
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Setting Structure Orientation and Background Color
Depending on your preferences and the way you distribute windows on your screen, 

you might want to look at the site structure horizontally or vertically. You can also 

change the background color for the Site view.

Figure 2-1. Horizontal and Vertical Orientation

Change the Site view orientation and background color in the View tab of the 

Properties palette.

Horizontal 
orientation

Vertical 
orientation
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Expanding and Collapsing the Site Structure
NetObjects Fusion lets you expand and collapse the child pages so that you can 

display only the page icons you want to see. The Outline and Structure views both 

display the same expanded and collapsed pages. If you change which child pages are 

hidden and shown in one view, the other view reflects your changes. See “Site 

Management Information” on page 2-25 for a description of Outline view.

In Structure view, a page that has one or more hidden child pages displays a plus 

symbol beneath the page icon.

Figure 2-2. Expanded and Collapsed Display of Page Icons

To expand the display to see child page icons, click the plus symbol.

To collapse the display of child pages, click the small triangle beneath the parent’s 

page icon.

Changing Page Properties
The properties associated with each page can be seen in the Page tab of the 

Properties palette. The properties also appear in the Site Management table in the 

Site Outline.

Use the Page tab settings to assist you in developing a site. For example, you can 

color-code your site structure display by assigning different colors to page icons. 

Additional 
pages symbol

Click a triangle to 
collapse child pages
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This can help you distinguish between different sections at a glance. You can 

instruct NetObjects Fusion to publish or not publish a particular page. You can note 

whether a page is done or not, and combine this information with a comment 

explaining the status in detail.

The page properties are as follows:

● Page Name. The name assigned to the page. You can rename a page at any time. 
For information on Custom Names, see “Renaming a Page” on page 2-10.

● Page Type. Shows whether the page is a normal page or a stacked page. Stacked 
pages are created when you use a data list. For information about stacked pages, 
see Chapter 12, “Data Publishing.”

● Page Color. Use Page Color to set the color of individual page icons in the Site 
view. Colors can help you visually group pages for various purposes, such as 
indicating which are finished or which have been assigned to a particular author.

● Status. Lets you set Done and Not Done indicators, a convenient way to manage 
individual pages in a large site. This setting is for information only and has no 
effect on the functioning of the site. It can be used in conjunction with the 
Comments field. The page icon displays a check mark symbol when you have 
selected “Done.”

● Publish/Don’t Publish. This setting allows you to publish some pages while not 
publishing others which might be under construction or private. The page icon 
displays a red bullet symbol when you have selected “Don’t Publish.”

A page that is designated “Don’t Publish” can still be previewed as an individual 

page, but it is removed from the navigation bars of other pages in the site and any 

links to it are also broken. No HTML is produced for these pages during the 

staging and publishing process. Using this feature is not a way to publish only 

changed sections of a site.

● Comments. Use the Comments area to enter notes to yourself or your co-
workers about the status or content of individual pages.

Done check markDon’t Publish bullet
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Printing the Site Structure
In Site view, the Print… command on the File menu prints your site structure. To 

print the entire site, select the home page before choosing Print. To print a section 

of the site, select the top-level page of the section you want to print. When you 

print, the hard copy shows the same magnification, colors, orientation, and 

expanded or collapsed child pages as you see on the screen. 

A Print To Fit option in the Print Settings dialog (Windows) or the Scaling option 

in the Page Setup dialog (Macintosh) reduces the site structure image to fit on your 

page. The printout’s footer automatically includes the author name, number of site 

pages, and the date last modified. 

Working with the Outline
The Site view offers an Outline option. Like the Structure view option, Outline view 

lets you expand and collapse your site structure level by level. However, it lets you 

see all pages’ site management information at once, giving you an instant overview 

of site status. You can sort pages by information type such as the names of child 

pages, page type, status, and comments, so you can quickly identify pages with 

common characteristics.

To see the site in outline

◆ Click the Outline View button in the control bar.

NetObjects Fusion displays the site in outline form with additional 
information about the selected page’s child pages.
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You can expand and collapse each section of your site to see all, a few, or 
none of the pages in the hierarchy.

To expand or collapse an outline level

◆ To expand a level, click the small plus symbol (Windows) or side-arrow 
(Macintosh) to the left of a contracted page.

◆ To collapse a level, click the small minus symbol (Windows) or down-
arrow (Macintosh) to the left of an expanded page.

Site Management Information
The columns on the right side of the outline provide information about pages that 

you can use to manage your site. They display information about the child pages of 

the selected page. If the selected page has no child pages, the information displayed 

is about the selected page.

● Child Name. Displays the names of the child pages of the selected page.

● Page Type. Shows whether the page is a normal page or a stacked page.

● Status. Shows whether the page has been declared Done or Not Done.

● Publish. Shows whether the page has been designated to be published.

● Comments. Displays comments entered about the page.

Each column in the table can be used to sort the display.

A plus sign or side-arrow 
indicates a collapsed 
page; there are hidden 
child pages.

A minus sign or down-arrow 
shows an expanded page; 
child pages are visible.

The absence of a sign 
shows that there are no 
child pages.
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To sort the display

◆ Click the column heading of the column you want to use to sort the list.

For additional information about managing your site, see Chapter 13, “Managing 

Assets.”

Making a Backup
NetObjects Fusion makes it easy to make a copy of the active .nod file. 

To make a backup

1. In Site view, choose Save Site As… from the File menu.

2. In the Choose a File Name dialog that appears, choose a descriptive file 
name and location for your backup file.

3. Type a name for your backup file and click Save.

NetObjects Fusion creates a copy of your .nod file in the location you 
specified. 

Note: The backup you make with the Save Site As command does not include assets. 
To make a copy that includes assets and other information that can be valuable if 
problems occur, back up your site as a template as described in “Exporting a Site as 
a Template” on page 2-13.
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Working with Pages 3

You work on the content of your site’s pages in the Page view. You control elements 

on your page with drag-and-drop ease and pixel-level accuracy because the Page 

view is a graphical, draw-based layout editor. You can place an element anywhere on 

a page and NetObjects Fusion will generate an HTML Web page that uses HTML 

tables to preserve its precise position. Your pages will retain their NetObjects Fusion 

layouts when visitors view your site with browsers that support HTML tables, such 

as Netscape Navigator 2.01, Microsoft® Internet Explorer™ 2.1, or any later 

versions.

This chapter describes the fundamentals of working in the Page view, including

● setting view and page properties

● selecting from the page tools palette

● controlling the page size

● choosing colors

● opening image files
Working with Pages 3-1



3

W O R K I N G  I N  T H E  P A G E  V I E W
Working in the Page View
Use one of these methods to open the Page view for the page selected in Site view:

● Double-click a page icon in the Site view.

● Click the Page button in the NetObjects Fusion control bar.

● Choose Page from the Go menu.

● Press Ctrl-2 (Windows) or z-2 (Macintosh).

The Page view displays your page divided into two kinds of workspace areas: the 

MasterBorders area and the Layout area. The MasterBorders area represents the 

page margins, and the Layout area is the body of the page. The MasterBorders area 

can contain elements that appear on many pages. The Layout area controls elements 

that are unique to this page. “NetObjects Fusion Page Anatomy” on page 3-13 

describes these areas in more detail.

The Page view also provides a separate Tools palette and Properties palette for 

working with content elements. Content elements are the text, graphics, and other 

items that you place on your pages. To help you place elements precisely, NetObjects 

Fusion can display either grid or guide lines.
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W

Figure 3-1. The Page View Workspace

The Properties palette controls the attributes of your page and its elements. It 

typically presents four tabs, although you might see more or fewer depending on 

what you have selected.

● The View tab controls the way the Page view is displayed, letting you hide or 
show optional visual aids.

● The Page tab is identical to the Page tab you see in the Site view, and it controls 
the general attributes of each page.

Tools palette

Current page

MasterBorder

Layout area

Page grid

Content elements

Element border

Page navigation 
buttons

Layout menu Coordinates
Element size

Zoom level
Properties palette

Site name

Banner

Navigation 
button bar

Text navigation bar
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● The Layout or MasterBorder tab, depending on which area you’ve selected. The 
Layout tab helps you create and modify page layouts as described in “Working 
with Layouts” on page 5-12. The MasterBorder tab helps you control elements 
that appear on many pages, such as AutoFrames. It’s described in “Working with 
MasterBorders” on page 5-2.

● The tab for the selected element. The Properties palette is context-sensitive and 

displays a tab based on the content element you select.

Setting the View Properties
The View tab controls the measurement units, the page grid and guides, and the 

display of element borders, links, and anchors.

Figure 3-2. The View Properties Tab

When you are placing elements on a page, you’ll use the following features to 

achieve an accurate page layout:

● You can change the measurement unit from the default of pixels to Centimeters, 
Inches, or Points.

Check boxes to display 
content element borders 
and show link, anchor, 
HTML, and script icons.

Choose a radio button to 
display or hide the page 
grid or guides.

Select the units of 
measurement from the 
drop-down menu.

Set the dimensions of the 
page grid in the current 
units of measurement.

Select to automatically align 
new objects with the grid or 
other objects.
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● Use the page grid to align your layout and gauge the distances between content 
elements. You can set the grid size, and display or hide the grid. 

● Use the page guides to help align objects vertically and horizontally. You can drag 
page guides and display or hide them. By default, Page view offers one vertical 
and one horizontal guide. To make another, hold down Control (Windows) or 
Option (Macintosh) and drag a guide. To delete a guide, drag it off the page.

● To hide all grid and guide lines, including MasterBorder boundaries, select None 
in the Grid/Guides section.

● Use the Snap feature to align elements exactly on grid lines, guide lines, or flush 
with other objects.

● Select the Show Element Borders check box to display element boundaries so you 
can control element size and position. 

● Select the Show Element Icons check box to display small icons indicating where 
links, anchors, scripts, and HTML tags exist on a page.

Link icon. The element has an associated link. Does not appear in text 

links.

Anchor icon. The element has an anchor point inserted here, to which 

you can link.

Script icon. The element has an associated script.

HTML tag icon. The text element has an HTML tag inserted at this point.

The View menu also helps you control various aids in Page view. You can open or 

close the Tools and Properties palettes; and show or hide element borders or 

element icons. With the Page Labels command, you can also show and hide the 

labels and margin lines for the Layout area and MasterBorders. The Layout Only 

command hides the MasterBorders area, which can improve performance.

The page grid, page guides, element borders, and element icons are aids for page 

editing, and do not appear as part of your published pages.
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Setting the Page Properties
In Page view, you can use the Page properties tab to control the name, color, and 

status of the displayed page. It gives you the same controls as it does in Site view, as 

described in “Constructing a Site” on page 2-2. 

Figure 3-3. The Page Properties Tab

The Page Tools
The Tools palette contains 15 basic tools for creating, editing, and manipulating 

different types of content, including interactive and multimedia elements. When 

you select certain tools, a group of secondary tools appears, each performing a 

different function on the same type of content element.

The Tools palette differs slightly between Windows and Macintosh systems as 

shown in Figure 3-4.

Set or change the page name.Pages are either stacked 
or normal. Stacked 
pages are described in 
Chapter 12.

Set whether this page will be 
published with the rest of the site.

Set the color of the Site 
view page icon for this 
page.

Set whether this page is done 
or is still in progress.

Enter comments to keep track 
of page production issues.

Set custom names to be used in 
buttons, banners, and titles
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Figure 3-4. Page Tools Palettes for Windows and Macintosh

The Control Tools
The three control tools are identical to the ones you saw in the Site view. In Page 

view, they control any element on a page, plus your overall view of your work.

Selection. Use the Selection tool to select, move, or resize content 

elements. Click an object to select it, drag to move it, or drag the handles 

of its bounding box to resize it. You can select multiple elements by 

dragging a selection box around them, or by holding down the Shift key 

while you click them one at a time. You can also deselect one element at a 

time by holding down the Shift key while you click the element. Use Shift-

click also when you want to get solid selection handles on a navigation bar 

or text block with the first click. 

The Selection tool is the default tool. This means after you click a content 

tool and place an element, the pointer automatically reverts to the 

Selection tool. To prevent a content tool from reverting to the Selection 

tool so you can place multiple elements of the same type, select the content 

tool by double-clicking it on the Tool palette. 

Zoom In. Click anywhere in the page window with the Zoom In tool to 

magnify the workspace. Zoom In gives you a closer view of your work by 

enlarging its appearance.

Control tools

Content tools

Secondary 
tools
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Zoom Out. Use the Zoom Out tool to scale the view down. Zoom Out 

gives you a higher-level, bird’s eye view of your work by reducing its 

appearance.

The Content Tools
Each content tool inserts a different type of content element. You can place content 

elements on any blank area of a page because the Page view is draw-based. This 

means that each element is placed in a bounding box and that box can be resized 

and positioned.

Each content element is documented in detail later in this chapter.

Text. Create a text box, then type to insert text, or use the Edit menu to 

paste text inside it. Use the Text properties tab to format your text just as 

you would in a word processor.

Picture. Use the Picture tool to insert and format image files. With the 

picture in place, you can create an imagemap that links parts of the image 

to other Web pages, or select one color in the image as transparent. The 

Picture tool contains five secondary tools:

Picture (default). Drag a box to contain the picture you select in the 

Image File Open dialog. The box automatically adjusts to the size of the 

image.

Transparency Color. Click a point on a GIF image that contains the 

color you want to be transparent. In a browser, pixels of that color will 

be suppressed, so that the background shows through.

Rectangular Hotspot. Draw and link a rectangular hotspot on a 

picture to turn it into an imagemap.

Elliptical Hotspot. Use this tool to create circular or elliptical hotspots 

for imagemaps.

Polygon Hotspot. Create hotspots of any multisided shape using 

this tool. Click to create each point, double-click to finish.
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Draw. Use the Draw tool to create your own geometric shapes. When you 

use this tool in combination with its properties tab, you can add text and 

color to your shapes. To include the shape in your site, NetObjects Fusion 

automatically renders it as a gif file. The Draw tool contains six secondary 

tools:

Rectangle. The Rectangle tool draws four-sided polygons of 

any dimensions.

Rounded Rectangle. This tool creates four-sided polygons with 

rounded corners.

Ellipse. Draw circles and ellipses on your pages.

Rule. Draw a horizontal line that will be displayed in the browser as 

either an HTML rule or a SiteStyle line image.

Polygon. You can draw any closed, multisided shape. Once the shape is 

drawn, you can edit it by dragging its vertices.

Line. Draw straight lines of any length, color, or angle. Add line head 

and tail styles.

Table. Web tables are similar to the tables you create in any word-

processing program to display information.

Navigation Bar. Insert horizontal or vertical navigation bars or banners. 

The Navigation tool contains four secondary tools.

Banner. Click to place a horizontal banner image.

Vertical Banner. Click to place a vertical banner image.

Navigation Bar. Click to place a horizontal button bar.

Vertical Navigation Bar. Click to place a vertical button bar.
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Rich Media. Insert sound, video, and animation into your site. The Rich 

Media tool contains three secondary tools.

Sound. Draw a bounding box in which to place an icon as a visual 

placeholder for an audio file. In the final, published Web page, site 

visitors can click the icon to hear the audio or play it inline.

Video. Like audio files, video files are not played until the site visitor 

clicks an icon for the file in a browser or clicks on them inline.

Shockwave. Macromedia® Shockwave™ for Director and Shockwave 

audio files bring your site to life with interactive animation and sound.

NetObjects Components. Add NetObjects Components to include 

interactive functionality and effects to your Web site. The NetObjects 

Components tool contains six secondary tools.

NetObjects Components (default). Choose from a list of installed 

components. NetObjects Fusion includes a time-based picture, a 

picture loader, or a rotating picture. You can also add components to 

the list.

DynaButtons. Add Java-based buttons that have a dynamic state 

(mouse over, pressed, depressed). Use DynaButtons to give users direct 

feedback as they interact with your site, enhancing their experience as 

they navigate around it.

Ticker Tape. Add this Java-based applet that gives your Web site visitors 

a scrolling ticker tape message in an LED font.

SiteMapper. Add this advanced Java-based application that, at the click 

of a button, creates an instant map of your site to assist users in viewing 

and navigating in your site’s hierarchy.

Message Board. Add this full-featured bulletin board so your site 

visitors can post, read, and reply to messages.

AutoForm. Creates a Submit button and attaches a CGI (Common 

Gateway Interface) script automatically, so you can process your forms 

without editing scripts.
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Java. Java applets are software programs that can add interactivity to your 

site. They are viewable with most current browsers.

ActiveX. ActiveX controls add programmability and interactivity to your 

Web pages, for browsers with Microsoft ActiveX support. This tool is 

available only on Windows systems because Macintosh does not support 

ActiveX technology.

QuickTime. QuickTime movies add action and sound to your Web pages, 

for browsers that support QuickTime. This tool is available on Macintosh 

systems. On Windows systems, place QuickTime movies using the Rich 

Media Video tool.

Data List. Use the Data List tool to insert a table of information that will 

be filled in with data either from NetObjects Fusion’s internal database or, 

on Windows systems, from an external database. The list automatically 

includes a row for each record in the data source. Each row presents a 

button that navigates to the record’s stacked page, which typically presents 

the record in full. Data lists and stacked pages are discussed in Chapter 12, 

“Data Publishing.” Referencing external databases is possible only on 

Windows systems because Macintosh does not support ODBC technology. 

On Windows systems, the Data List tool has two secondary tools.

Data List (default). Use this tool to create a data list that will reference 

data stored either in NetObjects Fusion’s internal database, or in an 

external database that is already referenced elsewhere in your site.

New External Data Source. Use this tool to create a data list that will 

reference data stored in an external source that is not yet referenced 

anywhere in your site.

Data Field. When designing a stacked page, use this tool to specify a 

location for each field. Data fields are discussed in Chapter 12, “Data 

Publishing.”

Forms. Forms let your site visitors enter data and send it to your Web 

server for processing. With forms, you can collect information from site 

visitors or allow them to request information from your server. The Forms 

tool has six secondary tools.
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Button. This tool creates either a Submit button or a Reset button. A 

Submit button sends the contents entered into the form objects to the 

server after a site visitor has entered information. A Reset button clears 

the contents of the form to allow the visitor to start over.

Check Box. Check boxes let site visitors select one or more items from a 

group. A check box can either be checked or unchecked, and any 

number of them can be checked at the same time. 

Radio Button. Use radio buttons when you want site visitors to select 

only one item in a group. Radio buttons behave just like check boxes, 

except that only one radio button in a group can be checked at a time.

Edit Field. This tool creates a single line in which visitors can enter text 

for submission to your server.

Multi-Line Text. To provide a way for site visitors to enter more than 

one line of text, you can create a multiple-line text box of any size using 

this tool.

Combo Box. A combo box contains a list of items for site visitors to 

choose from. Combo boxes can be displayed as a drop-down menu or a 

list box with a scroll bar.

Controlling Page Size
In NetObjects Fusion, page size is dynamic: your page can “grow” as you place 

elements on it. This is quite unlike a word processor or page layout program, where 

page size is fixed. In the latter, typically one of your first tasks is to specify the 

dimensions of your finished product—the printed page—either by choosing a 

standard size such as 8.5 x 11, or by entering custom dimensions for whatever paper 

stock your design requires. Any margin size you then choose will reduce the body 

area of the page.
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Because Web pages do not require a physical existence to be effective, setting their 

size can be a more dynamic process. For example, sites typically include pages of 

different heights. NetObjects Fusion helps you take advantage of this flexibility by 

dynamically expanding each page’s size as needed to accommodate the elements you 

place on it.

NetObjects Fusion Page Anatomy
In NetObjects Fusion, each page has two kinds of areas: Layout and MasterBorders. 

In Page View, they look like this:

Notice there is no boundary line between the top and left margins. This lets you 

place in the upper-left corner elements that extend into both the top and left 

margins. At the other corners, you must place elements within one margin or the 

other because elements cannot straddle margin boundary lines.

Each page’s size is equal to its Layout size plus its MasterBorder size. When you 

increase or decrease the Layout or MasterBorder size using controls on the 

Properties palette, the page size, which you can see on the Layout tab, increases or 

decreases accordingly. NetObjects Fusion does not enforce a standard page size 

throughout your site; each page can be a different size if you like.

If you sometimes examine the HTML NetObjects Fusion creates to describe a page, 

you should know that the total page size—Layout size plus MasterBorder size—

determines the width of the HTML table NetObjects Fusion generates to specify 

element locations on your page.
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New Pages in NetObjects Fusion 
When you are creating a new site, page size is initially determined by the template 

on which the site is based. For example, when you create a new blank site, your 

Home page inherits the default page size of the Blank Site template in your 

NetObjects Fusion 2.0\Templates folder. This default is 640x600, which is 

appropriate for the majority of browsers. 

You can change your site’s default page size on the Page tab of the Preferences 

dialog. Thereafter, any new pages you create will start at that size. A new page also 

inherits the site’s Default MasterBorders. To learn about editing the Default 

MasterBorders and creating new ones, see “Creating and Modifying MasterBorders” 

on page 5-3.

Dynamic Page Sizing
When you add certain elements to the Layout area in Page view, NetObjects Fusion 

dynamically increases the Layout size to accommodate them. Here are some 

examples:

● When you create a text block and paste in more text than the bounding box you 
drew can display, the text block grows down. If it reaches the bottom edge of the 
Layout, the Layout grows down too. This increases both your Layout and page 
height. 

● When you place a horizontal banner close to the right edge of your Layout, the 
Layout grows right to accommodate it, increasing both your Layout and page 
width. 

● When you use the Import Page command to import an HTML file, the Layout 
grows to accommodate the dimensions of the imported page. This means your 
NetObjects Fusion page will be the size of its MasterBorders plus the size of the 
imported page.

By default, you can control the width of a MasterBorder margin only by specifying a 

numeric value on the MasterBorders tab of the Properties palette. However, when 

you select the Auto-resize margins (Windows) or Drag and drop layout borders 

(Macintosh) option on the Page tab of the Preferences dialog, you can also set a 

MasterBorder margin’s size by dragging its boundary line in Page view. Regardless 
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of whether this option is set, NetObjects Fusion always automatically increases 

MasterBorders’ sizes to accommodate the elements you place within them, just as it 

dynamically adjusts Layout size while you work. When you define MasterBorders in 

addition to the Default, each has a minimum page size, which is the smallest size 

required to display the elements you place in it. When you apply a different 

MasterBorder to a page that is smaller than the MasterBorder’s minimum, 

NetObjects Fusion increases the page’s size to the MasterBorder’s minimum. 

For more information on MasterBorders and Layouts, see Chapter 5, “Managing 

MasterBorders and Optimizing Layouts.”

Choosing Colors and Images
Many kinds of content elements have color or include images. The tools for 

choosing colors and images differ slightly on Macintosh and Windows systems.

To choose a color

◆ To change the color of a selected element, click Color… on its properties 
tab or dialog, then select the color you want from the Color dialog.

Figure 3-5. Color dialogs for Windows and Macintosh

Your Windows or Macintosh documentation tells how to create custom colors and 

manage palette issues.
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To add an image to your page, you place an image file. In some cases, NetObjects 

Fusion automatically places image files for you, as when you create a navigation bar. 

NetObjects Fusion helps you manage image files by treating them as named assets of 

your site. When you use image assets, it’s easy to replace all instances of one image 

with another and minimize the number of image files your site includes. For more 

information about image file assets, see “Managing Files” on page 13-3.

When you create an image asset, NetObjects Fusion stores an absolute path to the 

image file in your site’s .nod file. Previewing also uses absolute paths to access the 

image file. However, when you stage, publish, or export a template, NetObjects 

Fusion must create the relative references that make your site portable to another 

system. So whenever you stage, publish, or export a template, NetObjects Fusion 

copies your image file assets from wherever they’re located on your hard disk to an 

Assets folder within your stage, publish, or template folder. For more information 

on the Assets folder, see “Asset Management Tips” on page 13-14.

To choose an image file

1. In the properties tab or dialog for the selected image element, click the 
Browse... button (Windows) or Select... button (Macintosh). For some 
elements, such as a picture, you can simply double-click the element.

The Image File Open dialog appears.

Folders tab 
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The default state of this dialog—the Folders tab (Windows) or the New 
From File option (Macintosh)—lets you create a new image file asset. 

● To display the path to the current folder, click the down-arrow in 

the Look in field (Windows) or press the folder pop-up menu 

(Macintosh).

● To preview the image, select the Show thumbnail image option, 

then click once on the image file name to preview. 

● To show image formats other than GIF and JPG, select the formats 

you want to view from the Files of type list box (Windows) or the 

Show pop-up menu (Macintosh).

2. To create a new image file asset, navigate to an image file, select it and 
click Open.

The image appears in the element. By default, NetObjects Fusion gives 
the new asset the same name as the image file. You can rename the asset 
in Assets view if you wish as described in “Managing Files” on page 13-3.

3. To place an existing image file asset, click the Image Assets tab 
(Windows) or choose the New From Asset option (Macintosh).

The dialog displays all the image assets of the current site. 

New From File option
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● For each image asset, the Image Assets tab lists the asset’s name and 

the Windows file name for its image file. Select an asset name to 

preview its image.

● To view a file’s path or location, select it. The path appears in the 

File Path field. If needed, use the right-arrow key to scroll and view 

the whole path and name.

4. Select the asset you want to place, then click the Open button.

The image appears in the element. Now, if you ever need to replace this 
image everywhere it appears in your site, you can do so with a single 
command in Assets view, as described in “Managing Files” on page 13-3.

Image Assets tab 

New From Asset option
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Designing with 
Text and Graphics 4

Text and graphics are the essential building blocks of any page design. NetObjects 

Fusion offers a complete set of draw-based tools for

● creating text blocks

● entering, editing, and formatting text

● creating and applying paragraph styles

● setting up tables

● checking spelling

● importing text

● placing images

● drawing shapes

● editing lines and arrows

● aligning elements

● detecting overlapping elements
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Working with Text
This section tells how to place text elements on your page, enter and edit text, and 

work with paragraph styles. It also describes how to insert HTML tags and variables 

into your text.

How text appears in your visitor’s browser will vary according to the browser, its 

settings, and platform. “Optimizing Your Layout” on page 5-19 tells how to manage 

your design to accommodate these variations.

For information on importing text, HTML, or RTF (Rich Text Format) files, see 

“Importing Pages” on page 4-20. For information on inserting links and anchors, 

see “Creating Links” on page 7-12. 

Creating a Text Box
Use the Text tool to add text to the MasterBorders and Layout area of your page. 

When you draw a bounding box for text, you create a space in which you can type 

and format text as you would in a page layout program. 

A text block can contain any number of paragraphs, headings, lists, or other types of 

text. By default, the size of a text box changes to accommodate the text it holds. For 

example, when you enter a small amount of text in a text box, the box shrinks to fit 

the text. It expands if you enter more text than the box can contain. This dynamic 

characteristic helps you control the effect of variations introduced by browser font 

settings, as described in “Locking a Text Block’s Minimum Size” on page 5-23.

It is helpful to turn on Show element borders in the View properties tab or View 

menu, so you can see the text element boundary when the element is not selected.

To create a text box and enter text

1. Select the Text tool.

2. Drag a boundary for the text box.
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When you release the mouse button to complete the boundary, a 
blinking insertion point appears inside the text box, hollow handles 
appear around it, and the Text tab appears in the Properties palette.

3. Type text in the text box or paste text from somewhere else.

Selecting Text

Use these methods to select text and paragraphs:

● Drag to select specific characters.

● Double-click to select a word.

● Triple-click to select a paragraph.

● To select a block of text, click the first word, then Shift-click the last word.

● To select multiple paragraphs, drag through them.

● To end a paragraph, press Enter (Windows) or Return (Macintosh). NetObjects 
Fusion automatically inserts a double space before the next paragraph.

● To force a line break within a paragraph, press Shift-Enter (Windows) or Shift-

Return (Macintosh).
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Managing the Text Box

You can move and resize the text box like you do other NetObjects Fusion elements:

● To select the text box, click the border line or drag a selection box, so the handles 
are solid. 

● To resize the selected text element, set the Lock Size option and drag a handle 
when the pointer is a two-way arrow.

● To move the selected element, drag the border when the pointer is the default 
selection tool.

Using the Text and Edit Menus
Whenever you select text, the Text menu appears in the NetObjects Fusion menu 

bar.

● To indent selected paragraphs, choose Indent from the Text menu. Choose 
Unindent to move the paragraph to the left.

● To display a word count for the selected text element and the whole page, choose 
Word Count from the Text menu.

● To insert symbols such as trademark, copyright, quotes, dashes, and so on, 
choose Insert Symbol from the Text menu.

● To insert HTML, choose Insert HTML from the Text menu. See “Inserting 
HTML Tags” on page 4-10.

● To insert a variable, choose Insert Variable from the Text menu. See “Inserting 
Variables” on page 4-11.

● When editing text, you can use the Cut, Copy, Paste, Select All, and Clear 
commands in the Edit menu as usual.

● To find or replace a word or phrase in a selected text element, choose Find or 
Replace from the Edit menu.

Formatting Text
The Text tab contains options for formatting selected characters and whole 

paragraphs. 
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● To change the font, size, style, and text color, select all the text you want to 
change.

● To change alignment, bullet, or paragraph style, you need only click inside the 
paragraph.

● To undo a style, choose Undo from the Edit menu.

Note: You can format selected characters only in text boxes, table cells, and Rich Text 
data fields, which are available only in internal data objects. In Simple Text data 
fields, all characters have the same format. For more information on data objects, 
see Chapter 12, “Data Publishing.”

To format text

1. Select the text you want to format.

The Properties palette displays the Text tab: 

Figure 4-1. Text Tab on Properties Palette

Text alignmentCharacter style

Choose your font

Font size

Paragraph 
formatting options

To choose a minimum 
size for the text block, 
see page 5-23

Text color is set by the 
Style view unless you 
select a different color.

You can select a 
colored background 
for the text box.

Attach URLS or page 
links to text. Attach HTML tags and 

scripts to text boxes.

Add space between text 
and element border
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2. Add or remove a text format by clicking on a character style icon.

You can choose bold, italic, underline, strike-through, or a combination 
of these. You can also choose superscript or subscript.

You can select Left, Center, or Right alignment.

3. Select a font from the Font list. This box displays the fonts installed on 
your system. Select Site Style to use the default font for the style selected 
in Style view. This font setting affects only the Layout area.

To affect the HTML tags output by NetObjects Fusion, you must 
redefine the Normal paragraph style. See “Using Paragraph Styles” on 
page 4-7.

Note: TrueType™ and PostScript® fonts are read by browsers that 
support the latest HTML font tags. To view multiple fonts in your site, 
your site visitors need an HTML 3.x compatible browser, such as 
Netscape Navigator 3.0 or Microsoft Internet Explorer 3.0, and the 
actual fonts installed on their systems. 

Text normally assumes the font assigned to it by a browser, but 
NetObjects Fusion allows you to assign unique fonts to your text. If the 
specified font is installed on the site visitor’s system, HTML 3.x 
compatible browsers will display it. If the font is not installed, the 
browser will use its default font.

4. Select a font size from the Size list. 

The number in parentheses shows the HTML tag that is equivalent to 
the point size.

5. If the selected text is to be a bulleted list, a numbered list, or an outline 
format, select the appropriate form from the Bullet list. Select None to 
use no bullet style. For more information see “Creating Lists” on 
page 4-9.

6. Change the Inset value to set the space between the text and the element 
border.

7. In the Text Color section, select Site Style to use the default color for the 
style selected in Style view, or click Color... to select a different color.
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8. In the Background Color section, select None to use no background, or 
click Color... to select a color to fill the text element.

Using Paragraph Styles
You can use NetObjects Fusion built-in paragraph styles or create your own. You 

can modify any style. You can modify a style by example only on a Windows system.

To use an existing paragraph style

1. Click in the paragraph you want to format, or if formatting multiple 
paragraphs, drag to select them. 

2. Choose a style from the Paragraph Style list. 

The list contains standard styles including Normal, Headings 1-6 (with 1 
offering the largest HTML 2.0 type size and 6 offering the smallest), 
Caption, Code, and more.

The selected paragraphs change to the style you selected.

To edit a paragraph style by example

1. On a Windows system, select a paragraph that is in the style you want to 
modify, so the style name is selected in the Paragraph Style list.

2. Select the text and change it to the font, size, color, and alignment you 
want.

3. Now select the style again from the Paragraph Styles list.

The Reapply Style dialog appears, showing the name of the selected style.
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4. Select Redefine the style using the selection as an example.

Note: If you select Reapply the formatting of the style to the paragraph, 
you will lose all your changes and the paragraph will return to its 
original settings for that style.

The selected style now has the new format you created.

To edit a paragraph style using a dialog

1. Click a paragraph that is set to the style you want to edit, so the style 
name shows in the Paragraph style list.

2. Click Edit....

The Paragraph Style dialog appears:

3. Select the font, size, effects, paragraph indent, bullet style, alignment, 
and color you want to use for the style. 

The number in the size list shows the HTML tag that is equivalent to the 
point size.

4. Click OK.

The selected paragraph changes to the settings you specified. The next 
time you choose the style you edited, the selected paragraph will appear 
in the new format.
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To create your own paragraph styles

1. Select the text you want to format. 

2. Format the text in your paragraph using the features in the Text tab, as 
described in “Formatting Text” on page 4-4.

3. Click New....

4. In the New Paragraph Style dialog that appears, type a name for the new 
Paragraph Style you wish to create, then click OK.

The new style appears as a choice in the Paragraph Style list, and you can 
use it as you would any paragraph style.

Creating Lists
NetObjects Fusion offers several options for presenting items in a list. Each item 

must be a separate paragraph. You can choose from a variety of numbered lists and 

bulleted list types. Bulleted lists are optimized for viewing in Windows browsers.

To create an ordered or unordered list

1. Separate your list items by pressing Enter (Windows) or Return 
(Macintosh). 

2. Select all the items you want to include in the list.

3. Choose a listing system from the Bullet drop-down menu. 

To create unordered lists choose Solid circle, Solid square, or Open 
circle. 

To create an ordered list, choose upper case alphabetic (A, B, C), 
lowercase alphabetic (a, b, c), roman numeral (upper and lowercase), or 
Arabic numerals.

4. For ordered lists, you can set the list start value by clicking anywhere in 
the list and choosing Set List Start from the Text menu.
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Enter a start value in the dialog and click OK.

Your list now begins with the new value regardless of the numbering 
system chosen.

Note: Ordered list counters such as 1, 2, a), b) and so on, do not show in 
your font style, as this is not an HTML option. Such counters are 
generated by the browser in the default browser font.

Inserting HTML Tags
Although NetObjects Fusion provides visual support for most HTML tags, a new 

tag might be developed that you want to use. You can insert HTML tags into a text 

element.

Use this feature to insert HTML tags that affect text. To insert other kinds of HTML 

tags, use a script. For more information see Chapter 11, “Scripting in NetObjects 

Fusion.”

To Insert an HTML Tag

1. Click in a text element where you want to place the tag. For example, if 
you are formatting text, click at the beginning of the text.

2. Choose Insert HTML from the Text menu.

The Insert HTML Tag dialog appears.
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3. Type the tag you want to insert, such as <B> for Begin Bold.

4. Click OK.

If Show Element Icons is turned on in the View properties tab or 
View menu, a small icon appears in the element border to indicate 
the presence of an HTML tag. 

5. If necessary, at the end of the text to format, insert an ending HTML tag, 
such as </B> for End Bold, the same way.

When you preview the page you can view the effects of the HTML tags you entered. 

To edit the tag, click it. The Insert HTML Tag dialog opens again, showing the tag 

you entered. Edit the tag and click OK.

Inserting Variables
NetObjects Fusion provides a list of variables you can include on your pages, such as 

the date and time the site was created or last modified, the site name and author, 

and so on. You can also define your own variables to include on your pages.

To insert a variable

1. Click in the text element where you want to insert a variable.

2. Choose Insert Variable from the Text menu.

The Insert Variable dialog appears.
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3. In the Type list, select a category, such as Date & Time, Site & General, or 
User defined.

The available variables appear in the Variable list.

4. Select the one you want to use. For example, to display the date and time 
the site was last modified, select Site Modified from the Variable list.

For Date & Time you can select a date format. Click Date Format... and 
select a format from the list. The format you select appears in the Value 
section of the dialog.

For Site & General, NetObjects Fusion generates the values 
automatically from the site information. For example, if you entered an 
author name in the Site properties in Site view, it appears in the Value 
section when the Author variable is selected.

5. Click OK.

● The variable appears in the text element at the insertion point. It is 

highlighted to identify it.

● To edit the variable, click it, then choose Edit Variable from the Text 

menu. You can also edit variables in Assets view.

Inserting User-defined Variables

User-defined variables give you a way to enter information that is subject to change, 

without re-entering the information every place it occurs.
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For example, you might be referring to a product that is in development and at this 

point has only a code name. The name appears on many pages in your site. You can 

enter the product name as a user-defined variable and insert it anywhere you want. 

When the product name changes, edit the variable and let NetObjects Fusion 

update all the pages in your site.

You can edit a user-defined variable in Assets view, as described in “Managing 

Variables” on page 13-13.

To define your own variable

1. Click in the text element where you want to place the variable.

2. Choose Insert Variable from the Edit menu.

3. In the Type list of the Insert Variable dialog, select User defined.

4. Click New....

5. In the Variable name field of the New Variable dialog, type a name for 
your variable.

6. In the Value box, type the information you want to display. 

7. Click OK.

The information appears in the text element.

Using Tables
NetObjects Fusion tables are similar to the tables you create in word-processing and 

page layout programs. You can format a table’s rows, columns, and borders, and fill 

its cells with text or images. Table cells can have borders of any width. You can also 

adjust the space between table cells, or the cell padding. The margin of each cell is 

called the cell spacing.
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Figure 4-2. Table Spacing

Use the Table properties tab to set whether each cell contains text or an image. Use 

the right-click (Windows) or Control-click (Macintosh) menu to add and remove 

columns and rows. You can easily change the content setting for any cell if you want 

to switch.

Creating a Table
When you first create a table, you configure all of its specifications, including the 

numbers of rows and columns, in the Table dialog. When you want to modify an 

existing table, you’ll use the Table properties tab instead.

To create a table

1. Select the Table tool.

2. Drag the tool to create a table box approximately the size you want.

Cell border

Cell spacing

Cell padding
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The Table dialog appears:

3. Enter the number of columns.

4. Enter the number of rows.

5. Select a content type, either text or picture, for each column number.

6. Click OK.

The dialog closes and NetObjects Fusion inserts the table into the table 
box you drew.

7. Add text or image content to the table cells:

● When you click a cell in a text column, an insertion point appears. 

Type or paste text into the cell.

● When you click a cell in an image column (marked with an X), the 

Image File Open dialog appears. To learn how to use this dialog, see 

“To choose an image file” on page 3-16.

Modifying a Table
You might want to modify a table after you’ve created it. By selecting the table, you 

bring up the Table properties tab, which you can use to change the table’s border 

size, padding, spacing, and background color. You can use the right-click 

(Windows) or Control-click (Macintosh)menu to add and remove columns and 

rows. 
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To set table properties

1. Select the table you want to modify by drawing a selection box around it.

The Table properties tab appears: 

2. Toggle the border size up or down, or enter a new border size.

3. Adjust the cell padding by toggling its value up or down, or by entering a 
new value.

4. Adjust the cell spacing by toggling its value up or down, or by entering a 
new value.

5. Click Color… to select a background color.

6. If you want to change a column width or row height, use the Selection 
tool to drag the column border or row border.

Note: The table remains at a fixed size as you move interior columns and rows. It 
automatically grows down when you type more text than the current cell can hold. 
You can manually resize the table by dragging the resizing handles.
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Like all content elements, a table can be manipulated with the Selection tool. You 

can resize a table at any time by dragging its handles. You can also add or remove 

rows and columns.

To add or remove rows or columns

1. Right-click (Windows) or Control-click (Macintosh) any table cell.

The pop-up menu appears.

2. Choose whether you want to add or remove the selected row or column.

When you add a new row, it appears below the selected cell. When you 
add a new column, it appears to the right of the selected cell.

To change a content setting

Although you set the content type for each column when you create the table, you 

can change this setting easily.

1. Right-click (Windows) or Control-click (Macintosh) any table cell in the 
column you want to change.

2. Select Cell Type... from the pop-up menu.

The Cell Type dialog appears.
Designing with Text and Graphics 4-17



4

C H E C K I N G  S P E L L I N G
3. Select Text or Picture, then click OK. Click Cancel to close the dialog 
without making any changes.

Checking Spelling
NetObjects Fusion can verify whether English text on the current page is spelled 

correctly. 

You can add words to a personal dictionary so they will no longer be flagged. Your 

personal dictionary is a simple text file, so you can use any text editor to add or 

delete words.

To check spelling

1. Choose what you want to check.

● To check all text blocks and tables on the page, select nothing.

● To check a particular block, text string, or word, select it.

2. Choose Spell Check... from the Edit menu.

If an error is detected, the Spelling dialog appears with the misspelled 
word selected in the Change To field.

3. Choose a replacement for the misspelled word. You can either:

● Type a correction.

● Select a suggestion from the list.
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4. Choose how to correct the selected word and go on to the next, if any.

● Click Ignore to skip this instance of the word.

● Click Ignore All to skip all instances on this page.

● Click Change to replace this instance.

● Click Change All to replace all instances on this page.

● Click Add to put the word in your personal dictionary so it will not 

be flagged as an error on any page in the future. 

● Click Suggest to see alternate spellings for the word in the Change to 

field.

● Click Options to choose U.S. or U.K English, and to choose a 

location for your personal dictionary.

● Click Close to cancel the spell check.

As a shortcut, you can replace a misspelled word with a suggestion by 
double-clicking the suggestion.
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Importing Pages
NetObjects Fusion allows you to import pages authored elsewhere. You can import 

the following types of pages:

● HTML documents (HTM or HTML extension)

● Rich Text Format files (RTF extension)

● Text-only files (typically TXT extension)

To import an HTML page

1. Navigate to the page where you want to import an HTML page.

2. Display this page in Page view.

It is easiest to import an HTML file onto a layout that contains no 
content, because elements from the HTML file will overlay existing any 
elements.

3. Choose Import Page... from the File menu.

The Open dialog appears.

4. Select an HTM or HTML file from your hard disk, CD-ROM, or LAN.

5. Click Open.

NetObjects Fusion places the contents of the HTM or HTML file on the 
current page, beginning in the upper left corner of the Layout area.

Note: Depending on the complexity of the HTML, you might have to 
manually re-position and resize your content elements, especially if the 
HTML contains pictures or tables.

To import plain text

NetObjects Fusion automatically places text you import into a text element on the 

selected page.
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1. Navigate to the page where you want to import plain text.

2. Display this page in Page view.

3. Choose Import Page... from the File menu.

The Open dialog appears.

4. In Windows, choose Text Files (*.txt) from the Files of type drop-down 
list. In Macintosh, both the HTML and All Files filters display text files.

5. Select a text file from your hard disk, CD-ROM, or LAN.

6. Click Open.

The text appears in a text box beginning in the upper left corner of the 
Layout area, regardless of other elements that might be on the page. The 
width of the text box is the same as the widest line in the text. The length 
adjusts to accommodate the text. To resize the text box, drag one of its 
handles. Make sure the handles are solid black before you drag.

To import a Rich Text Format page

You can import Rich Text Format (RTF) files onto a page. The text is automatically 

placed inside a text box.

1. Navigate to the page where you want to import formatted text.

2. Display this page in the Page view.

Make sure that this page contains no content.

3. Choose Import Page... from the File menu.

The Open dialog appears.

4. Choose Rich Text Format (*.rtf) from the Files of type list.

5. Select a rich text file from your hard disk, CD-ROM, or LAN.

The text you are importing must be in Rich Text Format (.rtf). Other 
formats such as Microsoft Word format (.doc) are not supported.
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6. Click Open.

The text appears in a text box beginning in the upper left corner of the 
Layout area, regardless of other elements that might be on the page.

The width of the text box is the same as the widest line of text. The 
length of the text box adjusts to the length of the text. To resize the text 
box, drag one of its handles. Make sure the handles are solid black before 
you resize.

Adding Pictures
You can place pictures in the MasterBorders and Layout area of your page. This 

section tells you how to add pictures, modify their size and appearance, set a 

transparent color, add text to pictures, and rotate text and pictures. 

Each picture on a Web page is a separate image file that browsers download and 

display. There are two widely supported image file formats for the Web:

● Joint Photographic Experts Group (JPEG)

JPEG supports 24-bit “true color.”

● Graphics Interchange Format (GIF)

GIFs are 8-bit, 256-color images. NetObjects Fusion also supports GIF 89a 

format.

NetObjects Fusion also supports animated GIFs. An animated GIF file contains 

multiple images that your browser plays in sequence. You can use a GIF animation 

program to create an animated GIF image. Animated GIFs provide an efficient way 

to add movement to your pages without the need for browser plug-ins. Simply 

insert them as you would an ordinary GIF image. 

You can add a link to a picture to make it more useful. You can link an entire picture 

or only certain regions of the picture, called hotspots. When you place a hotspot on 

a picture, NetObjects Fusion creates a client-side imagemap. Client-side imagemaps 

do not require Common Gateway Interface (CGI) scripts to decipher the 

imagemaps’ coordinates. For information on creating links and imagemaps see 

“Creating an Imagemap” on page 7-18.
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Because some browsers do not support pictures, it is important to provide text as a 

backup to the information you present in images. If you use images, take advantage 

of alt tags. Alt tags provide text titles that appear when the images are not displayed. 

Make your alt tags descriptive, so that site visitors know what the pictures are even if 

they can’t see them. The alt tag is linked if the image is a link, but not if it is an 

imagemap. If you use an imagemap, it’s a good idea to place text links elsewhere on 

the page, so that site visitors can still reach the destinations in the imagemap.

Note: When placing pictures on a page, be sure that they do not overlap. Most Web 
browsers do not support overlapping pictures. If your pictures or other content 
elements are layered, they might not appear the way you expect in your site visitor’s 
browser. To correct this problem, follow the instructions in “Detecting Overlapping 
Elements” on page 4-36.

To add a picture

1. Click the Picture tool and draw a bounding box for your picture.

The Image File Open dialog appears, with gif and jpg formats selected 
in the Files of Type list box.

For information on using this dialog, see “To choose an image file” on 
page 3-16.
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The folders in NetObjects Fusion 2.0\Parts\Design Parts contain 
many gif and jpg pictures to choose from.

You can also place images in bmp, pcx, and pct formats. When you 
select one of these formats, NetObjects Fusion offers to convert the 
image to gif or jpg format. 

● If you choose GIF, NetObjects Fusion dithers the image to 256-

colors. 

● If you choose JPEG, NetObjects Fusion retains the color 

information of the original file.

● If you do not convert the image, most browsers will not be able to 

display it.

After you choose, NetObjects Fusion converts the picture and saves it to 
the Assets folder within your site’s folder. The original picture is not 
changed.

2. Select the image file or asset you want from your hard disk, CD-ROM, or 
LAN, then click Open.

The image you selected appears in the bounding box, which 
automatically adjusts to fit the image size.

If you cancel the Image File Open dialog, NetObjects Fusion places a 
large X in the bounding box, to indicate no picture is selected for that 
picture element. 

Double-click the picture element, or select it and click Browse... 
(Windows) or Select... (Macintosh) in the Picture properties palette, to 
re-open the dialog and select a picture.

Changing Picture Settings
The Settings section of the Picture properties tab offers several ways to situate a 

picture inside its bounding box. The default setting is Normal, which means that the 

picture retains its original size and is centered within the box. You can change the 

alignment, force the picture to stretch to the size of its bounding box, or tile the 

picture across the bounding box area.
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For information on using other settings in the Picture properties tab, see “Setting 

the Transparency” on page 4-26, and “Adding Text to a Picture” on page 4-28.

To change picture settings

1. Select the picture you want to modify.

The Picture properties tab appears, showing the name of the selected 
picture in the File field: 

2. Select the setting you want:

● To maintain the picture’s aspect ratio but change its alignment 

within the bounding box, click the Align... button, then select a 

setting from the Vertical and Horizontal sections of the Alignment 

dialog.
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● To crop the picture, select Normal and drag the lower-right handle 

of the bounding box until just the part of the image you want 

appears.

● To stretch the picture across the bounding box area, select Stretch.

● To tile the picture over the bounding box area, select Tile.

3. To show existing hotspots, select the Show Hotspots check box. For 
information on hotspots, see “Creating an Imagemap” on page 7-18.

4. To rotate the picture 90 degrees, click an arrow in the Rotate box.

5. To specify text to display when a browser cannot display the picture, type 
the text in the AltTag field. 

Setting the Transparency
When you place a GIF image on a page, you can select one of its colors and make 

every pixel of that color transparent. Browsers will display all pixels in the image 

except pixels marked transparent. Although only part of the image becomes 

transparent, a GIF with a transparent color is called a transparent GIF. You can use 

transparent GIFs to achieve a natural image shape rather than a rectangular one, or 

to silhouette an image against the page background.
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Figure 4-3. An Ordinary GIF and a Transparent GIF 

Keep in mind that only pixels of exactly the same color will be selected to be 

transparent. If the image background color is dithered, it might contain a mixture 

of different shades to approximate a color. An image without dithering in the 

background works best.

Note: Transparency only works with GIFs. You cannot set a transparency for a JPEG 
or other image file format.

To set the transparent color

1. In the Tools palette, click the Picture tool, then click the Transparency 
Color tool in the secondary palette.

2. With the eyedrop pointer, click a point in an image that contains the 
color you want to make transparent. The picture becomes selected.
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The Transparency section of the Picture properties tab displays the color 
you selected, the Use Current Color box is checked, and the color 
appears transparent in the layout.

Moving, Cropping, and Copying Pictures
You can move and copy picture elements. You can crop an image to keep only a 

portion of it visible on the page.

● To move a picture element, drag it.

● To change the size of a bounding box, drag one of its handles. This 

does not affect the size of the image.

● To crop a picture, select the picture you want to crop, then drag the 

lower-right bounding box handle until you see only the portion of 

the image you want to display.

● To return a bounding box to the picture’s original size, select the 

picture, then choose Size to Image from the Page menu.

● To copy a picture, hold down the Control key (Windows) or Option 

key (Macintosh) while you drag the picture to a new location. The 

original will remain in place. 

You can also use the Cut, Copy, and Paste commands in the Edit menu 
to move and copy pictures.

For information about aligning, stretching, tiling, and rotating pictures, see 

“Changing Picture Settings” on page 4-24. To learn how to align a selected group of 

pictures, and how to make a selected group’s bounding boxes all the same height or 

width, See “Arranging and Sizing Elements” on page 4-36.

Adding Text to a Picture
You can add text to a picture and format its font, size, and alignment. The text you 

add becomes part of a new image file when the page containing the picture is 

published.
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To add text to a picture

1. Select the picture to which you want to add text.

2. In the Picture properties tab, select the Text in Element check box.

The “Your text here” label appears on the selected picture, centered 
vertically and horizontally.

3. Click Settings....

The Text in Element Settings dialog appears.

4. Replace “Your text here” with the text you want to appear on the picture. 

5. Select the Left, Center, or Right Relative Alignment icon to align the text. 

This alignment is relative to the Vertical and Horizontal Position you 
select for the text. For example, if you type two lines of text and click the 
Center icon, the two lines will be center justified. If you select the Left 
Horizontal and Top Vertical Positions, the lines will be centered over 
each other, and will appear in the top left corner of the picture.

6. If you want to change the font, next to Font click Set... to set the font, 
font style, and size in the Font dialog. 
Designing with Text and Graphics 4-29



A D D I N G  P I C T U R E S
You can choose any font listed without concern for your visitor’s 
browser settings or available fonts because NetObjects Fusion will 
composite the text into the image file.

7. Change the font color, if you like, by clicking Color… and selecting from 
the Color dialog.

8. You can set where to place the text on the picture.

● In Horizontal Position, select Left, Center, or Right.

● In Vertical Position, select Top, Center, or Bottom.

9. In the Orientation section, you can set the rotation angle of the text.

● Zero degrees represents no rotation. Drag the slider to rotate the 

text.

● On a Windows system, select the Right angles check box to 

constrain the text to right angles only; deselect it to rotate text to 

any angle. On Macintosh, rotation is always at right angles.

10. When you finish adjusting the text, click Close.
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Using the Drawing Tools
In addition to inserting existing images, NetObjects Fusion lets you draw and edit 

lines and shapes directly on the page.

You can draw rectangles, rounded rectangles, ellipses, polygons, and lines. You can 

also create a line that is generated by an HTML tag, called an HTML rule. 

You can select, move, resize, cut, copy, and paste drawing elements the same way 

you manage other NetObjects Fusion elements.

Drawing Shapes
You can draw rectangles, rounded rectangles, ellipses, and polygons. You can also 

select colors for these shapes and their borders. When the pages containing the 

shapes are published, NetObjects Fusion generates each shape as a GIF file.

To draw an ellipse, rectangle, rounded rectangle, or polygon

1. Select the Draw tool.

2. Select one of the secondary tools: Rectangle, Rounded Rectangle, Ellipse, 
or Polygon, depending on the shape you want to draw.

3. Drag an area to draw the shape.

● To help you draw a circle or square, select Show Grid in the View 

properties tab.

● To draw a polygon, click to set the start point, click to set 

subsequent points, and double-click to end the figure.

● When you draw a rounded rectangle, NetObjects Fusion supplies 

one extra handle inside the object. You can use this handle to edit 

the degree of curve on the corners.

The properties tab for the selected shape appears: 
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4. Change the color of the shape by clicking Color… in the Fill section of 
the tab.

The default color for all shapes is white.

5. Select the width and color of the border.

You can make the border the same color as the shape to render the 
border invisible.

6. Add an alt tag, if you wish, as a text title to be displayed when browsers 
do not display the shape itself.

7. If you like, you can link the shape by clicking Link.

Links and the Link dialog are described in “Creating Links” on 
page 7-12.

8. If you want to adjust the shape or size of the drawing, drag its handles.

● To vary the curve of a rounded rectangle, select it, place the pointer 

over the inside corner handle until it changes to a double-sided 

arrow (Windows) or grabber hand (Macintosh), then drag toward 

the inside until you have the desired curve.
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● To edit the lines of a polygon, select it, place the pointer over any 

handle until you see the double-sided arrow (Windows) or grabber 

hand (Macintosh), then drag the handle until the lines are the way 

you want.

Drawing Lines
You can use the Line tool to draw lines in the default line style selected in Style view, 

and lines with various head and tail styles. You can also set line width and color.

You can use the Rule tool to add HTML rules. HTML rules are fixed width, 

horizontal only, and appear to have beveled edges when displayed by the browser. 

When you create an HTML rule, NetObjects Fusions uses an HTML <HR> tag in 

the page.

To draw an HTML rule

1. Click the Draw tool, then select the Rule tool.

2. Drag a horizontal line.

The HTML rule appears.

3. Set HTML rule properties, if you wish.

● You cannot change the width of an HTML rule.

● Select Default Line Style to instead use the line picture from the 

current SiteStyle.

To draw a line

1. Click the Draw tool, then select the Line tool.

2. Drag from one point to another to set the position, length, and 
orientation of the line.

The point where you press the mouse button becomes the head of the 
line. The point where you release the mouse button becomes the tail of 
the line, even when you drag from right to left.
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To constrain the line to vertical or horizontal, hold down the Shift key 
while dragging.

The line appears on the page, with its endpoints selected.

3. In the Line tab of the Properties palette, select a line width and color for 
the line.

4. In the Style section, set line head and tail styles.

● Select a head style from the Head list. You can choose Line, Point, 

Arrow, Diamond, Circle, or Square. You can also select a color for 

the line head. 

● Select a tail style and color from the Tail list. To omit a tail style, 

select Line. 

● Select Head/Tail share style to automatically give the same ending 

style to both ends of the line.

● Select Line shares single color to convert the head and tail to the line 

color.

● Select Outline style to outline the head and tail with the line color.

Editing Lines
By dragging, you can change the shape and size of the head and tail styles, which 

you cannot do in the Line tab of the Properties palette.

To edit a line

1. Select the line. 

Selection handles appear at the head, middle, and tail.
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When you place the pointer over a selection handle, it changes to a 
crosshair.

● To make the line longer or shorter, or change its angle, drag an end 

handle. 

● To make the line thicker or thinner, drag a side handle.

● To change the shape of the end style, drag one of the endstyle 

handles.

Adding Text to a Shape
You can add text to a shape and format its font, color, size, and alignment. When 

pages containing this text are published, the text is rasterized and saved in the 

shape’s GIF file.

To add text to a shape

1. Draw a shape and select it.

2. In the properties tab for the shape you selected, click the Text in Element 
check box.

The “Your text here” label appears in the shape.

3. Click Settings....

The Text in Element Settings dialog appears.

4. Enter text in the text field, and set any of the other options you wish.

When you type or select an option in the dialog, the result appears 
immediately in the selected object.
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For information about the options and settings in this dialog, see 
“Adding Text to a Picture” on page 4-28.

5. When you finish, click Close.

Arranging and Sizing Elements
You can align two or more elements on their left, right, top, or bottom, and you can 

center them horizontally and vertically. You can also make two or more elements the 

same height or width.

Note: The selected elements assume alignment or size of the last element you select.

● To align elements, select the elements you want to align, then choose an 
appropriate option from the Align Elements command in the Page menu. The 
elements align accordingly. To undo an alignment, choose Undo from the Edit 
menu.

● To make two or more elements the same height or width, select the elements, 

then choose Width or Height from the Size Elements command in the Page 

menu. 

Detecting Overlapping Elements
When your layout includes elements whose boundaries overlap, a browser cannot 

display the elements in the positions you specified. If you preview your page and 

elements do not appear where you expect them to be, you could have an overlap 

problem. In Page view, it might be hard to see where elements overlap if, for 

example, your design includes many elements or you have not enabled the Show 

Element Borders option on the View tab of the Properties palette. NetObjects 

Fusion can help you identify overlapping elements quickly.

To select overlapping elements

1. Choose Select Overlapping Elements from the Page menu.
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2. In the dialog that appears, note the number of overlap occurrences and 
dismiss the dialog.

3. Scroll through your layout and observe which elements are selected. 
Their overlaps are highlighted.

4. Move elements as needed to eliminate the overlaps.

5. Choose Select Overlapping Elements again to verify that you’ve 
corrected all the problems.
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C H A P T E R  5
Managing MasterBorders 
and Optimizing Layouts 5

NetObjects Fusion divides a page into two workspace areas: the MasterBorder area 

and the Layout area. A MasterBorder is an area you can define to extend in from the 

edge of a Web page, just as you would set a top, bottom, left, or right margin for a 

page to be printed by a word processor. With a single click, you can convert a 

MasterBorder margin to an AutoFrame, which lets your site visitor scroll the body 

of your page while elements in the AutoFrame, such as navigation buttons, remain 

in view for easy access.

The Layout area controls elements that are unique to your page. You can design a 

layout in Page view, or instruct NetObjects Fusion to use an external HTML file for 

your page’s layout. Because many of your visitors probably have slow modem 

connections, NetObjects Fusion helps you evaluate your design so it can generate 

the most efficient HTML possible to limit display delays. And because you can’t 

depend on any two visitors’ browsers to display your design the same way, it helps 

you manage how browser variations impact your design. 

This chapter describes critical aspects of MasterBorders and layouts including

● editing, creating, applying, and importing MasterBorders

● creating AutoFrames

● working with layouts

● adding background sounds

● managing external HTML files

● generating efficient HTML

● designing to accommodate browser font variations
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Working with MasterBorders
MasterBorders appear on the top, bottom, left, and right sides of the Layout area in 

Page view, and represent the top, bottom, left, and right margins of your page. You 

can set the size of each margin in the unit of measurement selected for the page. 

Like headers and footers in a word processing document, MasterBorders can display 

elements that you want to appear consistently on a number of pages, such as a 

company logo or call-to-action buttons. Typically they present navigation controls, 

but you can place any text or picture in a MasterBorder just as you do in the Layout 

area. 

You can give a set of top, bottom, left, and right MasterBorder margins a name, and 

then apply them to individual pages much as you would apply a named style to a 

paragraph. These MasterBorder styles make it easy to give a consistent look and feel 

to any number of pages in your site, whether they reside contiguously in a branch of 

your site or are sprinkled widely throughout your site structure.

When you make a change in a MasterBorder, NetObjects Fusion automatically 

makes that change on every page that shares that MasterBorder style. In effect, left 

and right MasterBorders are like vertical headers and footers. Top and bottom 

MasterBorders replace the header and footer functions available in NetObjects 

Fusion 1.0. For information on converting version 1.0 sites to version 2.0 sites, 

please refer to “Importing a Section” on page 2-10.

Importing MasterBorders
When you create a new site, NetObjects Fusion automatically creates a default 

MasterBorder for it. For example, the default MasterBorder for a new blank site 

contains three navigation aids: a banner showing the page name at the top, a 

graphical navigation button bar on the left, and a text navigation bar on the bottom. 

This is because they’re included in the default MasterBorder of the Blank Site 

template. For information on the Blank Site template, new sites, and how to use 

templates, see Chapter 2, “Constructing and Managing a Site.”

When you import a template, or create a new site based on a template, the new 

pages have the same MasterBorders as they did in the site from which they were 

exported (the source site). When you import, all MasterBorder styles that were 
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present in the source site appear in the destination site. So, for example, unless you 

changed the name of the default MasterBorder style in either the source or the 

destination site, you will see Default listed twice in the list of MasterBorder styles 

available on the Layout tab of the Properties palette. In this case, it’s easy to 

determine which one is the site’s default: the site’s default is always the first one on 

the list, even if you edit its name.

When you create a new site based on imported pages, NetObjects Fusion bases the 

site on the Import template, whose default MasterBorders have the following widths 

in pixels: Top, 10; Left, 10; Right, 10; Bottom, 40. This means any new pages you 

create in the site will also initially have these margin widths, unless you edit the 

default MasterBorder.

In Site view, when you import HTML pages from a local or remote site, NetObjects 

Fusion gives each imported page the current site’s default MasterBorders. This 

means when you first view an imported page in Page view, its size will be equal to 

the site’s default MasterBorders plus the size of the imported page.

NetObjects Fusion’s Page view supports two methods for adding HTML pages 

created in other applications: Import Page and External HTML. When you import a 

single HTML page using the Import Page command, NetObjects Fusion expands 

the Layout if needed to accommodate the imported page, but makes no adjustment 

to the page’s MasterBorders. When you specify that a NetObjects Fusion page 

should be replaced by an External HTML page by using the External HTML option 

on the Layout tab, NetObjects Fusion makes no adjustment to its own page size; it 

simply makes sure your site visitor will see that External HTML page in the browser. 

To learn how to set up an External HTML page in Page view, see “Using External 

HTML Files” on page 5-16.

Creating and Modifying MasterBorders
You can modify a site’s default MasterBorders, or you can create your own 

MasterBorder styles. You can use multiple MasterBorder styles in your site. When 

you modify the MasterBorder on one page, NetObjects Fusion updates all pages 

whose layouts that use the same MasterBorder style. This means any object you 

place in a border automatically appears on all pages with that MasterBorder. 
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In a new blank site, the left MasterBorder contains graphical navigation controls, 

and the bottom MasterBorder contains text navigation controls. You can modify the 

default MasterBorder or create a new MasterBorder style from scratch.

To modify an existing MasterBorder

1. In Page view, click inside any MasterBorder margin, or in the grey area 
outside of the page.

The Properties palette displays the MasterBorders tab. The Name field 
shows the name of the MasterBorder style assigned to the current page. 
If you have started with a new blank site and not yet changed the 
MasterBorder, this name is “Default.”

2. In the Margins section, you can either enter values or click up and down 
arrows to change the number of pixels for the Left, Right, Top, and/or 
Bottom margin.

When the Auto-resize Margins (Windows) or Drag and Drop Layout 
Borders (Macintosh) option is turned on in the Page tab of the Edit 
Preferences dialog, you can drag the margin boundary lines to increase 
or decrease margin size. 
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3. Use the Selection tool to arrange content elements, if necessary.

4. Delete unwanted content elements, if necessary.

5. Use the content tools to insert additional text or content.

The changes apply to all pages with the selected MasterBorder style.

To create a new MasterBorder

1. In Page view, click inside the Layout area of the page.

The Properties palette displays the Layout tab. The MasterBorder section 
of the tab shows the name of the MasterBorder style assigned to the 
current page. If you have not selected a different MasterBorder from the 
MasterBorder list, this name is “Default.”

2. Click the New button.

NetObjects Fusion creates a new MasterBorder and names it Untitled 2, 
or the next number in sequence. Until you modify it, a new 
MasterBorder is almost identical to a blank site’s default MasterBorder.
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Note: Each time you click the New button in the Layout tab, NetObjects 
Fusion creates a new untitled MasterBorder. You can ignore extra 
borders, or rename them in the MasterBorders tab for use later. You 
cannot delete MasterBorders. 

3. Click inside the MasterBorder.

The Properties palette displays the MasterBorders tab. The Name field 
shows the name of the MasterBorder you just created—Untitled 2. 

4. In the Name field, type a name for your new MasterBorder.

5. In the Margins section, enter values or click up and down arrows to 
change the number of pixels for the Left, Right, Top, and/or Bottom 
margin.

If the Auto-resize Margins (Windows) or Drag and Drop Layout Borders 
(Macintosh) option is turned on in the Page tab of the Edit Preferences 
dialog, you can drag the margins to increase or decrease their size.

6. Use the Selection tool to arrange content elements, if necessary.

7. Delete unwanted content elements, if necessary.

8. Use the content tools to insert additional text or content.

9. When done, click inside the Layout area to see the new MasterBorder 
listed in the Layout properties tab for this page.

To apply a MasterBorder

1. Navigate to a page where you want to apply a different MasterBorder 
style.

2. Click inside the Layout area.

3. Select the MasterBorder you want from the MasterBorders list in the 
Layout tab of the Properties palette.

The margins of the page display the contents of the selected 
MasterBorder style.
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Using AutoFrames
A frame is an area of a page that contains content independent from the rest of the 

page. When a site visitor scrolls another part of the page, the frame content does not 

move. 

NetObjects Fusion supports two types of frames:

● AutoFrames

● Scripted frames

The NetObjects Fusion AutoFrames feature lets you add frames to MasterBorders 

with a single click. As with MasterBorders, you can add navigation controls, 

banners, text, graphics, and links to frames, just as you normally do. You can also 

add scroll bars to frames, so site visitors can view more information than currently 

appears on the screen. The easiest and most convenient way to create frames is by 

using the AutoFrames feature as described in this section.

NetObjects Fusion also provides a scripting interface that lets you manually code 

frames using the HTML page description language. This method requires 

knowledge of HTML codes and the NetObjects Fusion scripting interface. If you 

prefer the flexibility of creating frames yourself, refer to “Using Scripted Frames” on 

page 11-9.

Links within a frame can display a page, or display information in the same frame or 

a different frame. Frames can also reduce the amount of refreshing your visitor’s 

browser must do. To learn how you can take advantage of these frame features using 

AutoFrames, see “Behind the Scenes with AutoFrames” on page 11-18.

Within a frame, you can influence how variations in browser fonts affect your 

design using the Rows and Columns option on the Frame properties tab. These 

options work within a frame the same way they do within a layout, as described in 

“Choosing a Preferred Table Structure” on page 5-19.

Although Netscape Navigator and Microsoft Internet Explorer support frames, not 

all browsers do. If you use frames, you might need to create an alternate site for 

visitors with browsers that do not support frames. 
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To add and name an AutoFrame

1. Click an empty space inside a MasterBorder, or in the grey area outside 
of the page. 

The Properties palette displays the MasterBorders tab.

2. In the AutoFrames section, click the icon for the border where you want 
to place the frame—Left, Right, Top, or Bottom. 

The frame automatically occupies the entire border area, up to the next 
overlapping frame, if one is present. If the margin is wide enough, a 
orange label such as “Left Frame” appears inside the new frame, and the 
grey margin line changes to orange, indicating a frame is present.

When you create a top or left frame, consider the elements you want to 
add to it. At the upper-left corner of a page created with NetObjects 
Fusion defaults, no boundary line exists between the top and left 
MasterBorder margins. This lets you place elements that extend into 
both the top and left margins. If you convert either the top or left margin 
to an AutoFrame, this benefit is lost. You must place elements within one 
AutoFrame or the other because elements cannot straddle AutoFrame 
boundaries.
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Note: The order in which you turn on each frame determines the order in 
which the MasterBorders overlap each other when viewed in a Web 
browser. To check the sequence, look at the numbers in parentheses next 
to Left, Right, Top, and Bottom on the MasterBorders properties tab. 
You can change the order by turning a frame off, then turning on a 
different frame first.

3. To view the properties of the frame, click the Frame tab.

It displays all the options for the frame. The Frame Name field presents a 
default name such as “Left Frame” (Windows) or “L Frm” (Macintosh). 

4. To change the frame name, type a new name in the Frame Name field. 

Short names work best. NetObjects Fusion will include the frame name 
as part of the HTML filename for the frame in the form 
framename_pagename.html. Because the Macintosh has limits on 
filename length, a long frame name can cause your page to preview or 
publish incorrectly on a Macintosh.

On any system, a frame’s name becomes significant when you want the 
destination of a link to display in an AutoFrame. For more information, 
see “AutoFrames and Links” on page 11-19. 
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You can set the frame background to the SiteStyle, change it to a color, or place a 

picture inside the frame. Small pictures are tiled to fill the frame. 

To set the frame background

1. Click inside the frame where you want to set the background and reveal 
the Frame properties tab.

2. In the Background section of the Frame properties tab, set the 
background options:

● To use the background color of the SiteStyle, select Site Style 

Background.

● To use a different color, select Solid Color, click the Color... button, 

select a color from the Color dialog, then click OK. The selected 

color fills the frame background.

● To use a picture, click Picture. To learn about this dialog, see “To 

choose an image file” on page 3-16. The image, if smaller than the 

frame, is tiled to fill the frame.

To help your site visitors bring off-screen frame information into view, you can 

make your frame appear in the browser with vertical and/or horizontal scroll bars. 

To create a scrollable frame

1. Click inside the frame where you want to set scrolling options and reveal 
the Frame properties tab.

2. In the User Scrollable Frame section of the Frame tab, set when to turn 
scroll bars on.

● To force vertical and horizontal scroll bars to appear in the frame, 

select Yes.

● To prevent scroll bars from appearing in the frame, select No.
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● To display scroll bars when there is more information in the frame 

than can be viewed on the screen, select Auto. The browser will 

display scroll bars only when necessary.

When a frame is a fixed size, a site visitor with a small display might think it takes up 

too much screen space. The User Resizeable Frame option lets the browser or your 

site visitor stretch and/or resize the frame when necessary.

To create a browser-resizeable frame

1. Click inside the frame you want to set and reveal the Frame properties 
tab.

2. In the Frame tab of the Properties palette, select the User Resizeable 
Frame check box.

If the option is not available, enable it by selecting the Generate HTML 
frame borders option in the MasterBorders properties palette as 
described in the next procedure. HTML frame borders must appear so 
that the site visitor can drag them to specify a new size.

You can set NetObjects Fusion to create a rule line separating the frame and the 

Layout area when viewed in a Web browser.

To generate frame borders for browsers

1. Click inside the MasterBorder.

2. Click the MasterBorders tab in the Properties palette.

3. In the AutoFrames section, select Generate HTML frame borders.

When viewed in the browser, the frames on the current page will display 
rule lines.
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Working with Layouts
A layout is the arrangement of elements in the Layout area of a page. A page’s layout 

controls elements that are unique to that page. A page can have one or several 

layouts. The layout that is “on top” is the one that is in control and will be 

published. You might create several layouts per page for as you experiment with 

alternative designs, various prototypes, or for several versions of your site, such as 

English, French, rich media, and text-only. 

A new page has one “Untitled” layout. You select among a page’s various layouts and 

create new ones using the Layout menu next to the navigation buttons in the lower 

left corner of Page view. You can name your layouts individually using the Layout 

tab in the Properties palette. Other options for controlling layout characteristics are 

available in various locations.

● When the Page Labels option in the View menu is checked, the labels for and 
margin line between the Layout area and MasterBorders appear. 

● When the Auto-resize margins (Windows) or Drag and drop layout borders 
(Macintosh) option is turned on in the Page tab of the Edit Preferences dialog, 
you can drag the margin lines to increase or decrease the Layout area.

● To automatically size the Layout area to the elements it contains, choose Size 
Layout to Elements from the Page menu. The Layout area retains a size large 
enough to accommodate any elements in the MasterBorders. To enlarge the 
Layout later, reset the Layout Width and Height in the Layout properties tab, or 
drag the margins.

● To view the Layout area only, choose Layout Only from the View menu. Choosing 

this option also improves product performance. When in Layout Only mode, 

your MasterBorders are hidden but still preview. Choose Layout Only again to 

redisplay MasterBorders.

To modify layout properties

1. Click the Layout properties tab.
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2. In the Layout Name field, type a name for the layout.

NetObjects Fusion saves the layout for this page.

3. If you like, set the page width and height for this layout. You can set the 
unit of measurement (centimeters, inches, points, or pixels) in the View 
tab of the Properties palette.

You can either enter values or click the up or down arrows to increase or 
decrease the current value. A standard size is 640 pixels in width.

4. If you like, select a MasterBorder for the page. For information, see 
“Working with MasterBorders” on page 5-2.

5. In the Background section, set the background to be used in this layout:

● SiteStyle. SiteStyles include backgrounds. Select this option to use 

the default background specified by the SiteStyle selected in the 

Style view.

● Solid Color. Select this option and click Color… to select a solid 

background color. Solid backgrounds offer significantly faster 

download times than picture backgrounds.
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● Picture. Browsers can display pictures as backgrounds by tiling 

them over the area of a page. When you first select this option, the 

Image File Open dialog automatically appears. Choose an image file 

for the background. For information about the Image File Open 

dialog, see “To choose an image file” on page 3-16. Once you have 

selected a picture, you can change it by clicking Browse… 

(Windows) or Select... (Macintosh).

Using Multiple Layouts
A single page can have multiple layouts for prototyping or publishing several 

versions of a page. Use the Layout drop-down menu in the lower-left corner of the 

Page view to choose the current layout and create additional ones. 

When you publish your site, NetObjects Fusion publishes the layout currently 

selected for each page. 

Figure 5-1. The Layout Drop-Down Menu

To add a layout to a page

1. In Page view, navigate to the page where you want to add a layout.

Unless you have changed it, the default page layout name, “Untitled 
Layout,” appears in the Layout drop-down menu in the lower-left corner 
of the Page view window.

2. Choose Add… from the Layout menu.

The Layout area becomes blank.

3. Type a name for the layout in the Layout Name field of the Layout 
properties tab.

4. Add content elements to the page.
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5. If necessary, configure the page layout settings in the Layout 
properties tab.

The Layout drop-down menu always lists the layouts you’ve applied to the current 

page. Choose from this menu to switch between layouts. 

Adding Background Sounds
You can assign a sound to play when a site visitor views the page. You can use sound 

files in au, aiff, midi, or wav formats. The sound can play once, or continuously.

For a site visitor to hear sounds on a Windows system, the visitor’s computer must 

have a sound board and speakers installed. On any system, the visitor’s browser 

must be capable of playing sounds, either through a built-in player or a helper 

application. Some sound formats also require support from the Web server. To 

preview and test sounds, your system must also be appropriately configured. For 

more information about using sound files on various platforms, see “Inserting a 

Sound File” on page 8-2.

To add a background sound

1. In Page view, click the Layout area of the page where you want the sound 
to play.

2. In the Background section of the Layout tab, click the Sound check box.

3. In the Background Sound dialog, type a path or click Browse... 
(Windows) or Select... (Macintosh) to select a sound file from your hard 
disk, CD-ROM, or local area network (LAN). 

4. To make the sound repeat while the page is open, select the Continuous 
Loop check box.

5. Click OK.

The sound plays when you preview the page.
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Using External HTML Files
You might want to add to your site an HTML file that you downloaded from a Web 

site or created with an HTML editor. When you use the External HTML option in 

the Layout properties palette, NetObjects Fusion replaces the current page with 

your selected external HTML file when you preview or publish your site. This 

option is useful when:

● You want to add an existing HTML page without converting it to NetObjects 
Fusion format.

● You have created a special page with another tool, and prefer to maintain it with 
that tool.

● You’ve created a page in NetObjects Fusion, want to directly edit its HTML, and 
don’t want NetObjects Fusion to overwrite your HTML changes next time you 
preview or publish.

Because external HTML files are not converted to NetObjects Fusion format, you 

cannot combine NetObjects Fusion page elements and external HTML files on the 

same layout. 

For information on importing more than one HTML page from other sites, see 

“Importing a Template or Site” on page 2-14. For information on importing one 

HTML page and converting it to NetObjects Fusion format, see “Importing Pages” 

on page 4-20.

To reference an external HTML file

1. In Page view, display the page that you want to replace with an external 
HTML file.

2. Click the Layout area, and in the Layout properties tab, select the 
External HTML check box.

3. In the Open dialog, select a file with an HTM or HTML extension, then 
click the Open button.

The Layout and MasterBorder area displays a grey background with an X 
from corner to corner, to indicate that it has been replaced by an external 
HTML file. In Site view, the icon for this page is shaded.
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The HTML page is displayed by the browser when you preview or 
publish the page. 

Note: You can toggle between internal layouts and external HTML files 
by clicking the External HTML check box in the Layout properties tab. 
This is useful when recreating pages in NetObjects Fusion. You can 
publish with a working external HTML file while designing your layout.

When you publish or stage, your external HTML pages are included in the 

my_html folder. Adding an external HTML page does not automatically bring in its 

assets. Make sure all assets used by your page are registered in the Assets manager. 

Otherwise, you must move them to the server manually. One shortcut to add all 

assets is to import the page as described in “Importing Pages” on page 4-20, then 

use the procedure above to cover the imported elements with the original HTML.

To edit an external HTML file

◆ To edit the external HTML file, double-click the grey area that covers the 
replaced page. 

NetObjects Fusion launches the HTML editor specified in the HTML 
Editor field in the General tab of the Edit Preferences dialog.

To edit the HTML of a NetObjects Fusion page

1. Create the page in NetObjects Fusion Page view.

2. Stage your site.

When you stage, NetObjects Fusion creates an HTML file that contains 
relative references. If you use an HTML file created during the preview 
process, it might contain absolute references that won’t be valid when 
you publish your site.

3. Back in Page view, click the Layout area, and in the Layout properties 
tab, select the External HTML check box.

4. In the Open dialog, navigate to your Preview folder, select the HTML 
file NetObjects Fusion created for your page, then click the Open button.
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The Preview folder is in your site’s folder in NetObjects Fusion 
2.0\User Sites. The HTML file has the same name as your page.

5. Double-click the grey area that covers your page.

NetObjects Fusion launches the HTML editor specified in the HTML 
Editor field in the Page tab of the Edit Preferences dialog. Here you can 
tweak the HTML NetObjects Fusion created for your page. Because 
you’ve made the page external, NetObjects Fusion will not update it and 
potentially overwrite your changes when you preview or publish.

Adding Assets Using Drag and Drop
You can drag image, text, sound, video, and other files from Windows Explorer or 

Macintosh Finder and drop them onto your page in Page view. You can also drag 

text, images, and links from any application that supports drag and drop. 

In general, you can drag in any kind of file you can place using a tool or command 

in Page view. Before you add a media file, consider whether its format is appropriate 

for the platforms and browsers you’re planning to support. See Chapter 8, “Adding 

Rich and Interactive Media,” to learn which platforms, browsers, and plug-ins 

support which media file types.

You can drag and drop the following types of files:

● Image files in .gif, .jpg, and other common graphics formats. The image appears 
on the page. 

● Text files in plain text or ASCII format, such as .txt. The text appears in a text box 
on your page. 

● HTML files. Files with .htm or .html extensions are treated as external HTML 
files, and display the gray crossed out page, indicating the original HTML format 
is preserved.

● Sound files in .aiff, .au, .mid, .midi, .ra, .ram, and .wav formats. The sound icon 
appears on the page.

● Video files in .avi, .mov, .qt, .mpg, .mpeg, .mpe, and .mpv formats. The video 
icon appears on the page.

● Shockwave files in .dcr format. The Macromedia image appears on the page.
5-18 Managing MasterBorders and Optimizing Layouts



O P T I M I Z I N G  Y O U R  L A Y O U T
● NetObjects Fusion Components in .nfx format. The component placeholder 
appears on the page.

● Java applets with the .class extension. NetObjects Fusion displays the Java applet 
image on the page. 

Optimizing Your Layout
Two critical aspects of how your site visitor’s browser displays your layout are 

beyond your control: connection speed and text size. It’s likely that many of your 

visitors have slow modem connections, so you want your pages to use the most 

efficient HTML possible to limit display delays. Also, visitors might set their 

browsers to display text in a larger or smaller size, or in a different font. Differences 

in default font sizes on different platforms, and differences in how browsers from 

different manufacturers display text create additional variations. For example, 

default browser fonts on a Macintosh are smaller than the defaults on a Windows 

system, and Microsoft Internet Explorer puts slightly more white space between 

lines of text than Netscape Navigator does. Any of these variations can make a text 

block in your visitor’s browser larger or smaller than it appears when you’re 

designing a page in NetObjects Fusion’s Page view. 

To help your designs accommodate these visual and performance dynamics, 

NetObjects Fusion includes controls for:

● Choosing a preferred table structure for page elements, which helps control the 
layout when the site visitor’s browser is set to a larger font than you had planned.

● Locking a text block’s minimum size, which helps control the layout when the 
site visitor’s browser is set to a smaller font than you had planned.

● Viewing the HTML table structure that NetObjects Fusion uses to describe your 
pages to the browser, which helps troubleshoot the efficiency of your layout.

Choosing a Preferred Table Structure
NetObjects Fusion lets you choose a relationship between text blocks and other 

elements on your page. You can specify whether it’s more important for elements to 

retain their alignment either vertically or horizontally. By default, NetObjects 

Fusion assumes vertical relationships are most important. So, for example, if your 
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page has 10 pixels of white space between the end of a text block and a picture 

beneath it, NetObjects Fusion will set up the HTML for your page in a way that 

ensures that white space will always be 10 pixels, regardless of the size of the text in 

the browser. Examples later in this section illustrate this concept in more detail.

To specify the relationship, you’ll use two radio buttons on the Layout tab of the 

Properties palette, labeled Columns and Rows. 

The Frames properties tab also offers Rows and Columns options that let you 

specify relationships within a frame. To understand how the Columns and Rows 

options work in frames and layouts, consider this layout in NetObjects Fusion Page 

view:
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Figure 5-2. Designer’s layout of page in NetObjects Fusion Page view

The two text blocks are aligned at the top, as are the pictures below them. This 

alignment is maintained when you preview the site with normal-sized type in your 

browser, as shown below: 

Figure 5-3. Page generated with default Columns option shown with designer’s font size selected in 
browser
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This type is normal sized because the default proportional font and size settings of 

NetObjects Fusion match those of the browser. However, your site visitor might be 

browsing from a different platform, or the browser might be set to use a different 

proportional font setting.

The Rows and Columns options offer you more control for influencing what 

happens when a browser is set to display in a larger font. 

The following shows what happens if you select the Columns option. Notice that 

the white space between each text block and the image under it stayed constant: they 

maintained their vertical relationship. However, the tops of the two pictures are no 

longer aligned. 

Figure 5-4. Page generated with default Columns option shown with larger font size selected in browser 

The Columns option is recommended for best layout fidelity. This option is selected 

by default.

The following illustration shows what happens if you select the Rows option. Notice 

that the two pictures at the bottom of the page are side-by-side: they maintained 

their horizontal relationship. However, additional white space appears under the 

right-hand text block. 
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Figure 5-5. Page generated with Rows option shown with larger font size selected in browser

It’s easy to experiment with this yourself. Set up a page with relationships similar to 

those shown above, then preview the page. If you’re using Internet Explorer 3, you 

can simply click the Font button on the main tool bar to increase and decrease the 

font size and to observe layout dynamics at different sizes. If you’re previewing in 

Netscape Navigator, choose Preferences from the Options menu, select the Fonts tab 

in the dialog that appears, then choose a different font size using the Choose Font 

buttons. In either case, choosing a different font size can show you how variations 

can affect your layout. For example, choosing a larger font in Microsoft Internet 

Explorer for Macintosh can simulate how the fonts will look in a Windows browser, 

which has larger defaults.

Locking a Text Block’s Minimum Size
Locking a text block’s size can influence what happens when your site visitor 

chooses a smaller font than you used to design the page. It can help you minimize 

the white space that separates the block from the element beneath it.

NetObjects Fusion offers a Lock Size option on the Text tab of the Properties palette. 

When you select it, you can adjust the block’s bounding box to be larger than the 

text it contains. The locked text block will always be at least this big in both Page 
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view and the browser. You cannot lock the maximum size of a text block; it always 

grows to fit the text, both in Page view and in the browser.

Of course, making a text block larger than the text it contains does not minimize 

white space; it creates it, thereby increasing the amount of scrolling your visitor 

must do to view your content. 

To minimize white space, you must lock text block size to the minimum needed to 

accommodate the smaller font. Select the text in the block, set it to the smallest size 

you want to support, then select the Lock Size option. 

Restore your text to its original size and the block will expand to display it and you 

can continue designing as normal.

The payoff comes when you preview the page in a browser with small fonts. For 

example, if you lock the minimum size of the right-hand text block (the one that 

contains Contact Information) in Figure 5-3, preview with small fonts looks like 

this:

Lock Size option
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Figure 5-6. Page generated with Columns option and “Contact Info” text block locked shown with smaller 
font selected in browser

Notice that although the text on the left shrank, the picture beneath it did not move 

up, leaving unnecessary white space. The Contact Information text block shrank by 

the same amount, but the picture below it moved up to maintain the amount of 

white space you laid out between the bottom of the text block and the top of the 

picture in Page view.

Viewing HTML Table Structure
To display your page with the greatest possible accuracy, the HTML file NetObjects 

Fusion generates describes your page using HTML tables. The more your design 

allows NetObjects Fusion to isolate text elements in table cells, the more efficient the 

HTML it generates will be and therefore the more quickly your design will render in 

your site visitor’s browser. Viewing HTML table structure in Page view lets you see 

whether NetObjects Fusion can divide your layout into cells efficiently.

To preview how NetObjects Fusion divides your layout content into table columns 

and rows in Page view, use the Show HTML Table button on the Layout tab of the 

Properties palette.
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When you press and hold down the Show HTML Table button, all grid or guide 

lines as well as element borders disappear temporarily while NetObjects Fusion 

draws grey lines that show where it is dividing the layout into tables. 

Figure 5-7. Table borders showing in NetObjects Fusion Page view

When creating tables, NetObjects Fusion does its best to isolate text blocks from 

adjacent elements—those on either side. This prevents text expansion and 

contraction from moving those adjacent elements up and down. Of course when 

text expands, elements below it must move down. But, according to whether you 

choose to emphasize vertical or horizontal alignment, expanded text pushes down 
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just the elements immediately below it (Columns option), or all elements below it 

(Rows option).

This means optimization works best when your design allows NetObjects Fusion to 

isolate text boxes using straight horizontal and vertical lines, as shown in the 

illustration above. Optimization is less effective for a design such as the one below:

Figure 5-8. Designer’s layout of page in NetObjects Fusion Page view

Because no horizontal or vertical lines can separate the text blocks in this design, 

variations of text size in the browser will affect all adjacent elements of the design. 

The Show HTML Table button can help you identify design problems like the one 

above. If you press the button and see that elements are not isolated from their 

neighbors, adjust your design and view the result by pressing the button again. If 

elements still are not grouped as you want, consider that they might not be aligned 

with pixel accuracy, even though they appear to be perfectly aligned with the grid. 

To solve this, select the elements you want to group and choose from the Page menu 

either Align Elements Left or Align Elements Right, depending on which makes 

sense for your design.
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C H A P T E R  6
Using SiteStyles 6

The Style view is where you view, apply, edit, and create the look and feel of your 

entire site. SiteStyles™ are sets of thematic elements that are included with 

NetObjects Fusion. Some style elements are graphical, and others affect the text 

colors used in your Web pages. NetObjects Fusion 2.0 comes with a gallery of 

brand-new, professionally designed SiteStyles. A number of these take advantage of 

GIF transparency to blend seamlessly with any background color you choose. You 

can use these new SiteStyles as they are, edit them, or create your own styles to give 

your site a distinctive look.

This chapter describes SiteStyles and how to use them, including

● applying styles

● creating custom styles

● editing styles

● adding and removing styles
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Applying SiteStyles
SiteStyles include backgrounds, banners, buttons, data list icons, lines, and text 

colors for normal text, regular link text, and visited link text. When you select a 

name in the Gallery list, NetObjects Fusion displays the elements of that style in the 

Elements window:

Figure 6-1. The Style View

When you apply a SiteStyle, NetObjects Fusion automatically distributes its 

elements throughout your site. For example, it replaces all your navigation buttons 

with the new button style specified, while maintaining the relevant links. Take 

advantage of this power by experimenting with SiteStyles, exploring how different 

styles complement your content. Trying a SiteStyle takes only a few clicks in the 

Style Gallery.

Gallery list

Current SiteStyle

Click to set the 
selected SiteStyle.

Click to create a 
new SiteStyle.

Click to edit style 
elements.

Selected SiteStyle

Element Window
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NetObjects Fusion comes with a large selection of styles. You can download new 

styles as they become available at www.netobjects.com.

To apply a SiteStyle

1. Select a SiteStyle from the Gallery list.

The elements of the selected style appear in the Elements window.

2. Click Set Style to apply the current style to your site.

The name above the Gallery list changes to the one you selected to 
indicate the style has been applied. The next time you open the Page 
view, you’ll see the new style elements in place on each page.

Creating a SiteStyle
You can create original styles of your own to give your site a unique look. Simply 

collect image files for your banner, buttons, lines, icons, or backgrounds, and 

integrate them in the Style view.

Each SiteStyle has its own folder inside the Styles folder. When you create a new 

SiteStyle, NetObjects Fusion creates a folder for the style as well as subfolders to 

contain image files for elements based on images, such as the background, banners 

and buttons. As you define each style element, NetObjects Fusion copies its image 

file to the appropriate subfolders.

SiteStyles give you control over the appearance of text on navigational aids 

throughout a site. One of a web page designer’s challenges is to design attractive 

pages that load quickly. Text blocks load quickly, but because your visitor’s browser 

and platform control the font and size in which text is displayed, you cannot rely on 

text blocks to establish visual themes for your pages.

With SiteStyles, you can choose any font on your system for banners and buttons. At 

publish time, NetObjects Fusion dynamically generates bitmapped image files for 

these banners and buttons using the font you specified for each element. This means 

all your site visitors will see the fonts you selected, regardless of their browser or 

fonts installed on their systems. 
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SiteStyles are tightly integrated with automated navigation and linking. To display 

banners and buttons in Page view, NetObjects Fusion overlays text on an image. It 

draws the text from either the referenced page’s name on the Page properties tab or 

the name specified in the Custom name dialog. It gives the text the font style, size, 

and color you assigned in the Elements mode of the Style view. It combines this text 

with the image file for that element of the SiteStyle.

When you preview, stage, or publish the site, NetObjects Fusion creates a new .gif 

file for each new button and banner in the site. It puts these new .gif files in the 

auto_generated_images folder of the Preview, Stage, or Publish assets folders.

To create your own style

1. In the control bar, click the New Style button.

The Request dialog appears:

2. Enter a new style name.

3. Click OK.

NetObjects Fusion displays a new Elements screen that includes the list 
of basic style elements. It gives this list your new style name. It also 
creates a new folder for your style within the NetObjects Fusion 
2.0\Styles folder.

4. Define each style element by editing it as described in the following 
section, “Editing Styles.” 

5. Click Set Style.
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Your custom SiteStyle images and settings are applied to your site 
automatically. For even more flexibility—for example, to use more than 
one banner image in your site or to use a different image for each button 
in a navigation bar—use the Button and Banner properties tabs in Page 
view as described in “Using Navigation Button Bars” on page 7-3 and 
“Using Banners” on page 7-9.

Editing Styles
NetObjects Fusion allows you to edit any element of a style to customize it. When 

you create a style of your own, you must define it by assigning attributes to each 

element. Use the Elements view to edit existing style elements or create a custom 

SiteStyle from scratch. You cannot edit styles in the other views, Page view for 

instance.

When you select a new image for a style element, NetObjects Fusion automatically 

copies it into that element’s folder for the SiteStyle assigned to that site. If you’re 

editing an existing SiteStyle, the new image file replaces the one previously assigned 

to that element. It copies the new image to the folder, but doesn’t overwrite the old 

image file unless the new and the old files have identical names. NetObjects Fusion 

applies the new image to every site using that SiteStyle.

For example, suppose you want to modify the SiteStyle Nippon, to replace the 

butterfly on the highlighted primary button with a bumblebee. First you must 

create the bumblebee button image in an image editing application. You can give 

the new image file any name you like. Then, in Elements view, you edit the 

highlighted primary button style by selecting the image file that contains the 

bumblebee. The image file you select is copied to the Primary Buttons Highlighted 

folder in NetObjects Fusion 2.0\Styles\Nippon. If the new image file has the same 

name as the original file, the original will be overwritten. Thereafter, every site 

created on your machine that uses Nippon will use this file to display the 

bumblebee on all highlighted primary buttons.

This applies to all style elements that can be based on images: Background, Banner, 

Primary Button, Secondary Button, Line Picture, and Data List Icon.
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To edit a SiteStyle

1. Display the elements of the SiteStyle you want to edit. To do this, you 
can either

● Click the style’s name in the styles list, then click the Elements 

button on the secondary control bar.

● Double-click the style’s name.

The Elements list appears on the left, displaying the standard list of style 
elements under the selected style name. The Edit button also appears:

Elements list

Click to edit the 
selected element.

Element Window

Style being 
edited
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2. To open an element for editing:

● In the element list, select the style element you want to change and 

click Edit.

● Double-click the style element in the element list.

A dialog appears. Each style element has a different dialog for modifying 
it. Each is explained individually later in this section.

3. In the dialog, select new attributes for the style element.

For graphical style elements, you can select a new image file instead of 
the default file. 

4. When you’re finished modifying the element, click OK.

To edit a background

1. Double-click Background in the Elements list. 

The Background Style dialog appears:
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2. Select a background option:

● Select None to use a grey background, which is a browser default.

● Select Color to enable a solid-color background such as white, the 

default. Choose a different color by clicking the Color… button and 

selecting from the Color dialog. On the Macintosh, use the pull-

down menu to select the system palette or the color palette for a 

particular browser.

● Select Picture to use an image file as a background, which browsers 

will tile across the area of each page. Click Browse… (Windows) or 

Select... (Macintosh) to choose an image file from your hard disk, 

CD-ROM, or LAN.

3. Click OK.

To edit a banner 

1. Double-click Banner in the Elements list.

The Banner dialog appears:

2. To change the banner’s image, click Browse… (Windows) or Select... 
(Macintosh) to choose an image file from your hard disk, CD-ROM, 
or LAN.

3. To change the appearance of text, click Text Settings... and set text 
options as described in the following procedure, “To edit text settings.” 

4. Click OK.
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To edit text settings

1. From the Banner or Button dialog, click Text Settings… to set options 
for the banner or button titles.

The Text Settings dialog appears.

2. Select the Left, Center, or Right Relative Alignment icon to align 
multiple lines of text. 

3. To change the font, click the Set... button next to the Font list field. The 
Font dialog appears. In this dialog select the font, font style and size.

In Windows, use the Script pull-down menu to select the style of script. 
Western is the default.

4. Change the font color, if you like, by clicking the Set... button next to the 
Color field and choosing from the Color dialog.

5. You can set where to place the text on the picture.

● In Horizontal Position, select Left, Center, or Right.

● In Vertical Position, select Top, Center, or Bottom.
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6. In the Orientation section, you can set the rotation angle of the text.

● Zero degrees represents no rotation. Drag the slider to rotate the 

text.

● In Windows, select the Right angles check box to limit the text to 

right angles only; deselect it to rotate text to any angle. The 

Macintosh slider automatically selects right angle settings.

7. When you finish adjusting the text, click OK.

After you close the banner or button dialog, the banner or button text 
appears with its new options in the Elements window.

Each SiteStyle includes a primary button and a secondary button. The navigation 

controls that appear throughout your site can be configured to display one or the 

other. For example, top-level pages can display the primary button set while lower-

level pages display the secondary set. 

Each button has two states you can edit: regular and highlighted. Button 

highlighting is used in navigational button bars to show which page a visitor is 

currently viewing. You can turn highlighting on and off in the Nav. Bar properties 

tab found in the Page view. Highlighting is turned on by default.

To edit a primary button

1. Double-click Primary Button in the Elements list.

The Primary Button dialog appears:
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2. To select a different primary button image:

● Choose a regular button image by clicking the first Browse… 

(Windows) or Select...(Macintosh) button and choosing an image 

file from your hard disk, CD-ROM, or LAN.

● Choose a highlighted button image by clicking the second Browse… 

(Windows) or Select... (Macintosh) button and choosing an image 

file from your hard disk, CD-ROM, or LAN.

3. To set different text options:

● Choose options for regular button text by clicking the first Text 

Settings… button. 

● Choose options for highlighted button text by clicking the second 

Text Settings… button.

The Text Settings dialog appears, where you can set text options as 
described in the preceding procedure, “To edit text settings” on 
page 6-9.

4. When finished, click OK in the Text Settings dialog and then click OK in 
the Primary Button dialog.

To edit a secondary button

1. Double-click Secondary Button in the Elements list.

The Secondary Button dialog appears:
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2. To select a different secondary button image:

● Choose a regular button image by clicking the first Browse… 

(Windows) or Select... (Macintosh) button and choosing an image 

file from your hard disk, CD-ROM, or LAN.

● Choose a highlighted button image by clicking the second Browse… 

(Windows) or Select... (Macintosh) button and choosing an image 

file from your hard disk, CD-ROM, or LAN.

3. To set different text options:

● Choose options for regular button text by clicking the first Text 

Settings… button. 

● Choose options for a highlighted button text by clicking the second 

Text Settings… button.

The Text Settings dialog appears, where you can set text options as 
described in the earlier procedure, “To edit text settings” on page 6-9.

4. When finished, click OK in the Text Settings dialog and then click OK in 
the Secondary Button dialog.

A variety of narrow, horizontal, and page-wide images can serve as line pictures to 

separate Web pages into sections. A number of line picture images are included in 

NetObjects Fusion styles. You insert Line pictures in the Page view using the Draw 

tool.

To edit a line picture

1. Double-click Line Picture in the Elements list.

The Image File Open dialog appears. 

2. Select an image file from your hard disk, CD-ROM, or LAN.

3. Click Open.
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Data list icons appear when you use a data object to create a data list in the 

Page view.

To edit a data list icon

1. Double-click Data List Icon in the Elements list.

The Image File Open dialog appears.

2. Select an image file from your hard disk, CD-ROM, or LAN.

3. Click Open.

You can configure the normal text color for a SiteStyle to use a default color other 

than basic black.

To edit a normal text color

1. Double-click Normal Text Color in the Elements list.

The Color dialog appears.

2. Select one of the basic colors, or define a unique color.

3. Click OK.

Link colors show site visitors where links are located, and browsers keep track of 

which links have already been followed. Regular links are links the site visitor has 

not yet followed. Set a regular link color that is different from the color you plan to 

use in ordinary text.

To edit a regular link color

1. Double-click Regular Link Color in the Elements list.

The Color dialog appears.

2. Select one of the basic colors, or define a unique color.

3. Click OK.
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Visited links show site visitors where they have already been. By assigning them a 

different color than that of the regular links, you let site visitors know at a glance 

that the link is a familiar one. If color consistency is more important to you than 

this detail, you can assign identical colors to regular and visited links.

To edit a visited link color

1. Double-click Visited Link Color in the Elements list.

The Color dialog appears.

2. Select one of the basic colors, or define a unique color.

3. Click OK.

Adding and Removing Styles
You can add new styles to the Style Gallery, either those you obtain from NetObjects 

or those you create on your own. 

Importing a SiteStyle
NetObjects Fusion provides many pre-built SiteStyles, and NetObjects is creating 

more. You can download new SiteStyles as they become available from 

www.netobjects.com. After you download a new style, you must import it to use it 

with your current site.

Note: The list of SiteStyles available in the Style Gallery is specific to your .nod file. 
This means the imported style appears in the current site but will not appear in the 
list of the other sites you have already created. It can appear in new sites you create 
based on the default Blank Site template if you update it as follows: make a backup 
of the default Blank Site.nft that resides in your AutoSites folder, open a new blank 
site named Blank Site, import the SiteStyle(s) you want, export the site as a 
template, and replace the default Blank Site template with the Blank Site.nft you 
created. You can follow a similar procedure to add styles to any template. When you 
insert a template, any new styles it contains are added the active site’s Style Gallery.
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To import one SiteStyle

1. In the Style view, choose Import Style… from the File menu.

The Open File dialog appears.

2. Open the style folder of the style you wish to import and select its .ssf 
file. 

3. Click Open.

NetObjects Fusion adds its name to the Gallery list.

A style folder can exist anywhere and still be imported. It doesn’t have to be in the 

NetObjects Fusion Styles folder. For example, it might reside externally, such as on a 

server, and be downloaded to your local drive. The Import Style command makes a 

complete copy of an imported style’s folder in the appropriate place.

To import all available SiteStyles

◆ In Style view, choose Update Styles List from the Edit menu.

NetObjects Fusion updates the Style Gallery of the active site to match 
the current contents of the Styles folder. This process also deletes any 
styles in the style list that are not included in the Styles folder.

Removing Styles
Removing styles from within NetObjects Fusion does not delete the .ssf files and 

associated images in the NetObjects Fusion 2.0\Styles folder. The removal process 

removes the style only from the Style Gallery list of the active .nod file. 

To remove a style from the list

1. In the Style Gallery list, select the style you want to remove.

2. Remove the style by one of these methods:

● Choose Remove Style from the Edit menu.

● Press the Delete key.
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3. Click Yes in the warning dialog.

The style disappears from the Style Gallery list of your particular site. It 
remains in the NetObjects Fusion 2.0\Styles folder.
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Creating Links and 
Navigation Aids 7

When you create a new blank site, NetObjects Fusion automatically presents 

navigation bars and banners on every page to help site visitors understand and 

navigate the structure of your site. In a new blank site, these navigation aids are 

included in the site’s default MasterBorder. When you create your own navigation 

bars and banners, you can put them in any MasterBorder or page layout area.

In addition to navigation bars and banners, NetObjects Fusion makes it easy to 

create any kind of navigation aid you might want using links. For example, you can 

make any text, image, or drawn shape into a navigation aid by adding a link.

This chapter tells how you can create the following in the Page view:

● navigation button bars

● banners

● internal links

● anchors

● smart links

● external links

● imagemaps
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Working with Navigation Aids
When you create a new blank site, NetObjects Fusion automatically includes three 

navigation aids in the site’s default MasterBorder: a banner showing the page name 

at the top, a graphical navigation button bar on the left, and a text navigation bar on 

the bottom.

Figure 7-1. Default MasterBorder for a new blank site

Typically, navigation controls appear in the top, bottom, and left margins of a Web 

page, but NetObjects Fusion lets you easily place navigation controls anywhere on 

the page. Banner titles and button names are determined by the page name set in 

the Site view or in the Page properties tab. Buttons are linked according to your site 

structure. Whenever you change your site structure in the Site view or change the 

name of a page, NetObjects Fusion automatically updates the navigation controls. 

Banners and button bars offer high visibility, easy access, and integrated movement 

through your site.

NetObjects Fusion places text navigation controls in the bottom MasterBorder by 

default. Text navigation controls are important because they provide navigation for 

visitors whose browsers do not display the graphical navigation control. You can 

publish text-only versions of your pages that display text in place of any graphical 

navigation control you create. Site versions are described in Chapter 14, “Staging 

and Publishing a Site.”

Navigation Button Bar

Text Navigation Bar

Banner
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Using Navigation Button Bars
Navigation bars are rows or columns of buttons or text that are automatically linked 

to other pages in your site. You can use the Navigation Bar tool to add navigation 

bars to MasterBorders or page layouts.

Figure 7-2. A Navigation Button Bar

By default, button names are the same as the page name, unless you specified a 

custom name for buttons, as described in “Renaming a Page” on page 2-8.

The default style for buttons is determined by the SiteStyle you set in the Style view, 

described in Chapter 6, “Using SiteStyles.” The SiteStyle button image is 

automatically distributed to the buttons throughout your site. You can change the 

button style for a button bar without changing the SiteStyle. 

To add a navigation bar

1. Go to the page where you want to place the navigation bar.

2. Click the Navigation Bar tool. 

3. From the secondary tool palette, click the Navigation Bar or Vertical 
Navigation Bar tool.

4. Drag a box in the MasterBorder or Layout area where you want to place 
the button bar.

A new graphical button bar appears, and the Properties palette displays 
the Nav Bar tab. The button bar contains the buttons indicated by the 
setting in the Display field of the Nav Bar properties tab.

Buttons are linked 
to other pages in 
your site.

Button styles 
are set in the 
Style view.
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5. Position the bar by dragging it with the Selection tool.

To set the display level

1. Select the button bar, then click the Nav Bar tab in the Properties palette.

2. In the Display section of the Nav Bar tab, click the Set... button.

The Nav Bar Display dialog appears.

3. In the Show section, set the navigation option for this bar:
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● First Level generates buttons linked to the children of your 

Home page.

● Parent Level includes links to all pages in the level above the 

current page in the site structure.

● Current Level links the buttons to this page and all other pages on 

the same level with the same parent page.

● Child Level generates links to the children of the current page.

Open the Site view if you are unsure which level of the site you want to 
link to.

4. Select Include Home Page to include your Home page as a link in this 
button bar. 

By default, Include Home Page is selected to provide quick access to the 
hub of your site.

In the Buttons section of the Nav Bar properties tab, you can set whether the 

selected bar displays text or graphical buttons. Because secondary button images are 

typically lighter or smaller than primary button images, you can use them to suggest 

your site structure to your visitor. For example, you might use the secondary style 

for the lower levels of your site.

To set button type

● To apply the primary button style for the current SiteStyle, select 

Primary Buttons. 

● To apply the secondary button style, select Secondary Buttons.

● For a text-only button bar, select Text. 

In the Style section of the Nav Bar properties tab, select whether to use the current 

SiteStyle or a different style for the buttons in the selected button bar.
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To set button style

● To use the current SiteStyle, select Site Style.

● To use a different style, select Other Style, then select a style from 

the drop-down list box. This can be convenient if, for example, you 

want to use a third and fourth button style on the third and fourth 

levels of your site. In Style view, you can create a SiteStyle that uses 

any button image you want. For more information, see “Creating a 

SiteStyle” on page 6-3.

● To highlight a button when its page is open, select Use Highlighting.

In the Display (in pixels) section of the Nav Bar properties tab, set the pixel size of 

the selected Navigation button bar border, and the spacing between buttons.

To set button spacing

● To increase or decrease the Navigation bar border, scroll or type to 

enter a new number in the Border field.

● To increase or decrease the spacing between buttons, scroll or type 

to enter a new number in the Spacing field.

In the Fill Background section of the Nav Bar properties tab, set whether to use a 

background color in the selected Navigation button bar.

To set button fill background

● To use a background color, click the Color... button, select a color 

from the Color dialog, then click OK. 

● To use no background color, select None in the Fill Background 

section.

You might want to change the image on just one or two buttons in a Navigation 

button bar, instead of all buttons in the bar.
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You can change the image on an individual button to an image you select. However, 

when you use your own image, the button does not automatically display the page 

name.

When choosing an image for a button, you can select among files in gif, jpg, bmp, 

pcx, and pct formats, as appropriate to your platform. Most Web browsers support 

images in gif or jpg format only, so if you select an image in one of the other 

formats, NetObjects Fusion will offer to convert it to gif or jpg for you. Your image 

should be an appropriate size for a button. If you like, you can use an image from 

one of the primary or secondary button image folders in a SiteStyle.

To change the image on a particular button

1. Click the button you want to change.

The entire button bar appears selected.

The Properties palette displays the Button tab, which shows the name of 
the selected button. The Picture field shows the path and name of its 
associated image file.

2. Click the Browse... (Windows) or Select... (Macintosh) button.
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The Image File Open dialog appears. To learn about this dialog, see “To 
choose an image file” on page 3-16.

For a convenient source of button images, look in NetObjects Fusion 
2.0\Styles and view the folder for each NetObjects Fusion style. Open 
the folder for the desired style, then look in the Primary Buttons and 
Secondary Buttons folders for button image files. You can also check 
the Buttons folder in NetObjects Fusion 2.0\Parts\Design Parts.

3. When you have selected the button image you want to use, click the 
Open button.

The button changes to the selected image, and the file name is listed in 
the Picture field of the Button properties tab. The button does not 
display the page name.

Note: NetObjects Fusion creates a copy of the selected image, gives it a 
filename that includes both the site name and the pagename, and places 
it in the appropriate button folder of the button’s SiteStyle.

To delete a navigation bar

1. Select the Navigation bar you want to delete.

Be sure the bounding box handles are solid and not hollow.

2. Delete the Navigation bar using one of these methods:

● Choose Cut or Delete Element from the Edit menu.

● Press Ctrl-X (Windows) or z-X (Macintosh).

● Press the Delete key.

● Right-click (Windows) or Control-press (Macintosh) the 

navigation bar and choose Delete Element from the pop-up menu.

The Navigation bar disappears.

If you wish to undelete the Navigation bar, choose Undo from the Edit 
menu.
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Using Banners
Banners are graphical title bars that display the title of the page, helping site visitors 

navigate your Web site. You can use the Navigation Bar tool to add new banners. 

Figure 7-3. A Banner

Banners are just like pictures, except that they contain the page names shown in Site 

view and listed in the Name field of the Page properties tab. To learn more about 

how NetObjects Fusion creates banners, see “Creating a SiteStyle” on page 6-3.

By default, banner names are the same as the page name, unless you specified a 

custom name for the banner, as described in “Renaming a Page” on page 2-8.

To add a banner

1. Go to the page where you want to place the banner.

2. Click the Navigation Bar tool. 

3. From the secondary tool palette, click the Banner or Vertical Banner 
tool. 

4. Drag a box in the MasterBorder or Layout area where you want to place 
the banner.

A new banner appears in the current SiteStyle, and contains the page 
name specified in the Page properties tab or Custom Name dialog. The 
Properties palette displays the Banner tab.

Banner style 
is set in the 
Style view.

Page name is set 
in the Site view 
or the Page 
properties tab.
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5. Position the banner by dragging it with the Selection tool, if necessary.

The MasterBorder in a new blank site includes a default banner that matches the 

current SiteStyle. For any single banner, you can change the banner style or use your 

own banner image. However, when you use your own banner image, the banner 

does not automatically display the page name. 

When choosing an image for a banner, you can select among files in gif, jpg, bmp, 

pcx, and pct formats, as appropriate to your platform. Most Web browsers support 

images in .gif or .jpg format only, so if you select an image in one of the other 

formats, NetObjects Fusion will offer to convert it to .gif or .jpg for you. Your image 

should be an appropriate size for a banner, and include the text you want the banner 

to display. 

To change the banner style

1. Select the banner you want to change.

2. In the Style section of the Banner properties tab, select a SiteStyle from 
the Other list.
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The selected banner changes to reflect the new style. 

To return the banner to the style selected for the site, click the Site Style 
button.

To change the banner image

1. Select the banner you want to modify.

The Banner properties tab appears.

2. In the Picture section of the Banner tab, click the Browse... (Windows) 
or Select... (Macintosh) button. Or you can simply double-click the 
banner.

The Image File Open dialog appears. To learn abut this dialog, see “To 
choose an image file” on page 3-16.

On a Windows system, the Folders tab shows the image file for each 
banner on the current page. For example, you might have two different 
banner images on a page.

For a convenient source of other banner images, look in NetObjects 
Fusion 2.0\Styles and view the folder for each NetObjects Fusion style. 
Open the folder for the desired style, then look in the Banners folder for 
the banner image file. You can also check the Banners folder in 
NetObjects Fusion 2.0\Parts\Design Parts.

3. When you have selected the banner image you want to use, click the 
Open button.

The banner changes to the selected image, and the file name is listed in 
the Picture section of the Banners properties tab. The banner does not 
display the page name.

Note: NetObjects Fusion creates a copy of the selected image, gives it a 
filename that includes both the site name and the pagename, and places 
it in the Banners folder of the banner’s SiteStyle.
reating Links and Navigation Aids 7-11



7

C R E A T I N G  L I N K S
To delete a banner

1. Select the banner you want to delete.

2. Delete the banner using one of these methods:

● Choose Cut or Delete Element from the Edit menu.

● Press Ctrl-X (Windows) or z-X (Macintosh).

● Press the Delete key.

● Right-click (Windows) or Control-press (Macintosh) the banner 

and choose Delete Element from the pop-up menu.

The banner disappears.

If you wish to undelete the banner, choose Undo from the Edit menu.

Creating Links
Links are among the most powerful mechanisms on the Web. With NetObjects 

Fusion, you can easily link page elements to any other point on the Web, including 

points within your site. You can link segments of text, drawn shapes, whole pictures, 

or areas of pictures in the form of an imagemap. You can also create anchors—

markers at a specific location on a page—to aid navigation in long pages.

The navigation controls described in the previous section are page-based, 

automated linking mechanisms. The linking techniques described in this section are 

ways of manually linking other content elements such as text, pictures, and drawn 

shapes, both within the site and outside it. As you organize your site, you’re likely to 

create multiple links to the same location from different parts of your site. You can 

update these links efficiently in the Assets view, as described in “Managing Links” 

on page 13-8.

The properties tab for all linkable elements contains a Link button in the lower left-

hand corner. The Link button opens the Link dialog, where you specify the 

destination of a link. There are three types of links, and each has its own tab in the 

Link dialog:
-12 Creating Links and Navigation Aids



C R E A T I N G  L I N K S
● Internal Link, which links to a page or anchor inside the site.

● Smart Link, which links to a relative position in the site, such as previous page or 
next page. Sometimes these are called structural links.

● External Link, which links to a page in another site by a variety of methods: via 
URL (Universal Resource Locator), FTP (File Transfer Protocol), and others.

If Show Element Icons is turned on in the View properties tab, NetObjects Fusion 

displays the Link or Anchor icon when you create a link or anchor.

You can follow an existing link to its target page or anchor. To do this, either right-

click (Windows) or Control-press (Macintosh) a linked element then select Follow 

Link from the pop-up menu that appears, or select the element and choose Follow 

Link from the Edit menu. To follow a text link, first click the text so it includes the 

blinking insertion point.

To edit a link, select the linked text or object, click the Link... button in the 

properties tab, then change the link in the Link dialog that appears. To remove a 

link, select it, click Link... in the properties tab, and click Unlink in the Link dialog.

Creating an Internal Link
Internal links lead to pages or anchors within your site. If you move the page to a 

different place in your site structure or change the page’s name, NetObjects Fusion 

automatically updates the link accordingly. The Assets view shows you the internal 

links in your site and lets you track them as they are automatically updated.

To create an internal link

1. Select an item to link.

● If you are linking text, select the text you want the browser to 

highlight with the link color.

● If you are linking a picture or other element, click to select it.

2. In the properties tab for that element, click Link....

The Link dialog appears, with the Internal Link tab selected by default. 
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● The Page section lists all the pages in the current site. 

● The Anchor section lists all the anchors on the page selected in the 

Page Name section. To learn how to create an anchor, see “Adding 

an Anchor” on page 7-14.

3. In the Page section, select the target or destination page for the link. 

● Scroll the list, or type the first few letters of the page name to 

automatically select the first page name starting with those letters.

● To select the current page, select the Current Page button.

● If you are linking to an anchor on a page, first select the page, then 

select the anchor name in the Anchor section.

4. Click Link.

NetObjects Fusion creates the link. When your site visitor clicks the 
linked element, the browser will display the top of the destination page.

Adding an Anchor
An anchor is a marker on a page. Anchors are useful on long pages, so that your site 

visitors can go directly to a particular part of the page, instead of scrolling and 

searching for information.
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You can place an anchor anywhere in a text element or table, or on a picture or 

drawn shape. You can link to an anchor from anywhere. When the site visitor clicks 

the link, the browser displays the page containing the anchor, beginning at the 

location of the anchor.

To add an anchor

1. Click to place the insertion point within a line of text, or select an image 
or drawn shape. 

2. In the properties tab for the selected element, click the Anchor... button.

The Add Anchor dialog appears. The Anchors on Page section shows any 
existing anchors on the selected page.

3. Type a name for the anchor in the Name field. The name cannot contain 
spaces.

4. Click OK.

If Show Element Icons is turned on the View properties tab, the 
Anchor icon appears at the anchor location on the page.

To edit an anchor, click the Anchor icon and change its name in the 
Change Anchor dialog that appears. To delete an anchor, select it and 
click Remove in the Change Anchor dialog.
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Creating a Smart Link
Smart links lead to a page in your site based on its relative position in the structure, 

not its name. These links automatically adjust when you change your site structure. 

For example, if your smart link leads to the parent of the current page, and you later 

move the current page to a different parent, NetObjects Fusion updates the link to 

point to the new parent. Sometimes a smart link is called a structural link.

To create a smart link

1. Select an item to link.

2. In the properties tab for that element, click Link....

The Link dialog appears.

3. Click the Smart Link tab.

4. Select the type of link you want:

● Select Home to link to your Home page.

● Link to the parent of the current page by selecting Up.

● Next Stacked Page links to the next page in a stack.

● Previous Stacked Page links to the previous page in a stack.
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● Select Next Page to link to the sibling to the right of this page in 

your site structure.

● Previous Page links the sibling to the left of the current page in your 

site structure.

5. Click Link.

For detailed information about stacked pages, see Chapter 12, “Data Publishing.”

Creating an External Link
External links are Universal Resource Locators (URLs) that point to other pages and 

items in other sites on the Web. A valid URL can include the protocol, host name 

(or DNS), pathname, and sometimes a filename, such as 

http://www.netobjects.com/ products/fusion.html. Each external link you 

create becomes an asset of the site that you can easily update in Assets view.

To create an external link

1. Select an item to link.

2. In the properties tab for that element, click Link.

The Link dialog appears.

3. Click the External Link tab.
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The External Link tab shows a list of external link assets used within the 
current site.

4. Select an internet protocol from the URL drop-down list.

If you’re creating a link that requires no protocol, clear the URL field. 
The list makes it easy to choose a protocol, but you don’t have to use one.

5. Either enter a new URL or, if you’ve already created a link asset for this 
URL, select it from the list. 

When the site visitor clicks the selected element, this link target will be 
displayed.

If you select a link target from the list of assets, its URL and name appear 
in the URL and Asset Name fields. You can modify the name and URL if 
you like.

6. If you’re creating a new external link asset, enter a name for this link 
target in the Asset Name field. 

This name is for your reference, and appears in the list of links in Assets 
view, allowing you to quickly identify and sort link destinations. It is not 
added to HTML generated when your site is staged or published. 

7. Click Link.

Creating an Imagemap
An imagemap lets you specify different links for different areas of a picture. You 

create an imagemap by drawing hotspots on a picture. You can link as many 

hotspots as you like in a single image, but the hotspots cannot overlap or extend 

beyond the edge of the picture. Because the imagemaps you create with the 

following procedure do not require a CGI script running on the server, they are 

called client-side imagemaps.

To create a client-side imagemap

1. Select a picture on a page.

2. Select the Picture tool to bring up its secondary tools.
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3. Select one of the hotspot tools, depending on whether you want to create 
a rectangular, circular, or polygon hotspot.

4. Draw a hotspot on the image.

If you are using the Polygon Hotspot tool, you must single-click to 
establish each vertex of the polygon, then double-click to complete the 
hotspot shape.

The Link dialog appears.

5. In the Link dialog, select the type of link by clicking one of the tabs.

6. Select a destination for the link or type a URL. For more information 
refer to the preceding sections.

7. Create more hotspots, if you like, using the same tools and the Link 
dialog.

Note: Once a picture is imagemapped, it can be moved anywhere on the 
page and even copied and pasted elsewhere in the site.

To edit an existing hotspot, select it. The Hot Spot properties tab appears.

● To edit the link, click Link.... The Link dialog appears, displaying the tab for the 
type of link. Change the link destination or click Unlink to remove the link.

● To make the hotspot an anchor, click Anchor.... and type a name in the Add 
Anchor dialog that appears. 
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C H A P T E R  8

A

Adding Rich and 
Interactive Media 8

To help you give your Web site increased impact, NetObjects Fusion provides tools 

that make it easy to add rich and interactive media to your pages. You can use tools 

on the Tools palette or drag-and-drop to add elements such as

● sounds

● video

● QuickTime movies

● Java applets

● Shockwave files

● ActiveX controls
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Inserting a Sound File
Sound files are digital audio files that a browser can play on a properly-configured 

system. Before you add sound to your pages, determine whether you and your 

visitors can hear it. For a site visitor to hear sounds on a Windows system, the 

visitor’s computer must have a sound board and speakers installed. On any system, 

the visitor’s browser must be capable of playing sounds, either through a built-in 

player or a helper application. Typically, visitors must download these from the 

sound technology developers and install them in their browsers, but most popular 

browsers have sound file players built in. For example, Live Audio technology is 

built into Netscape Navigator. Some sound formats also require support from the 

Web server. To preview and test sounds, your system must also be appropriately 

configured. 

Once your system is properly configured, NetObjects Fusion makes it easy to add 

popular audio file formats to your pages. The list below describes the formats it 

supports, as well as each formats requirements:

● Windows audio (.WAV), plays on Windows only

● .AIFF, with browser plug-ins, can play on Windows 95 and Macintosh

● .MIDI, can play on all operating systems

● .AU, used in Java applets and can play on Sun and NeXT systems 

● RealAudio™ (.RA, .RAM), with browser plug-in, can play streaming audio on all 
systems; requires Web server-resident software.

NetObjects Fusion also lets you add any of these formats as a background sound 

that plays when a visitor views your page. For more information, see “Adding 

Background Sounds” on page 5-15.

Because importing a sound file uses the <EMBED> tag of standard HTML, you can 

use the Sound tool to offer your site visitors other file types. For example, after you 

select the Sound tool and drag an area on your page, choose a file format such as 

Adobe Acrobat PDF, text document, or spreadsheet. When a site visitor clicks the 

document’s icon, the file either displays in the browser or downloads to the visitor’s 

system. 
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Because an audio file has no visual element, netObjects Fusion represents the audio 

file with a graphic, usually an icon or an inline player control bar recognizable by 

the browser. When a site visitor clicks the icon or the play button on the inline 

player control bar, the browser either plays the sound file or opens a helper 

application to play it.

To insert a sound file

1. Click the Rich Media tool.

2. In the secondary palette click the Sound tool.

3. Draw a bounding box on your page.

The Open dialog appears.

4. Select a sound file from your hard disk, CD-ROM, or LAN. 

5. Click Open.

The default sound icon appears on your page, and the Sound tab is 
displayed in the Properties palette:

The Filename field displays the name of the selected sound file.
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6. Click Browse... (Windows) or Select... (Macintosh) to change your 
sound file selection, if necessary.

7. In the Display section, set the display options for this sound:

● To change the sound icon, select Icon and click one of the three 

standard sound icons.

● To select another image file as an icon representing the sound, select 

File, then click Browse... (Windows) or Select... (Macintosh).

● To use the standard audio player for your particular browser, click 

Inline.

8. To provide text for the browser to display if it cannot play the sound, use 
the AltTag field.

Inserting a Video File
Video files are digital movies and animations that can be played on-line. Most 

require helper applications or browser plug-ins. If you include video files in your 

site, be sure to provide a link to a download site for a plug-in that can play your files. 

However, the latest browsers have video players built in. For example, Netscape 

Navigator includes Live Video and QuickTime support.

Video files can be displayed as part of a Web page. Placeholder icons represent the 

video files, and site visitors can click the icons to launch a separate browser window 

to play them. Videos can also be displayed inline on the page itself. In this case, the 

first frame of the video is displayed on the Web page.

NetObjects Fusion supports popular video file formats, including:

● QuickTime™ media (.MOV, .QT), supported by Windows and the Macintosh 
with browser plug-ins.

● Moving Pictures Experts Group (.MPG, .MPEG), supported by Windows and the 
Macintosh with browser plug-ins.

● Microsoft Audio Video Interleaved (.AVI), supported by Windows and by the 
Macintosh with the help of an .AVI to .QT media format conversion utility.
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● Vivo Active Producer (.VIV), supported by Windows and the Macintosh with 
browser plug-ins.

To insert a video file

1. Click the Rich Media tool.

2. In the secondary tool palette, click the Video tool.

3. Draw a bounding box on your page for the video placeholder. 

The Open dialog appears. 

4. Select a video file from your hard disk, CD-ROM, or LAN. 

5. Click Open.

The video icon appears on your page and the Properties palette displays 
the Video tab:

6. Click Browse... (Windows) or Select... (Macintosh) to change your video 
file selection, if necessary.

7. Select the display option for this video using the radio buttons in the 
display section:
Adding Rich and Interactive Media 8-5



8

I N S E R T I N G  A  V I D E O  F I L E
● Select Icon and click one of three standard icons.

● Select File, then click Browse… (Windows) or Select... (Macintosh) 

to choose another image file to use as an icon.

● Click Inline to display the first frame of the video inside the browser 

window.

8. To provide text for the browser to display when it cannot play the video, 
use the AltTag field.

Inserting a QuickTime Movie
Apple Computer’s QuickTime™ is a multimedia software architecture used to 

create and deliver graphics, sound, video, text, and music. Its various versions can 

provide interactive, virtual, and 3D effects. 

On a Macintosh, NetObjects Fusion’s QuickTime tool makes it easy to place any 

QuickTime movie on a page. Or you can simply drag a QuickTime movie out of the 

Finder or other application and drop it onto your NetObjects Fusion page. On a 

Windows system, use the Rich Media Video tool to place QuickTime movies.

To view QuickTime movies, your site visitors must have the QuickTime plug-in 

installed in their browsers. For more information on QuickTime, visit Apple 

Computer’s Web site at www.apple.com.

To insert a QuickTime movie

1. On a Macintosh system, click the QuickTime tool.

2. Draw a bounding box for the QuickTime movie.

An Open dialog appears.

3. Select the Preview checkbox option.

The Open dialog expands to include a preview area.
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4. Select a QuickTime movie from your hard disk, CD-ROM, or LAN.

The movie’s poster frame appears in the preview area. If it does not, click 
Create.

If you select a video file that can be converted to QuickTime, the Open 
button becomes a Convert button. 

5. When you have selected the movie you want, click Open or Convert.

The poster frame of the movie appears in the element you placed and 
the QuickTime tab is revealed on the Properties palette.

:

The Filename field displays the name of the selected movie.

6. To choose a different movie to display in this element, click the Select... 
button.
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7. To display the QuickTime icon instead of the poster frame in Page view, 
select the Icon radio button in the Display section of the QuickTime 
properties tab.

8. To provide text for the browser to display when it cannot play a movie, 
use the AltTag field.

Inserting a Java Applet
Java applets are an efficient way to add interest and motion such as scrolling 

messages and color cycling buttons to your site.

Java applets are platform-independent applications with compact file sizes and a 

wide range of capabilities. Usually, applets run on the client platform, which means 

that site visitors download them and run them inside their browser windows. Most 

browsers are Java-compatible.

NetObjects Fusion embeds the Java applet file on your page. If the applet conforms 

to a certain standard, NetObjects Fusion can display the applet’s parameters on the 

Java Applet properties tab. For Java applets written this way, it is easy to edit the 

applet’s variables without leaving NetObjects Fusion.

Visit the NetObjects Fusion Web site to learn the details of using Java applets, and 

the standard that allows NetObjects Fusion to display parameters.

To insert a Java applet

1. Click the Java tool.

2. Drag a bounding box to specify the size of the applet interface.

The Open dialog appears.

3. Select an applet from your hard disk, CD-ROM, or LAN.

The file extension for a Java applet is .class.

You can use the led_clock .class Java applet in the NetObjects Fusion 
2.0\Parts\Plug-in Parts\Java Applets folder as an example. This applet 
provides a digital clock using LED style characters. 
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The Java applet placeholder image appears on your page and the Java 
Applet tab is displayed in the Properties palette:

4. Set the parameters for this applet.

● If the parameters for this applet are registered in the Parameters 

section of the Java Applet tab, you can edit them by double-clicking 

each one and entering values in the Enter Value dialog.

● To get helpful hints on how to change parameters, read the text that 

appears in the Parameter Info section of the Java Applet tab.

● To remove a parameter, select it and click the minus sign (–). The 

selected parameter is deleted immediately. 

● To add a parameter, click the plus sign (+) and enter a name and 

value in the dialog that appears.

Typically you can add more instances of a parameter that already 
exists. For example, if text1 and text2 already exist, the applet will 
probably recognize a text3 parameter you create. If you add a 
parameter the applet does not recognize, it will be ignored.
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● To change the order of the parameters, use the arrow buttons. The 

selected parameter moves up or down in the list.

● To change the applet file, double-click the Java Applet element on 

the Web page, and select a different .class file in the Open dialog 

that appears.

● If your applet uses more than one .class file, use the List... button to 

associate the extra files. In the Java Applet Files dialog, click Add.... 

then select another .class file. The selected Java applet appears in 

the Class list. To delete an applet from the Class list, click List, select 

the applet, then click Delete.

5. To provide text for the browser to display if it cannot launch the applet, 
use the AltTag field.

Once you’ve placed a Java element placed, you cannot change the applet it embeds. 

If you want to replace an applet you’ve already placed with another, you must delete 

the first Java element and place the another. 

Inserting Shockwave Files and Other Plug-Ins
Because the Web is evolving rapidly, leading manufacturers have made their 

browsers “open.” Thanks to this open architecture, you can add the latest 

functionality to your site without requiring your site visitors to use a custom 

viewing application. Examples of these “plug-ins” are Shockwave and HotSauce. 

Using Shockwave
NetObjects Fusion supports Shockwave file formats. These files can be passive or 

interactive animations. They can also contain sound. 

Before your site visitors can view your Shockwave files, they must install the 

Shockwave plug-in for their particular browser and platform. These plug-ins are 

available from the Macromedia Web site at: http://www.macromedia.com.
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The NetObjects Fusion 2.0\Parts\Plug-in Parts\Shockwave folder contains 

ready-to-use Shockwave files that you can include in your site. NetObjects Fusion 

supports various Shockwave formats, including:

● Shockwave for Director 4.0 and 5.0 (.DCR)

● Director (.DIR)

● Protected Director (.DXR)

● Shockwave Audio (.SWA)

Any Shockwave files you embed appear inline on the Web page itself. In fact, you 

can use the Shockwave tool to place any plug-in. However, no matter what kind of 

plug-in you place, Page view always displays the Macromedia placeholder.

To insert a Shockwave file

1. Select the Shockwave tool.

2. Draw an area the same size as the file’s stage.

The stage is the space in which the animation will appear. Check the 
stage size of the file before you draw the box. If you draw a box whose 
dimensions are different from the stage dimensions of the module, you 
can resize the final animation display.

The Open dialog appears. 

3. Select a Shockwave file from your hard disk, CD-ROM, or LAN. 

4. Click Open.

The Shockwave placeholder image appears on your page and the 
Shockwave tab is displayed in the Properties palette:
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5. Click Browse… (Windows) or Select... (Macintosh) to change your 
Shockwave file selection.

6. To provide text for the browser to display if it cannot play the animation, 
use the AltTag field.

Using HotSauce Meta-Content Format
Browsers that support Apple’s HotSauce Meta-Content Format (MCF) can display a 

3D representation of the pages in your site. To display the visual site, the browser 

uses a file with extension .mcf in the site’s root directory. NetObjects Fusion can 

generate this .mcf file when you preview, stage, or publish your site. This MCF file 

allows browsers that support HotSauce to provide 3D-style navigation of your 

entire site. Much like SiteMapper, the advanced navigation application included in 

NetObjects Components, HotSauce can make a large site easier to navigate.

To use HotSauce, you must have the HotSauce plug-in installed in your browser. 

This Netscape plug-in is available from the Apple HotSauce site: 

http://hotsauce.apple.com. HotSauce is emerging technology and as of the 

writing of this manual, the plug-in is available for Netscape Navigator 2.0 and 

greater, Internet Explorer, and Cyberdog. HotSauce support will be built into 

Netscape 4.0. 
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To insert HotSauce MCF as a custom window

1. In Publish view, click Settings..., then click the Modify tab in the 
Configure Publish dialog.

2. In the Site Map section, select Generate HotSauce Site Map.

3. Preview your site so NetObjects Fusion can generate the requested mcf 
file.

4. Select your Home page in the Site view, then select Page view.

HotSauce needs to be at the top level of your site structure.

5. Click the Rich Media tool, then select the Shockwave tool in the 
secondary tools palette.

6. Drag an area on your Home page for the HotSauce navigation window.

An Open dialog appears.

7. Choose All Files in the List Files of Type drop-down menu.

8. In the folder User Sites\your site folder\Preview, select yoursite.mcf.

9. Click Open.

10. A Macromedia placeholder appears on your page.

Although this placeholder says “Made with Macromedia” it is actually a 
placeholder for your .mcf file. 

11. Preview your site again.

12. If your browser supports HotSauce, the HotSauce navigation window 
appears inline on your page.

13. Click in the window and drag your mouse to start navigating 
throughout the site.

14. Investigate other options by clicking on the menu in the upper left hand 
corner of the HotSauce navigation window.
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To use HotSauce MCF as an external link

1. Preview your site.

2. Go to your Home page in NetObjects Fusion.

HotSauce needs to be at the top level of your site structure.

3. In Page view, select the element you want to link.

4. Click Link in the lower left corner of the element’s properties tab.

5. Click the External Link tab.

6. Enter a URL in the URL field.

● To test the link in preview, enter file://hard_disk_name/ NetObjects 

Fusion 2.0/User Sites/my_site/Preview/my_site.mcf.

● To test the link in stage or publish, enter http://www.domain.com/ 

my_folder/my_site/Preview/my_site.mcf.

7. Click Link.

8. Preview your site again.

9. Click this link 

A second browser session is launched and presents the HotSauce 
navigation window.

10. Click in this browser and drag your mouse to start navigating 
throughout the site.

11. Investigate other options by clicking on the menu in the upper left hand 
corner of the HotSauce navigation window.

Inserting an ActiveX Control
ActiveX controls are supported on Windows systems by Microsoft Internet Explorer 

version 3.0 and later, and allow you to add custom capabilities such as audio and 

movie players, calendars, custom buttons, and forms to your Web pages. You can 
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view documents such as Microsoft Office files right in Internet Explorer, without 

launching the associated program. Your site visitors must use Internet Explorer 3.0 

or later to view content created with ActiveX controls. 

The ActiveX tool is available only in NetObjects Fusion for Windows. ActiveX is not 

supported on the Macintosh.

ActiveX requires that you install Microsoft ActiveX controls on your system. 

ActiveX controls can be obtained from the Microsoft Web site. Or, check 

www.netobjects.com and www.microsoft.com for links to archives of free, 

ready-to-use ActiveX controls. 

To insert an ActiveX control

1. Click the ActiveX tool.

2. Draw a bounding box for the control.

3. The Insert ActiveX Control dialog appears, listing the ActiveX controls 
currently installed on your system. The bottom section shows the 
filename of the selected control. ActiveX control files have an ocx 
extension.

Select the Set Codebase check box to display the file name of the control 
in the Codebase field of the ActiveX properties tab.

4. Click OK.

The Properties palette displays the ActiveX tab for the selected object:
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The ActiveX tab displays the parameters for the selected control. 

5. To change a parameter, select it in the ActiveX tab, then edit it in the text 
field at the top of the tab. 

● To accept the text, click the check mark. 

● To cancel the edit, click the X.

● To display more options or the Open dialog, you can click the 

Browse button, which is labeled with three dots, when it appears 

next to the text field.

Click Properties... to open a Control Properties dialog where you can 
edit other parameters for the selected control. 
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Designing and 
Implementing Forms 9

This chapter describes forms, an interactive page element supported by most 

browsers. Forms are used by your site visitors to submit information to your server 

or request more information. 

This chapter describes how to use forms in NetObjects Fusion. The discussion 

includes

● assigning Common Gateway Interface (CGI) scripts

● creating the Submit and Reset buttons 

● creating text boxes, check boxes, radio buttons, and combo 
boxes

● adding hidden fields for client-side parameters
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Common Gateway Interface (CGI) Scripts
Forms are typically controlled on the Web server by CGI scripts. To use a form with 

NetObjects Fusion, you must have a CGI script that tells your server what to do with 

the data it receives. 

CGI scripts run on a Web server as extensions to the server. Not all Web 

administrators allow their customers to install CGI scripts on their servers. Some 

provide standard CGI scripts for all their customers to use. A few do not support 

CGI at all. For information on CGI support for your server, consult your Web server 

administrator or Internet Service Provider (ISP). 

Form Elements
Each page can contain one form. Your form can include a variety of elements:

● Buttons, check boxes, radio buttons, and combo boxes to select information. 

● Text boxes where site visitors type information.

● A Submit button to send the form data to the server.

● A Reset button to clear any information a site visitor has entered.

Each form element has its own properties tab, where you can configure its actions 

and attributes.

Browsers display form elements differently, so check your form on all the browsers 

and platforms you want to support to be sure the elements appear correctly. For 

example, early versions of popular browsers use characters to size the width of form 

elements, while later versions use pixels to size the width of form elements. 

The HTML to present forms with a large number of small elements can get very 

large. You can minimize the size of the HTML file NetObjects Fusion generates by:

● Choosing the Rows option for Table Structure in the Layout tab for the form.

● Using the Align Elements option from the Page menu to align form elements.
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Figure 9-1. A Web Form

Naming Form Elements
You set the names for the form elements in the Properties palette for each element. 

Each CGI script has its own element naming conventions. In general, the names 

cannot include spaces or punctuation. Check the documentation for your CGI 

script for naming conventions.

Single-line 
text fields

Check boxes

Combo boxRadio buttons

Multiple-line 
text field

Form buttons
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Creating Submit and Reset Buttons
The Submit and Reset buttons are essential parts of your form. Clicking the Submit 

button sends the form data to your server and clicking Reset clears the information 

a site visitor has entered. 

NetObjects Fusion provides two methods to create the Submit button:

● The AutoForm tool. Use this method to automatically use the Forms-Handler 
CGI script provided with NetObjects Fusion. 

● The Button tool. Use this method if your form will use either your own CGI 
script or a CGI script from a third party.

Using the AutoForm Submit Button
The NetObjects Fusion AutoForm component makes it easier to create a working 

Submit button for a form. It automatically uses the Forms-Handler.cgi script 

provided with NetObjects Fusion. Before you can successfully test or deploy a form 

that uses an AutoForm submit button, you must configure your server as described 

in the AutoForm usage note available at www.netobjects.com/support.

To add an AutoForm Submit Button

1. In Page view, display the page containing your form.

2. Click the NetObjects Components tool.

3. In the secondary tool palette, click the AutoForm tool.

4. Drag a rectangle where you want to place the Submit button.

A Submit button appears on the page, and the Component tab of the 
Properties palette shows the parameters you must set for this button.
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5. To set a parameter, click the parameter, enter the value in the Form 
Handler text box. Then, for Windows, click the check mark or the X 
mark. For Macintosh, click OK or Cancel.

● Button Name. Name that appears on the Submit button. The 

default is “Submit.” The button adjusts to the text length.

● Success URL. Published URL of success page, for example, 

http://www.myserver.com/formstest/html/success.html. Browser 

displays this page if submission is successful. You must create this 

page in your site before selecting it here. To select the page, click 

Success URL, and then click the Browse (...) button display a list of 

pages in your site, or simply double-click the Success URL property 

to display the Link dialog. In the dialog, select the success page, then 

click Link to return to the Component tab.

● Error URL. Published URL of error page, for example, 

http://www.myserver.com/formstest/html/error.html. Browser 

displays this page if submission fails, usually caused when the site 

visitor does not fill in a required field. See Required Field # later in 

this list for details. You must create this page in your site before 
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selecting it here. To select the page, click Error URL, and then click 

the Browse (...) button display a list of pages in your site. Click the 

error page, and then click Link to return to the Component tab.

● Output File. Name of text file on the Web server to which Forms-

Handler.cgi will write data submitted through your form. Use any 

filename valid for your server. Do not enter path information. 

NetObjects Fusion automatically creates these folders to contain 

your data:

- For Windows platform servers, it writes the output file to the 

folder c:\webdata.

- For Unix and Macintosh platform servers, it writes the output 

file to the folder path_to_yoursite/assets/webdata, for 

example /usr/john/public_html/cool/assets/webdata.

● Publish to. Style of script for the platform of the server to which you 

are publishing. Script styles are described in the AutoForm usage 

note. Double-click to select Unix or Windows. If you set this 

parameter to Unix, you must set the Perl path.

● Perl Path for Unix. Path to Perl application on server, required for 

Forms-Handler.cgi. Consult your ISP. Required when the “publish 

to” parameter is set to Unix.

● Required field #. This is the true or false setting that specifies 

whether the visitor must fill in the selected field. Field names only 

appear in the AutoForm properties list after you correctly name the 

form elements, and then click the Submit button again. Element 

naming conventions for AutoForm are described in the AutoForm 

usage note.
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Using the Button Tool
If you use the Button tool to create the Submit and Reset buttons, you might use 

hidden fields to pass additional information to the script you’re using to process 

your form. Hidden fields are described in “Adding Hidden Fields” on page 9-16.

To create a Submit or Reset button

1. Select the Forms tool, and then select the Button secondary tool.

2. Draw a button box.

The Button properties tab appears:

3. Enter the name of the button in the Name field. 

Use the name referenced by the CGI script you intend to use.

4. Enter text for the label in the Text section.

5. Select the button type: Submit or Reset.

6. To use a custom image as your button, select the button, and then click 
Browse… (Windows) or Select... (Macintosh).
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7. Choose an image file from your hard disk, CD-ROM, or LAN.

8. If your CGI script requires hidden fields, specify them in the Hidden 
Field dialog. See “Adding Hidden Fields” on page 9-16 for details.

Creating Other Form Elements
This section describes how to create form elements, such as check boxes, radio 

buttons, single-line text boxes, multiple-line text boxes, and combo boxes.

Creating Check Boxes
Use check boxes to let site visitors select one or more items from a group of items, or 

to toggle a single item. Check boxes can be checked or unchecked, and any number 

of check boxes in a group can be checked at the same time. Site visitors can also 

choose not to select any check box items.

To create a check box

1. Select the Forms tool, and then select the Check Box secondary tool. 

2. Draw a region for the check box.

The Check Box properties tab appears:
-8 Designing and Implementing Forms



C R E A T I N G  O T H E R  F O R M  E L E M E N T S
3. Enter the name of this check box.

Check the documentation for your CGI script for naming conventions. 

4. Enter a label for this check box. 

This label appears to the right of the check box, and describes the 
option.

5. Optionally, enter a value for the check box. 

The value will be passed to the CGI script that processes this form. 

6. Enter the default state of the check box.

A check box can be checked or unchecked by default, but the site visitor 
can click to change it.

Creating Radio Buttons
Radio buttons work like check boxes, except that the site visitor can select only one 

radio button in a group at a time. When a site visitor clicks one radio button, all 

others in the group are deselected. Since radio buttons let site visitors choose only 

one item from a group, you create group names and assign each radio button to a 

group.

To create a radio button

1. Select the Form tool, and then select the Radio Button secondary tool.

2. Create a radio button region.

The Radio Button properties tab appears.
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3. In the Group Name field, enter the name of the group for this radio 
button.

Check the documentation for your CGI script for naming conventions. 

4. Enter a button label in the Button field.

5. In the Value Sent field, enter the value to be sent to your server when the 
radio button is selected.

6. Set the default state of the button.

One radio button in each group can be selected by default, but a site 
visitor can select a different radio button. 

If you later add radio buttons using an existing group name, NetObjects 
Fusion automatically groups the new radio buttons with the existing 
group.
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Creating a Single-Line Text Field
Use the text boxes to enter text data. Single-line text boxes can be any length but 

only one line high. For text information that is more than one line, use the multiple-

line text box described in “Creating a Multiple-Line Text Field” on page 9-13.

To create a single-line text field

1. Select the Form tool, and then select the Edit Field secondary tool.

2. Draw a form text box.

The Single Line properties tab appears: 

3. Enter the name of this text box in the Name field.

Check the documentation for your CGI script for naming conventions. 

4. In the Text field, enter default text, if necessary.

The default text appears in the text box and will be sent back to your 
server as form data unless a site visitor changes it.

5. Set the visible length of the box.
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This is the number of characters that can be displayed at once in the text 
box, therefore it is the width of the text box, measured in characters.

6. Set the maximum length for text in this box.

The maximum length is the total number of characters site visitors can 
enter. If you enter more than the visible length, most browsers will scroll 
the text box so that the cursor is always visible.

7. If the text box is for sensitive information like a password or credit card 
number, select Password format.

When this option is selected, browsers will not display the entered 
characters. The site visitor will see placeholder characters instead, such 
as bullets or asterisks. This prevents others from obtaining sensitive 
information by looking over a site visitor’s shoulder or reading an 
unattended screen.

8. To label the text field, use the Text tool to insert text next to it.
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Creating a Multiple-Line Text Field
Multiple-line text boxes can hold more than one line of text. Their properties are 

identical to those of single-line text boxes.

To create a multiple-line text field

1. Select the Form tool, and then select the Multi-Line secondary tool.

2. Draw a multiple-line text box.

The Multi-Line properties tab appears: 

3. Enter the name of this text box in the Name field.

Check the documentation for your CGI script for naming conventions. 

4. Enter default text, if necessary.

The default text appears in the text box and will be sent back to your 
server as form data unless the site visitor changes it.

5. Set the visible length.

The visible length is the width of the text box in characters.
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6. Set the visible height.

The visible height is the height of the text box in characters, or text lines.

7. To label the text field, use the Text tool to insert text beside it.

Creating Combo Boxes
Use combo boxes to display options too large for a radio box or a check box group. 

A combo box can be displayed in two ways:

● As a scrolling rectangular list, where site visitors click an item to select it.

● As a drop-down menu, where only one item from the list is displayed. This can be 
expanded into a full list by clicking on it. Like radio buttons, drop-down lists can 
have only one selection at a time.

To create a combo box

1. Select the Form tool, and then select the Combo Box secondary tool.

2. Draw a list box area.

The Combo Box properties tab appears: 
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3. Enter the name of the combo box. 

Check the documentation for your CGI script for naming conventions. 

4. Click the Dropdown List or List Box option, depending on how you 
want to display this list box.

5. Set the visible height of the list box.

This option only applies when the List Box option is selected.

6. In the Elements section of the Combo Box properties tab, add or remove 
list items:

● To add a list item, click the plus sign (+) and enter text.

● To remove a list item, select it and click the minus sign (–).

● To reorder the list, select a list item and use the arrow buttons.

7. If you want to allow site visitors to select more than one item, check 
Allow Multiple Selections.

This option only applies when the List Box option is selected.
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Adding Hidden Fields
For your own CGI script or a third-party script, use the Hidden Fields dialog to 

create hidden form fields. These fields apply to the entire form, so you need to add 

them to one form element only.

To define hidden fields

1. Select any form element on the form.

2. In the properties tab for the selected element, click the Hidden Fields... 
button.

The Hidden Fields dialog appears:

● To add a field, click the Plus (+) button, then enter the name and 

value in the Enter Value dialog.

● To remove a field select it, then click the Minus (-) button.

● To move a field up or down in the list, select it, then click the up- or 

down-arrow.

3. Click OK.
-16 Designing and Implementing Forms



A S S I G N I N G  A  C G I  S C R I P T
Assigning a CGI Script
Unless you are using the AutoForm component, you must assign a CGI script to 

your form. You can do this using the Form Settings dialog for any form element. 

The form settings apply to the entire form, so you add them to only one form 

element. The settings appear in the Forms Settings dialog for any element on the 

form.

To assign a CGI script

1. Select the form element.

2. In the Properties tab for the selected element, click the Settings... button.

The Form Settings dialog appears.

3. In the Form Name field, enter a name for this form. 

This is an arbitrary name you assign to the form. It enables embedded 
scripts to reference form elements. For example, you might use a Java 
applet that references the form by name.

4. In the Settings section, click Browse... (Windows) or Select... 
(Macintosh), and then select a CGI script for the File field.

When you publish your site, NetObjects Fusion uses this path as the 
source from which to copy the script to your server. 
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5. In the Action field, enter the URL that will reference the CGI script once 
the site is published; for example:

http://www.host.com/myaccount/fusionproject/assets/cgi-
bin/mtscript.cgi

This is the URL on the server for the CGI script file you assigned to your 
form in Step 4, above. 

The Action setting determines the action of your form’s Submit button. 
When a visitor clicks Submit, the visitor’s browser looks up the URL you 
specify in the Action setting and executes the CGI script it finds there. 

6. In the Settings section, select the Post button.
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Using NetObjects Components 10

NetObjects Components are pre-built mini applications that add sophisticated and 

interactive functionality to your Web site. You can add NetObjects Components to 

your Web pages without custom programming or scripting.

NetObjects Fusion includes seven components, but it can give you access to many 

more. Check www.netobjects.com regularly for information on new NetObjects 

Components as they become available. Java developers can use the NetObjects 

Component Development Kit (CDK), available for free from NetObjects, to create 

additional components for incorporation into Web sites. Download the CDK from 

www.netobjects.com/developer/index.html. 

A few of the NetObjects Components require some setup on the server side. Server-

side setup is covered in usage notes at www.netobjects.com/support. This chapter 

tells how to use NetObjects components, including

● placing NetObjects Components

● setting their client-site parameters

● adding new components to NetObjects Fusion
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Placing NetObjects Components
NetObjects Fusion provides these NetObjects Components that create the following 

functionality when you publish your Web site:

● Rotating Picture, a Java applet that displays images of your choice in a 
continuous loop. You might use this to display rotating advertisement banners.

● Picture Loader, a Java-based applet that loads an image dynamically at browser 
request from a URL. For example, you can display an image from another Web 
site.

● Time Based Picture, a Java-based applet that displays an image of your choice for 
a specified period of time. You might show different advertisements at different 
times.

● DynaButtons, Java-based buttons that display primary buttons in a highlighted 
and non-highlighted state, responding to visitor actions like clicking or running 
the mouse pointer over the button. Dynabuttons are often used for navigation.

● Ticker Tape, a Java-based applet that gives your Web site visitors a scrolling LED 
ticker tape message. This scrolling can highlight important messages.

● SiteMapper, an advanced Java-based applet that lets you create a map of your site 
at the click of a button. Visitors can use the map to help navigate through the site.

● Message Board, a fully functional threaded message board that lets your 
customers, vendors, and employees interact on your site.

● AutoForm, a FormHandler CGI script that lets visitors to your site send feedback 
using your Web-based forms. For more information, see “Using the AutoForm 
Submit Button” on page 9-4.
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Figure 10-1. NetObjects Components on the Tools palette

The Tools palette gives you access to the basic set of NetObjects Components. When 

you select the NFX Components tool in the primary palette, the six secondary tools 

in the secondary palette appear. 

Select the NFX Component tool in the secondary palette to bring up the Installed 

Components dialog, which includes the Rotating Picture, Picture Loader, and Time 

Based Picture components, as well as any other components that have been added.

The methods for placing a component and setting its parameters are the same for 

each component, as described below.

To place a NetObjects Component

1. Click the NetObjects Components tool.

2. Select a tool from the secondary palette.

3. Drag a place for the object on your page. 

A placeholder for the object appears, and the Properties palette displays 
the tab for the selected NetObjects Component.

Use these methods to edit all NetObjects Component parameters in the 
Component tab:

Primary Palette

Ticker Tape

AutoForm

MessageBoard

NFX Component Tool

DynaButtons

SiteMapper

Secondary Palette

NFX Component Tool
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● To edit a parameter, double-click the parameter, then make the 

changes in the text edit field or select a value from the drop-down 

list.

● To enter the edit, click the check mark (Windows) or click OK 

(Macintosh).

● To cancel the edit, click the X (Windows) or Cancel (Macintosh).

● To browse for a file, click the Browse button that appears when a file 

or URL field is selected.

The Browse button is the small button labelled with an ellipse 
(...). If you select a URL, the Browse button displays the Link 
dialog. If you select a file, the Browse button displays the Open 
File dialog.

● Double-click a parameter to display an appropriate dialog, such as 

the Image File Open dialog for selecting image files, or the Link 

dialog for specifying URLs.
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For information on the Image File Open dialog, see “To choose an image 
file” on page 3-16. For more information on the Link dialog, see 
“Creating Links” on page 7-12.

Test your components by previewing, staging, or publishing your site. Be 
aware that if you’re using a NetObjects Component that requires setup 
on the server side, such as Message Board or AutoForm, you must 
complete the setup before you can test.

Adding Rotating Pictures
You can use the NetObjects Fusion Rotating Picture component to display different 

pictures in succession in the same place on the page. You specify the image to 

display, and the number of seconds to pause before displaying the next picture in 

the sequence. You can also assign a link to each picture.

To add rotating pictures

1. In Page view, go to the page where you want to place the rotating 
pictures.

2. Click the NetObjects Components tool, then click the NetObjects 
Components tool in the secondary tool palette. 

3. Draw a rectangle where you want to place the picture.

The Installed Components dialog appears, showing the list of available 
NetObjects Components:
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To learn how to add more components, see “Adding New NetObjects 
Components” on page 10-18.

4. Select Rotating Picture, then click OK.

The placeholder image for rotating pictures appears on your page, and 
the Properties palette displays the Component tab. 

5. Set the Rotating Picture Component parameters:

● Pause Time (Seconds). Set the number of seconds to pause between 

picture rotation. For example, change this number to 5 to display 

each picture for 5 seconds.

● Number of Images. Set the number of images to display. The 

maximum is fifty. The number of parameters adjusts automatically. 

● Image 1. Double-click to select the first image from the Image File 

Open dialog.

● URL for Image 1. Double-click to select a link from the Link dialog, 

described in “Creating Links” on page 7-12.
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● Image 2. Double-click to select the second image from the Image 

File Open dialog.

● URL for Image 2. Double-click to select a link from the Link dialog, 

described in “Creating Links” on page 7-12.

Using Picture Loader
Use the NetObjects Picture Loader Component to load an image from an external 

source, such as another Web site. 

When you place the component, a placeholder image appears on your page.

To add a picture

1. In Page view, go to the page where you want to place the external picture.

2. Click the NetObjects Components tool, then click the NetObjects 
Components tool in the secondary tool palette. 

3. Drag a rectangle on the page the size of the picture you want to display. 
The image will automatically adjust to the size of this rectangle.

The Installed Components dialog appears, showing the list of available 
NetObjects Components. To learn how to add more components, see 
“Adding New NetObjects Components” on page 10-18.

4. Select Picture Loader, then click OK.

The picture placeholder appears on your page, and the Properties palette 
displays the Component tab. 

5. Set the Picture Loader Component parameter:

Image URL. Click on the Image URL parameter, then type the complete 
URL for the picture, such as: http://www.netobjects.com/ 
announcements/assets/images/homepagemainart.gif.

You don’t need to add any other tags. NetObjects Fusion generates all the 
required HTML code.

6. Click the check mark (Windows) or OK (Macintosh) to confirm your 
URL selection.
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Using Time Based Pictures
You can use the NetObjects Fusion Time Based Picture component to display 

different pictures in the same page location at different hours of the day. You can 

also assign a link to each picture. You specify the image to display and the time to 

display it, and the browser automatically changes the picture at the specified time.

To add time based pictures

1. In Page view, go to the page where you want to place the time based 
picture.

2. Click the NetObjects Components tool, then click the NetObjects 
Components tool in the secondary tool palette. 

3. Drag a box where you want to place the picture.

The Installed Components dialog appears, showing the list of available 
NetObjects Components. To learn how to add more components, see 
“Adding New NetObjects Components” on page 10-18.

4. Select Time Based Picture, then click OK.

The placeholder image for time based pictures appears on your page, 
and the Properties palette displays the Component tab: 
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5. Set the Time Based Picture Component parameters:

● Number of Images. Set the number of images to display. When you 

change this setting, by editing the text field or using the up and 

down arrows, the number of parameters adjusts automatically.

● Image 1. Double-click to select the first image from the Image File 

Open dialog. Browse to find your image and click Open.

● URL for Image 1. Double-click to select a link from the Link dialog, 

as described in “Creating Links” on page 7-12. Select your link and 

click the Link button.

● Start Time for Image 1. This value is always 12am. Image 1 is always 

displayed starting at midnight. This setting cannot be changed.

● Image 2. Double-click to select the second image from the Image 

File Open dialog. Browse your hard drive to find your image and 

click Open.

● URL for Image 2. Double-click to select a link from the Link dialog, 

as described in “Creating Links” on page 7-12. Select your link and 

click the Link button.
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● Start Time for Image 2. Click on the Start Time for Image 

parameter and use the pull-down menu to select the display time 

for Image 2. Double-click the parameter to cycle through the hours.

Using DynaButtons
You can place DynaButtons anywhere on the page. You can assign up to 20 buttons 

to a DynaButton bar, and you can also assign sub-buttons to each DynaButton.

When published, each button appears in the browser in the primary button style 

selected for the site, and displays the name of the page to which it is linked. You 

cannot assign custom images to Dynabuttons.

When a visitor passes the mouse pointer over a DynaButton, it appears to be 

depressed, showing that it is a link. When a site visitor clicks a DynaButton 

containing sub-buttons, its sub-buttons appear; otherwise the browser opens the 

button’s URL.

To add a Dynabutton

1. In Page view, go to the page where you want to place the DynaButton.

2. Click the NetObjects Components tool, then click the DynaButtons 
secondary tool.

3. Drag a rectangle for the DynaButton.

A button placeholder labelled DynaButton appears on your page and the 
Properties palette displays the Component tab.
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4. Set the parameters for the DynaButtons component:

● Orientation. Select Horizontal or Vertical.

● Number of Buttons. Set the number of DynaButtons for this button 

bar. When you change this setting, the number of parameters 

adjusts automatically.

When you increase the number of buttons, the DynaButton 
image on the page also enlarges.

● Button 1. Double-click to display the Link dialog and select a link 

target for this button. “Creating Links” on page 7-12 describes the 

use of the Link dialog.

● Use Sub-Buttons 1. Select Yes or No. Selecting Yes activates the 

following parameters:

● Number Sub-Buttons. Set the number of sub-buttons. The number 

of parameters automatically adjusts.
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● Sub-Button 1,1. Double-click to display the Link dialog and select a 

link target for this button. “Creating Links” on page 7-12 describes 

the use of the Link dialog.

● Sub-Button 1,2. Double-click to display the Link dialog and select a 

link target for this button.

Using Ticker Tape
You can add a scrolling message to your Web page simply by adding the NetObjects 

Ticker Tape component. 

To add a Ticker Tape display

1. In Page view, display the page where you want to place the ticker tape 
message.

2. Click the NetObjects Components tool, then click the Ticker Tape 
secondary tool.

3. Drag a rectangle where you want to place the Ticker Tape component. 
Make the rectangle the size you want for the message background.

The ticker tape placeholder appears on your page, and the Properties 
palette displays the Component tab.
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4. Set the Ticker Tape properties:

● Number of Messages. Enter the number of messages to display in 

the Ticker Tape edit field. When you change this setting, the number 

of parameters automatically adjusts.

● Text for Message 1. Enter the text for the first message in the Ticker 

Tape edit field.

● URL for Message 1. Double-click to select a link for this message. 

“Creating Links” on page 7-12 describes the use of the Link dialog. 

● Text for Message 2. Enter the text for the second message, if any in 

the Ticker Tape edit field. Add periods or other characters to the 

beginning of the second message, or to the end of the first message, 

to separate the messages. Spaces are ignored.

● URL for Message 2. Double-click to select a link for this message. 

“Creating Links” on page 7-12 describes the use of the Link dialog.

● Speed. Set the speed for the messages. The default is 25. Higher 

numbers are faster.
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● Frame Color. Select this parameter from the Ticker Tape menu to 

set the border color of the ticker tape display. The default is light 

gray. Double-click to cycle through the colors.

● Background Color. Set the background color for the ticker tape 

display. The default is black. Double-click to cycle through the 

colors.

● LED Color. Set the LED color for the ticker tape text. The default is 

green. Double-click to cycle through the colors.

Using SiteMapper
SiteMapper is a Java-based navigation application that provides an interactive site 

map for your site visitors. When visitors invoke SiteMapper, an additional browser 

window appears containing a site structure map similar to the one you see in the 

Site view. This allows visitors to jump directly from page to page independently of 

your page navigation controls. If your site is particularly large, SiteMapper can 

simplify site navigation. Visitors can also view the site map in an outline view, as 

well as search for pages.
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To add a Site Map

1. In Page view, go to the home page of the site where you want to include 
the SiteMapper component.

2. Click the NetObjects Components tool, then click the SiteMapper 
secondary tool.

3. Drag a rectangle for the SiteMapper button.

The button appears on your page, and the Properties 
palette displays the Component tab.

4. If you like, change the image on the SiteMapper button.

To change the image, double-click its name, or click the Browse button, 
then select another image file from the Image File Open dialog. The 
Browse button is the small button labelled with an ellipse (...). For 
information on using the Image File Open dialog, see “To choose an 
image file” on page 3-16.

Adding a Message Board
You can create a Message Board for your site by adding the NetObjects Fusion 

Message Board component to one of your pages.

When your site visitors click the Message Board button, the 

browser opens a new browser window displaying the message 

board.
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Visitors can use this message board to read messages organized by Thread, Subject, 

Author, or Time, expand or collapse the view, post new messages, and reply to 

messages. 

You can have only one Message Board per site. For the Message Board to run 

properly, your Web server must be able to run CGI scripts, and the site visitor’s 

browser must support the Netscape JavaScript standard. Before you can test the 

Message Board, you must complete the server-side setup described in usage notes at 

www.netobjects.com/support.

To add a Message Board

1. In Page view, go to the page where you want to place the Message Board 
button.

2. Click the NetObjects Components tool, then click the Message Board 
secondary tool.

3. Drag a rectangle for the Message Board button. 
10-16 Using NetObjects Components



P L A C I N G  N E T O B J E C T S  C O M P O N E N T S
The button appears on your page, and the Properties palette displays the 
Component tab. 

4. Set parameters for the Message Board.

● Subdirectory. Name of Message Board directory on server. Default 

is bbs. Change this name if you want to place the Message Board in 

a different directory.

● Page Title. Name that appears in the title bar of the browser’s 

Message Board window. 

● Publish to. Select the platform of your server: Macintosh, Windows, 

or Unix.

On Macintosh, Message Board must be published to a Webstar 
2.0 Web server, running on a PowerPC computer.

● Perl Path for Unix. This is the path to the Perl 5 interpreter on the 

Unix server, and you need it only when publishing to a Unix server. 

Obtain it from your Internet Service Provider. (Or, you can type 

which perl from a Unix command prompt.)
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Adding New NetObjects Components
You can add other NetObjects components or third-party components to your 

installed components list.

To learn where to get more NetObjects Components, visit www.netobjects.com.

To add a NetObjects Component

1. In Page view, click the NetObjects Components tool, then click the 
NetObjects Components tool in the secondary tool palette. 

2. Click anywhere on the page.

The Installed Components dialog appears, showing the list of available 
NetObjects Components.

3. Click Add....

The Install Components dialog appears.

4. Select a component with the extension .nfx or .class, then click Open.

The new component now appears in the list.

5. Select the component and click OK.

The new component appears on your page.
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Scripting in NetObjects Fusion 11

This chapter describes the scripting feature in NetObjects Fusion. Scripts are a way 

of extending your applications, in which all the code is executed on the site visitor’s 

computer.

Scripting can help your pages interact with Web technologies that enable dynamic 

data publishing. You can also use scripting to create HTML frames. If you are using 

NetObjects Fusion AutoFrames, you need to know how NetObjects Fusion sets up 

HTML pages for them so you can create links and control how the pages refresh in a 

browser.

The discussion includes

● using layout, master, and frame scripts

● using element scripts

● using scripts for dynamic data publishing

● using scripted frames 

● using links in AutoFrames
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Scripting
NetObjects Fusion is extensible, which means that it can support HTML tags and 

scripts not specifically handled by the Tools palette. You can use NetObjects Fusion 

client-side scripting to insert HTML, Visual Basic scripts, and JavaScript™ scripts. 

This type of scripting reduces the strain on your Web server (server side) because all 

the code is executed on the computer of your site visitor (client side).

To use the advanced scripting feature, you must be familiar with HTML and the 

scripts you intend to use. Consult www.netobjects.com for usage notes on scripts.

NetObjects Fusion offers two kinds of scripting:

● Layout scripts

● Element scripts

For both types of scripts, you can add variables; cut, copy, or paste variables from 

other scripts; and, insert an existing text file containing scripts.

Using Layout Scripts
A layout script inserts information in three locations of the page’s final HTML file. 

Use layout scripts to add meta-information to a page, define script functions that 

will be referenced in the body of the page, or include other scripts that run when the 

document loads.

NetObjects Fusion provides three ways to attach scripts to your pages:

● Layout scripts: When you attach a script to the layout page, the script applies to 
the current page only.

● Master scripts: When you attach a script to a MasterBorder, the script applies to 
all the pages with that MasterBorder style. For details on the MasterBorder 
feature, see Chapter 5, “Managing MasterBorders and Optimizing Layouts”.

● Frame scripts: When you attach a script to an AutoFrame, NetObjects Fusion 
places the script in the content page for that AutoFrame. If you convert the 
AutoFrame back to a MasterBorder, any script attached to the AutoFrame is 
deleted. See “Using AutoFrames” on page 5-7 for details on AutoFrames.
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The procedure, described below, for adding the three types of scripts is the same. 

The only difference is where and how you access the Layout Script dialog.

To use a layout script

1. Open the Layout Script dialog by one of these methods:

● Layout scripts: Choose Layout Script… from the Page menu, or 

choose Layout Script… from the pop-up menu in the layout area.

● Master scripts: Choose Master Script… from the pop-up menu in 

the MasterBorder area, or click the Script... button on the 

MasterBorders tab.

● Frame scripts: Choose Frame Script... from the pop-up menu in the 

AutoFrame area, or click the Script... button on the Frame tab. 

For Windows, right-click to display the pop-up menu and for 
Macintosh, Control-press to display the pop-up menu.

The Layout Script dialog appears:

2. Click the field in which you want to place your HTML code.
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● When you place HTML code in the Inside Head Tag field, 

NetObjects Fusion adds as a new line between the <HEAD> tag and 

the </HEAD > tag. Use this field only to add complete and valid tags 

into the <HEAD> area.

● When you place HTML code in the Inside Body Tag field, 

NetObjects fusion adds it inside the <BODY> tag, just before the 

closing bracket. Use this field only to add attributes for the <BODY> 

area.

● When you place HTML code in the Beginning of Body field, 

NetObjects fusion adds it on a new line just after the <BODY> tag. 

Use this field to enter complete tags and scripts.

3. Place your HTML or script in the selected field by one of these methods:

● Type HTML or script text.

● Click Insert... and select an HTML or script file (ASCII text format) 

from your hard disk, CD-ROM, or LAN.

● Paste in HTML or script text you copied from another application.

HTML code gets inserted exactly as typed. This means that in the 
<BODY> section, scripts must include the <SCRIPT> and </SCRIPT> 
tags. If it is unclear how the code is being inserted, preview the site and 
look at the source.

You can also use the Cut, Copy, Paste, and Undo buttons or their 
standard keyboard equivalents to edit text in any field.

4. Click the Variable... button to insert a variable.

To learn how, see “Inserting Variables” on page 4-11.

5. Click OK.
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Using Element Scripts
Element scripts control individual content elements by placing HTML or scripting 

information in the <BODY> region of the final HTML file. You can use element 

scripts with any content elements, whether they are located in the MasterBorder or 

Layout area of a page. Element scripts can contain HTML code for an element, or 

scripting information that controls the element. For example, you can add HTML 

tags or options not directly supported, or call a JavaScript routine.

A common use for the Before and After scripts is to link an image to a JavaScript. In 

the Before Script, enter the following to start the link:

<A HREF=”#” OnClick=”myScript()”>

In the After Script, enter the following to close the link: 

</A>

To add HTML elements not directly supported by NetObjects Fusion, create an 

empty text element and enter HTML in the Before Element tag scripting field.

To use an element script

1. Select the content element to which you want to apply a script.

2. Open the Element Script dialog by one of these methods:

● Click Script in the properties tab for the selected element.

● Choose Element Script… from the pop-up menu for the element. 

For Windows, right-click to display the pop-up menu and for 

Macintosh, Control-press to display the pop-up menu.

● Choose Element Script from the Page menu.

The Element Script dialog appears: 
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3. In the dialog, click the field in which you want to place your HTML 
code.

● When you place HTML code in the Before Element Tag field, 

NetObjects Fusion adds it on the line before the opening tag for the 

element. Use this field to add opening tags for HTML that will affect 

the element, or to add complete scripts.

● When you place HTML code in the Inside Element Tag field, 

NetObjects Fusion adds it just before the closing bracket of the 

element’s opening tag. Use this field only to add attributes for the 

element.

● When you place HTML code in the After Element Tag field, 

NetObjects fusion adds it on a new line just after the element’s 

closing tag. Use this field to enter closing tags to match any opening 

tags you entered in the first scripting field.

4. Place your HTML or script in the selected field by one of these methods:

● Type HTML or script text.
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● Click Insert... and select an HTML or script file (ASCII text format) 

from your hard disk, CD-ROM, or LAN.

● Paste in HTML or script text you copied from another application.

HTML code gets inserted exactly as typed. This means you must include 
the appropriate opening and closing tag pairs. If it is unclear how the 
code is being inserted, try previewing the site and looking at the source.

You can also use the Cut, Copy, Paste, and Undo buttons or their 
standard keyboard equivalents to edit text in any field.

5. Click the Variable... button to insert a variable.

To learn how, see “Inserting Variables” on page 4-11.

6. Click OK.
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Using Scripts for Dynamic Data Publishing
Another common use of element scripts is to link databases to Web pages for 

dynamic publishing. Many vendors offer database-to-Web scripting products such 

as Netscape LiveWire, Bluestone Sapphire/Web, Tango from EveryWare, and Cold 

Fusion from Allaire. 

Each scripting product offers different features and capabilities, but all the products 

work essentially the same way. They use proprietary scripting languages and a 

server-side scripting engine to link your Web page to a database when requested by a 

browser. 

To incorporate dynamic publishing: 

1. Draw an empty Form Edit Field for each database field to be displayed 
dynamically. 

These form fields translate into simple HTML table cells at publish time. 

2. Attach an element script to each form field by clicking Script in the 
properties tab of the field.

Enter the script in the Inside Element Tag field of the Element Script 
dialog. Once the site is staged or published to a server that supports the 
scripting engine, the database fills each element with content. When a 
browser requests a page containing a database-scripted HTML table, the 
server-side scripting engine fills the proper table cell with nested HTML 
or data from the database. 

The text block is constrained on the top, left and right, so if the database 
provides more information than the text block can contain, the text 
block grows down. 
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Using Scripted Frames
A frame is an area of a page that contains content independent from the rest of the 

page. When a site visitor scrolls another part of the page, the frame content does not 

move. Frames are a popular device to help visitors navigate a site. For example, 

many sites use two frames: one to display menu pages and another to present links 

to other areas and pages within the site. 

NetObjects Fusion 2.0 supports two ways to create frames:

● AutoFrames

● Scripted frames

Use NetObjects Fusion AutoFrames feature to add frames to MasterBorders with a 

single click, and then add navigation controls, banners, text, graphics, and links. 

This is the easiest and most convenient way to create frames, and is described in 

“Using AutoFrames” on page 5-7. To learn the hidden mechanics of AutoFrames in 

NetObjects Fusion, see “Behind the Scenes with AutoFrames” on page 11-18.

Using NetObjects Fusion’s scripting interface, you can manually code frames using 

the HTML page description language. This method requires knowledge of HTML 

codes and the NetObjects Fusion script interface, and is no more complicated than 

creating frames in an HTML editor. This section gives an overview and example of 

how you can script a simple frame. 

With frames, content can appear in several different rectangles that divide the 

browser’s window into a patchwork of individual pages. The frames form a top-level 

page called a frameset (in HTML). 

Within a frameset, each frame has characteristics of a page. When viewing a 

frameset, a site visitor can drag frame borders and scroll frame contents to view 

information. Clicking on a link within a frame can bring up new information 

within the frame or in a different frame. Or, clicking a link can bring up an entirely 

different page to replace the frameset.
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Defining the Frameset
To define a frameset, first, add the frameset page, which serves as the top-level page 

and contain the frames. You can add the frameset page anywhere, but make sure its 

location makes sense within the organization of your site. What makes sense 

probably depends on how you want your site visitor to enter the frameset. For 

example, if you want the visitor to enter the frameset using standard NetObjects 

Fusion navigation aids, add your frameset page as a sibling of the other pages on the 

navigation bar. 

To define a Frameset

1. Create and name your page in the Site view.

2. Double-click the page to open it in the Page view. 

3. Choose Layout Script from the Page menu. 

4. In the Inside Head Tag field, enter the HTML that defines the page as a 
frameset and the names of the frames it contains, as in this example: 
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The src attribute of the <frame> tag instructs the browser where to find 
the frame’s content: an HTML page file. You’ll create those pages in the 
next step, “Creating Frame Content” on page 11-12.

The source file names must match names of the pages that hold your 
content. After creating the content pages, you can determine their exact 
names by previewing your site and checking their names in your 
browser’s view of the HTML source. If the source file names you specify 
do not exactly match the page names NetObjects Fusion creates for your 
content pages, you might encounter difficulties when staging or 
publishing your site.

You can enter the source for your frames as a relative path 
(./menu.html) because NetObjects Fusion puts all pages except the 
Home page in the same HTML folder. This means the source document 
for each frame is always in the same directory as the page defining the 
frameset. If the Home page is the frameset, refer to the sub-pages as 
./html/page.html.

5. Click OK.

All elements placed on a frameset page, including the banner and 
navigation bars, are completely covered by the frames. This limits a 
visitor’s ability to navigate out of the frameset page. “Creating Targeted 
Links” on page 11-13 discusses how to create a link that exits the 
frameset.
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Creating Frame Content 
Once you have defined your frameset, create the content for each of your frames.

To create content for a page

1. Add a page to your site and lay out its content. Consider these issues 
during your design:

– If you want the frameset to be the only way a site visitor can access the pages in 

the frames, organize the content pages as children of your frameset page, for 

example:

This simplifies managing NetObjects Fusion’s automatic navigation 
links, whether your design uses them or not.

– Within a frame-content page, create links to other pages. To learn how to 

control where the linked information appears, refer to “Creating Targeted 

Links” on page 11-13.

– Plan your links. Include links only to those pages designed to be displayed in 

your frame. If you don’t want your frames to show banners and navigation 

bars, create a new MasterBorder for those frame content pages and remove 

their banners and navigation bars.

2. Click Preview in the control bar to preview your site in your browser.

3. Check the behavior of all links. 

The frameset previewed below uses the example HTML shown in the 
previous section. The designer laid out content pages and implemented 
links so that when the site visitor clicks on a thumbnail picture in the 
bottom menu frame, the top main frame displays the full-size image.
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Figure 11-1. Clicking an image in the menu page displays the corresponding content page in the 
main frame

Creating Targeted Links
When a site visitor clicks a link within a frame, the linked information can appear in 

one of three places:

● The current frame 

● The frame specified as the default for viewing all links launched from a frame-
content page

● A frame identified for viewing this link

Unless you specify otherwise, when a site visitor clicks a link, the linked page 

appears in the frame where the visitor clicked the link. You can choose between two 

kinds of targeted links to override thid, both described in the following sections.

Each content page 
appears in this frame.

The menu page 
appears in this frame.
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Default Target Frame
To create a frameset with one frame displaying content and the other presenting 

navigation links, specify the display frame as the default for viewing all links 

launched from the navigation frame. 

To do this, place a <base> tag in the Layout Script in the Inside Head Tag field of 

the navigation frame’s content page. In the example shown in the previous section, 

the following appears in the Inside Head Tag field of the menu page: 

<base target="main">

This displays the linked information in the main frame when a site visitor clicks a 

link in the menu frame.

Specific Link Target
Use the External Link tab in the Link dialog to set a target frame for a specific link. 

You can also use the External Link tab to create a link to a page internal to your site 

as described below.

To link to a specific location

1. Select the object or text to be linked.

2. Click the Link button at the bottom of the Properties palette.

The Link dialog appears.
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3. Click the External Link tab.

4. In the URL field, delete http://, and then specify the page to link to and 
the name of the frame that should display it; for example:

page.html" target="name 

In the above statement, page.html is the path to your document. If the 
link is to a page within your site, use a relative path. Instead of name, 
type in the name of the frame, found on the Frame properties tab, where 
the linked frame should appear.

Do not type quote marks at the beginning and end of text in the URL 
edit box. NetObjects Fusion automatically encloses the text with quotes.
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To create a link that leaves the frameset and displays the linked page in 
the full browser window, follow the steps above but type the following in 
the URL edit box:

page.html" target="_top

5. Click Link to close the dialog and create the link.

You can use a specific link target in conjunction with the default target 
link because the specific will override the default. 

Supporting Non-Frame Browsers
If your browser does not support frames, you can create alternate content for the 

browser.

To create alternate content for browsers

1. When defining the frameset, replace the closing </frameset> tag with 
the <noframes> tag.

2. In the page containing the frame content, design the page as you want it 
to appear in the browser that does not support frames.
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3. At the very bottom of your layout, create an empty text box. If you are 
using a MasterBorder, make sure you place the text box below all 
MasterBorder content.

4. For Windows, right-click the text box and choose Element Script... from 
the pop-up menu. For Macintosh, Control-press to display the pop-up 
menu.

5. Enter the following script in the After Element field:

</td></tr></table></noframes></frameset>

This leaves some unorthodox HTML at the bottom of your document, 
so be sure to test the page with the browsers you want to support before 
publishing.
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Behind the Scenes with AutoFrames
If you have been creating frames using HTML tags in NetObjects Fusion’s scripting 

interface or in an HTML editor, you might want to know how an AutoFrame differs 

from a scripted frame at the HTML level before you choose to use an AutoFrame. 

This section describes the differences, and tells how to add links to AutoFrames.

When you create a scripted frame, you first create a page that defines the frameset. 

Then, you create content pages that appear within the frames. Within the content 

pages, you can set up targeted links that specify which frame will display the target 

of links launched from that content page. For example, in the content page for a 

frame that presents navigation aids, you would use a <base> tag to specify a 

different (and probably larger) frame as the default for displaying the targets of any 

links launched from the navigation frame.

With AutoFrames, you use a MasterBorder style to define your frameset as follows:

To define a frameset using an AutoFrame

1. Choose the MasterBorder style that will define your frameset.

If you are starting a new blank site and want all pages to share the same 
frameset, simply modify the Default MasterBorder style. If you want 
your site to present multiple framesets, you must create a new 
MasterBorder style for each frameset.

2. Convert at least one MasterBorder margin to an AutoFrame by clicking 
the appropriate button on the MasterBorders tab of the Properties 
palette. 

3. Use margin settings to specify the width of your frames.

If you selected the Drag and Drop Layout Margins option in the Page tab 
of the Preferences dialog, drag the margin borders to size the 
AutoFrame. 

4. Specify the content for each frame.
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You can do this more efficiently for an AutoFrame than for a scripted 
frame because you don’t have to create a separate content page. Just 
place the elements in the applicable frame in the MasterBorder. 

Behind the scenes, NetObjects Fusion sets up the frameset with the specified 

AutoFrame and a body frame with the same name as the MasterBorder. When you 

create additional NetObjects Fusion pages and assign them the MasterBorders with 

AutoFrames, each page is a new content page for the body frame. 

The source for each AutoFrame has a fixed name, based on the frame name. For 

example, if the body frame name is Default, the source name is Default_index.html. 

NetObjects appends the extension _index.html to the source name. You can specify 

a name for your AutoFrame on the Frame tab of the Properties palette.

AutoFrames and Links
When you click a link in an AutoFrame, the browser either refreshes the Body frame 

or the entire page, depending on the number of AutoFrames and the content of the 

page:

● The browser refreshes only the Body frame if the link references a NetObjects 
Fusion page that shares the same MasterBorder as the current page and the 
following conditions are met:

– The shared MasterBorder includes one AutoFrame, and the AutoFrame does 

not contain any dynamic content, such as a banner or navigation bars.

– The shared MasterBorder includes two parallel AutoFrames (top and bottom 

or left and right) and the AutoFrames do not contain any dynamic content, 

such as a banner or navigation bars.

● The browser refreshes the entire page if:

– The shared MasterBorder includes perpendicular AutoFrames.

– The shared MasterBorder includes three or four AutoFrames.

Note: If the link references a page that does not share the MasterBorder, or references 
an external HTML page, the browser exits the frameset and displays the target page 
in the full browser window. 
Scripting in NetObjects Fusion 11-19



1

B E H I N D  T H E  S C E N E S  W I T H  A U T O F R A M E S
If you are accustomed to scripting frames, you might want to create a second 

content page to be displayed within the navigation frame or create a button that 

displays a different navigation bar within an AutoFrame. Even though each 

AutoFrame permits only one content page, you can workaround this using these 

options:

● Create a second MasterBorder identical to the first except for the content, then 
link your button to a page with the second MasterBorder. 

● Link the frame to be updated, as described below.

To create a link to be displayed in a frame

1. In your AutoFrame, add the picture or text to be linked. 

2. Click the Link... button on the element tab on the Properties palette.

3. Select the External Link tab.

4. In the URL edit box, enter the location to link to and the name of the 
frame the link will open. For example:

www.netobjects.com" target="Default

Use a relative path if the link is to a page within your site.

● Use the MasterBorders name, which is displayed in the 

MasterBorders tab, for the target if you want the link to open in the 

body frame. The MasterBorder name is used by the body frame. If 

this is a new site, or if you have a single MasterBorder in your site 

and have not changed the name, the body frame is called Default. 

● Use the name of the AutoFrame, which is displayed in the Frame 

properties tab, to open the link in an AutoFrame.

The target name is case sensitive. Also, change spaces to underscores. For 
example, enter Left Frame as Left_Frame. Do not type quote marks at 
the beginning and end of text in the URL edit box. NetObjects Fusion 
automatically encloses the text with quotes.

5. Press the Link button to close the dialog and create the link.
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6. Preview your page and test the link.

To display the linked page in the full browser window

1. Follow the steps above but type the following in the URL edit box:

page.html" target=”_top

To create a link to a new browser window

1. In your AutoFrame, add the picture or text to be linked. 

2. Click the Link... button on the element tab on the Properties palette.

3. Select the External Link tab.

4. In the URL edit box, make sure http:// is selected, and then enter:

www.domain.com" target="nameofwindow

In the above statement, nameofwindow is the name of the browser 
window. This name must not match an existing frame name. The 
browser will first look for a frame with the specified name, if it finds 
none, it will then open a new instance of itself and display the target in it.

5. Press the Link button to close the dialog and create the link.

6. Preview your page and test the link.
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Data Publishing 12

NetObjects Fusion makes it easy to publish listings of information such as employee 

directories, product and service catalogs, and event schedules. You can enter, 

manage, and store this information as records in your NetObjects Fusion site file, 

and on Windows systems, store information in an external application, such as a 

database or spreadsheet.

To publish the data, you specify its source and create a master layout for data-based 

pages. Then NetObjects Fusion uses your layout to create a separate page for each 

record, and automatically provides your site visitor with buttons to navigate 

between them. 

This chapter describes how to publish data in NetObjects Fusion. The discussion 

includes

● creating a data object

● using data stored internally

● using data stored externally

● creating a data list

● creating stacked pages
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NetObjects Fusion’s data publishing capabilities let you store text and images in a 

database internal to your site, or, if you are working on the Windows platform, 

import data from external sources, such as Microsoft Excel, Access, and ODBC 

databases. In both cases, NetObjects Fusion publishes your data in standard HTML 

pages. This makes it easy to add listings, such as product and service catalogs, 

employee directories, and event schedules to your site.

Each record in your database is published on a stacked page. Each stacked page 

corresponds to a row in a data list. A data list appears on the parent of the stacked 

pages, and like a table of contents, acts as an index for your stacked pages. Data 

objects are collections of data fields. For example, to publish a product catalog, you 

would use a product data object with the following data fields: name, price, and 

photo. The actual data for the fields could be entered manually in NetObjects 

Fusion or drawn from an external desktop database or ODBC database connection.

Figure 12-1 shows the key elements of data publishing with NetObjects Fusion.

Figure 12-1. Data Publishing
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You can publish data from internal and external sources. NetObjects Fusion lets you 

present your data to the site visitor in a data list and a series of associated stacked 

pages. Once you’ve chosen a source, NetObjects Fusion automatically creates the 

appropriate number of stacked pages. Each stacked page corresponds to a record in 

the data source. 

For example, suppose you publish a shirt catalog on the Web. Each row in the shirt 

data list lets the site visitor navigate to the stacked page that contains the 

corresponding shirt.

At the heart of data publishing is the data object, which is simply a collection of data 

fields. You use a data object to define what information you want to publish. To 

create your shirts catalog, your first step is to create a shirts data object. A data 

object can be defined once and used in different filtered data lists. For example, 

using the shirts data object, you can create one data list of all the shirts in your 

database. With the same data object, you can create another data list of just button-

down shirts. And with the same data object, you can create still another data list of 

all the shirts on sale, and so on.

If the data object is created from an external source, for example, from a Microsoft 

Access database, and the source is updated, a site containing this data object is 

updated when you publish again. For example, suppose your shirts data object 

references 50 records originally and the external database is updated with 25 new 

records. After republishing, the data object references 75 records, the shirt data list 

contains 75 rows and there are 75 stacked pages.

After you create a data list on a page, NetObjects Fusion generates a stacked page as 

its child. When you create the layout of the first stacked page, the remaining stacked 

pages automatically inherit the same layout.
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In the Site view, the page icon for the data list page and the page icon for its child 

stacked pages appear as shown in Figure 12-2.

Figure 12-2. Data List Page and Its Child Stacked Pages

Publishing Data
In general, when you work with data publishing, you follow a three-step process:

1. Create a data object.

When you create a data object, you identify the fields you want to use in 
your site. When you store records internally, you must specify the data 
fields you want to store. When you store records externally, NetObjects 
Fusion assumes you want to use all fields available in the source. 

2. Create a data list.

When you create a data list, you prepare a display of the data in a row-
and-column format. The display serves as a table of contents, typically 
summarizing the data that appears in the stacked pages. You select the 
fields you want to display as column headers in the list.

Each row of data that appears in the data list represents information 
available on a single stacked page. The field data from either the internal 
or external source populates the data list when you publish.

3. Create a set of stacked pages.

When you create a data list, NetObjects Fusion automatically creates the 
first of your stacked pages, where you create the layout to be used for all 
the pages in the stack.

Data list page

Stacked pages
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When you design a stacked page, you create or identify the field data you 
want to display on the page.

● If you are storing data internally, you enter the field data on the 

stacked page itself.

● If you are using an external source, the field data is drawn from the 

external database, spreadsheet, or ASCII text file.

Creating a Data Object
On Windows, you can create two types of data objects:

● External data objects: These objects import text fields from a data field created in 
a program other than NetObjects Fusion. External data sources include external 
databases, spreadsheets, and ASCII text files.

● Internal data objects: These objects are simple text, formatted text, and picture 
data fields within your NetObjects Fusion site file.

For Macintosh, you can create internal data objects only.

Creating a Data Object for Internal Data
Internal data is information you enter directly into a stacked page, either by typing 

text or numbers, or by placing a picture. You create a data object in the Page view or 

in the Assets view. If you create a data object in the Page view, you can continue 

immediately to create stacked pages to contain the data. If you create a data object in 

the Assets view, you must return to the Page view to create stacked pages.

For Windows, use internal data objects only if you do not need to update the data 

frequently.
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To create a new internal data object

1. Create a new internal data object by one of these methods:

● For Windows: In the Page view, click the Data List tool, click the 

default secondary Data List tool, and then draw a rectangle on the 

page. NetObjects Fusion displays the Data Publishing dialog. Click 

the New... button.

● For Macintosh: In the Page view, click the Data List tool, and then 

draw a rectangle on the page. NetObjects Fusion displays the Data 

Publishing dialog. Click the New... button.

● For both platforms: In the Assets view, click the Data Objects 

button in the secondary control bar, and then click the New Object 

button in the control bar.

NetObjects Fusion displays the Data Object dialog. The dialog for 
Macintosh is identical to the one shown here except that it offers no 
external option.
2-6 Data Publishing



C R E A T I N G  A  D A T A  O B J E C T
2. Verify the Internal radio button is selected, then enter a name for the 
data object and any comments.

NetObjects Fusion uses the data object name to identify the data object 
later, when you create a data list and in the Assets view list of data 
objects.

Now add fields to this object. Fields define the kind of data you can 
enter.

3. Click the “+” button to add a field.

NetObjects Fusion displays the Data Field dialog box.

4. Type the field name, select the data type for the field, and then click OK.

Internal data fields can store formatted text, plain text, and image files:

– Simple text fields: These fields can only contain characters with the same 

formatting characteristics.

– Formatted text fields: These fields can contain characters with individual 

formatting. 

– Image file fields: For Windows, these fields can contain an image in one of 

these formats: GIF, JPEG, BMP, PCX, or PICT. For Macintosh, these fields can 

contain an image in one of these formats: GIF, JPEG, PCX, or PICT.

5. Repeat steps 3 and 4 to add fields.

6. When you have finished, click OK.
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The data object is now an asset of your site. If you started in the Page 
view, you can select fields and format the data list as described in 
“Creating a Data List” on page 12-14, and lay out your stacked pages as 
described in “Creating Stacked Pages” on page 12-19.

To edit your data object later, see Chapter 13, “Managing Assets.”

Creating a Data Object for External Data in Windows
You can create an external data object only with the Windows version of NetObjects 

Fusion 2.0. External data exists in a local desktop databases or in SQL data sources. 

To make this data available to your site, choose an appropriate driver. NetObjects 

Fusion uses two types of drivers to access data:

● Index Sequential Access Method (ISAM) drivers: These draw data from 
desktop databases, such as Microsoft Access, Paradox, dBase, Microsoft Pro, 
Microsoft Excel, or delimited text files. ISAM drivers are automatically installed 
with most desktop databases.

● Open Data Base Connectivity (ODBC) drivers: These draw data from 
Structured Query Language (SQL) data sources, such as Oracle data files. Before 
you can choose an ODBC data source, you must specifically create it by binding 
your data file to a driver. You can do this in the Windows ODBC Control Panel or 
from within NetObjects Fusion. If you use MS Office or MS Office Professional 
for Windows 95, you might already have a set of ODBC drivers installed on your 
system. If you do not use those products, you must obtain the drivers elsewhere. 
Contact Microsoft for more information.

Which driver to use? If your system includes both types of drivers for your 

application, we recommend using the ISAM driver. This is because an ISAM driver 

is faster, and it takes fewer steps to select an ISAM driver.

NetObjects Fusion automatically gives you access to all the fields available in the 

external file. By default, it imports all external fields as simple text. You can change 

the field type to Image and import pictures referenced in the external file as image 

file paths.
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To create a data object from a desktop database

1. Create an external data object by one of these methods:

● In Page view, click the Data List tool, click the secondary External 

Data List tool, and then draw a rectangle on the page.

● In Page view, click the Data List tool, click the default secondary 

Data List tool, and then draw a rectangle on the page. NetObjects 

Fusion displays the Data Publishing dialog. Click the New... button. 

Click the External radio button in the Data Object dialog, and then 

click the Source button.

● In the Assets view, click the Data Objects button in the secondary 

control bar, and then click the New Object button in the control bar. 

Click the External radio button in the Data Object dialog, and then 

click the Source button.

NetObjects Fusion displays the Data Source Type dialog.

2. In the Type panel, select the data file type from the pull-down menu of 
desktop database types. Microsoft Access is the first item in the list.
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NetObjects Fusion always provides access to Access 3.0 database files. 
Additional data types are available if ISAM drivers have been installed. 
ISAM drivers are automatically installed when you install Microsoft 
FoxPro, Microsoft Visual FoxPro, Paradox, Microsoft Excel, or dBASE.

3. Click the Browse button, locate the database, and open it.

If the file is a multiple-file database or a spreadsheet with multiple tabs, 
NetObjects Fusion displays the Select dialog box.

4. Choose the file or tab you want to use and click OK.

NetObjects Fusion creates displays the Data Publishing dialog with your 
new data object. The data object contains all fields in the external source, 
and takes the name of the selected file or tab. 

5. Continue with the steps in “Creating a Data List” on page 12-14 to 
complete the data list.
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To create a data object from a SQL data source

1. Create an external data object by one of these methods:

● In the Page view, click the Data List tool, click the secondary 

External Data List tool, and then draw a rectangle on the page.

● In the Page view, click the Data List tool, click the default secondary 

Data List tool, and then draw a rectangle on the page. NetObjects 

Fusion displays the Data Publishing dialog. Click the New... button. 

NetObjects Fusion displays the Data Object dialog box. Click the 

External radio button and then click the Source button.

● In the Assets view, click the Data Objects button in the secondary 

control bar, and then click the New Object button in the control bar. 

NetObjects Fusion displays the Data Object dialog box. Click the 

External radio button and then click the Source button.

NetObjects Fusion displays the Data Source Type dialog box.

2. In the Type panel, click the ODBC button, and then the Select button.

The SQL Data Sources dialog box appears.
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This dialog displays all the ODBC data sources stored on your computer. 
You can select a database that you have created, (continue with step 3) or 
you can create a new one (continue with step 4).

3. To select an ODBC source on your system, click the source in the list box 
and then click OK. NetObjects Fusions displays the Select Database 
dialog box. Select the database and click OK.

4. To create a new data source, enter a name and click New...

NetObjects Fusion displays the Add Data Source dialog box. You can 
also access this dialog from the ODBC control panel. Click the Help 
button to display Microsoft ODBC help for more information.

5. Select the driver type in the list and then click OK. 

The driver type must be the same as the type of data file. 

The system displays a dialog box for the selected driver. For example, if 
you selected a SQL database driver, the system displays the ODBC SQL 
Server Setup dialog box. Enter the requested information and click OK 
to close the dialog.

NetObjects Fusion redisplays the Data Sources dialog.

6. Select your new data source and click OK.

7. Click the Select Directory button to select the data file and then click 
OK.
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If the file is a multiple-file database, NetObjects Fusion displays the 
Select dialog so that you can select a file. Then, it creates the data object, 
gives it the name of the selected file or tab, and imports its fields as 
simple text fields, which present all characters with the same formatting. 
To import images, see the next procedure.

If you started in Page view, the Data Publishing dialog displays your new 
data object, and you can continue with the steps in “Creating a Data 
List” on page 12-14 to complete the data list.

To import images from an external data source 

1. In your database application such as Microsoft Excel or Access, create a 
simple text field, then in each record enter the full path to each image, 
for example c:\my documents\images\photo.gif. 

2. In NetObjects Fusion, create an external data object as described in the 
procedures above and link it to the table that contains your image field.

3. Switch to Assets view, click the Data Objects button, then double-click 
the data object you created to open it for editing.

4. In the Data Objects dialog that appears, double-click the name of the 
field that contains your images.

5. In the Data Field dialog that appears, select the Image File option.

6. Close both dialogs and switch to Page view.

● If you have not created the data list and stacked pages, see “Creating 

a Data Object for External Data in Windows” on page 12-8.

● If you have created the data list and placed the image field on your 

stacked pages manually or by selecting the Display All Fields option 

in the Data Publishing dialog when you created the data list, go to a 

stacked page, delete the placed image field, then place it again using 

the Data Field tool as described in “Adding Text and Stacked Pages 

for Internal Data” on page 7-18.

Each image from the external data file appears on the appropriate 
stacked page.
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Creating a Data List 
Once you have created a data object, you can create a data list on any page. The data 

list, in turn, allows you to create stacked pages, one page for each row in the list. 

When you have finished, NetObjects Fusion automatically adds data list icons to the 

first column in the data list. The data list thus acts as a table of contents—each row 

contains data for, and is linked to, a single stacked page.

This procedure assumes you have already created a data object. If not, see “Creating 

a Data Object for Internal Data” on page 12-5 or “Creating a Data Object for 

External Data in Windows” on page 12-8 for details on creating data objects.

To create a data list

1. In the Page view, display the page on which you want to place the 
data list. 

2. On a Windows system, click the Data List tool and verify that the 
standard secondary Data List tool is selected. On a Macintosh, simply 
click the Data List tool.

3. Draw a rectangle in the page body.

The Data Publishing dialog appears. It displays the available data objects 
and the fields of the selected data object. 
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4. Select the data object you want to use for this data list.

NetObjects Fusion lists the data object fields in the Fields list box.

5. Choose a field to sort the list.

NetObjects Fusion will display the records sorted in ascending order.

6. To filter the data, click Set... next to Filter.

By default, NetObjects Fusion displays all available records in the data 
list and on stacked pages. A filter selects a subset of the available records 
to display. You can create selection criteria that isolates exactly the 
records you want to appear in your data list.

NetObjects Fusion displays the Query dialog box.
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7. Enter your selection criteria and click OK.

NetObjects Fusion returns you to the Data Publishing dialog.

8. In the Data List area, enter a name for the data list.

9. In the Fields list, select fields to include in the data list by clicking the 
check boxes to the left of the fields.

As a shortcut, you can click the Add All button, which marks all fields for 
display. Typically, however, you display only a subset of fields in the data 
list and display all fields on stacked pages.

10. To link a field to its stacked page, select the field and click the Link/
Unlink button.

A data list automatically includes a navigation button at the left of each 
row that links to the record’s stacked page. When you link a field, your 
site visitor can click either the button or the linked field to jump to the 
record’s stacked page.

11. To change the order in which fields appear left to right in the data list, 
click a field and then click the up and down arrow buttons.

Continue to select fields and press the up- and down-arrow buttons 
until the list is in the order you want.
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12. To set options for creating stacked pages:

● Select the Display all fields option to automatically place all fields 

available in the data object in a simple layout when NetObjects 

Fusion creates the first stacked page. This shortcut can save you the 

effort of placing fields individually as described in “Designing the 

First Stacked Page” on page 12-19.

● Select the Add navigation buttons option to automatically place 

relative navigation buttons in a simple layout when NetObjects 

Fusion creates the first stacked page. This shortcut can save you the 

effort of creating these buttons as described in “Adding Navigation 

Buttons for Stacked Pages” on page 12-22.

13. Click OK.

NetObjects Fusion displays the data list placeholder, which presents as 
column heads the names of the fields you selected for display and a data 
list button at the left of the first row. This is enough information for you 
to use the Properties palette to specify the appearance of your data list. 
NetObjects Fusion populates the data list only when you preview or 
publish the page. Data never appears in the data list in Page view.

14. Click the data list to see the Data List tab in the Properties palette.
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Adjust the settings on the Data List tab to change the bullet type, 
background color, border size, and spacing of the data. You can also 
mouse over the column heading borders and drag them to set column 
width.

When you are satisfied with the appearance of your data list, go on to 
creating a layout for your stacked pages as described in the next section.

Field names 
identify columns 
of data.

Data List icon uses 
the style of the 
current SiteStyle.
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Creating Stacked Pages
Stacked pages are individual pages that correspond to the rows of data in a data list. 

When first created, there is only one stacked page, on which you create the design 

for all of the subsequent pages in the stack. Each subsequent stacked page starts with 

the same layout as the first stacked page. If you later rearrange and modify the 

layout on any stacked page, the new layout applies to all the stacked pages.

Stacked pages also correspond to records in a database. When you store information 

internally in NetObjects Fusion, each stacked page lets you enter data into the fields 

of the data object. If you are drawing information from an external data file, each 

stacked page displays information from a single record.

Note: You can add or delete stacked pages for internal data as described in “Adding 
Text and Stacked Pages for Internal Data” on page 12-22. However, to add or delete 
records for external data, make the changes in your external database or spreadsheet 
application and then republish your site.

Designing the First Stacked Page
The first stacked page determines the initial layout for all the stacked pages. Data 

fields and non-data elements (text, pictures, or other assets) added to the layout of 

the first stacked page are repeated across all the stacked pages. In addition, layout 

changes made to any stacked page are automatically applied to all pages in the stack.

To design the first stacked page

Unless you selected the Display All Fields option when you created your 
data list, NetObjects Fusion displays a blank page. You can add text and 
graphic elements to this page, just like any other page. The key items to 
be added, however, are the data fields you have defined in the data object 
and have included in the data list that has spawned this set of stacked 
pages.
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1. Click the Data Field tool and draw a rectangle in the body of the stacked 
page.

NetObjects Fusion displays the Data Field dialog box, so that you can 
choose which field you want to display in the area you have drawn. The 
fields available are those in the data object you have used for the data list.

Stacked page 
navigation 
buttons

Drawi ng an area 
for a data field

Data Field tool
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2. Select a field and then click OK.

● If you are using external data, NetObjects Fusion displays simple 

text field data from the first record in the data file. To import 

images, see “To import images from an external data source” on 

page 12-13. 

● If you are using internal data and selected an image file field, 

NetObjects Fusion displays the Open file dialog box. Select the file, 

and then click OK.

● If you are using internal data and selected a simple or formatted 

internal text field, NetObjects Fusion displays a blank field. See 

“Adding Text and Stacked Pages for Internal Data” on page 12-22 

for details.

3. Add additional data fields, until you have placed as many as you want. 
Add text blocks to label your fields, lines and other graphics until you are 
satisfied with your layout.

4. If your stacked pages reference external data, you can use the Display 
Next and Display Previous Stacked Page buttons (left and right arrows) 
on the secondary control bar to scroll though all pages in the stack.
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Adding Navigation Buttons for Stacked Pages

To add navigation buttons for stacked pages

Next and previous buttons simplify navigation between stacked pages. You can 

automatically add navigation buttons when creating your data list as described in 

“Creating a Data List” on page 12-14, or you can create custom navigation aids by 

drawing or importing buttons, as described below.

1. Add an element to serve as a button. 

You can place text, draw a button using the Draw tool, or import an 
image using the Picture tool. The Parts\Design Parts\Buttons folder 
contains pictures specially designed for page links.

2. Select the element.

3. Click Link in the element properties palette.

4. Click the Smart Link tab.

5. Select the Next Stacked Page and then click Link.

Adding Text and Stacked Pages for Internal Data
For internal data you enter into NetObjects Fusion, you create a stacked page for 

each record you want to create. Each additional stacked page has the same layout of 

data fields and non-data elements you have placed on the first stacked page.

Once you have created the first stacked page, you can add additional stacked pages. 

You can create as many new stacked pages as you want. Each stacked page creates a 

row in the data list on the data list page, so it is a good idea to create the same 

number of stacked pages as the number of items you want to display. You can add 

and delete stacked pages for internal data whenever you want.

Note: You cannot add or delete stacked pages associated with an external data object. 
To add or delete records when data is stored externally, you must use your external 
database or spreadsheet application and republish your site.
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To create additional internal data stacked pages

1. On the first stacked page, click the Add New Stacked Page button in the 
secondary control bar.

NetObjects Fusion displays a duplicate stacked page with blank data 
fields.

2. Enter data in the data fields.

3. To add an image file in a image file field, double-click the field.

When data has been added to the stacked pages, the data list can display 
it. Preview the data list page to see how it will look in your browser.

Add new 
stacked page.

Delete this 
stacked page.

Display previous 
stacked page.

Display next 
stacked page.
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Managing Assets 13

NetObjects Fusion performs many housekeeping tasks for you behind the scenes. 

This includes keeping records of all the files, links, data objects, and variables used in 

your site. The Assets view lets you see and manage the assets associated with your 

Web site and navigate to the pages on which they appear. It lets you delete unused 

assets and verify the location of assets that are in use. Because NetObjects Fusion uses 

aliases for files and external links, you can globally replace an item that appears on 

several pages, such as a picture, an applet, or an external link, by replacing it once in 

the Assets view. When you have inserted a variable in different text blocks on 

different pages, you can edit the value of the variable in the Assets view and 

NetObjects Fusion updates all instances of the variable throughout your site 

automatically.

This chapter describes the features of the Assets view, including

● managing files

● managing links

● managing data objects

● managing variables

● asset management tips
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When you open the Assets view, choose which kind of asset to view by clicking one 

of the four buttons in the secondary control bar. You can sort a list by clicking a 

column heading, and you can change the width of any column by dragging the 

column divider to the left or right.

Figure 13-1. The Assets view

For each file in your site, the Assets view lists

● Name

● Type

● In Use

● Location

● Size

● Date

● Verify Status

Click to see files, links, 
data objects, or 
variables.

Sort by clicking the 
column heading.

Drag the column 
divider to change 
column width.
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For each link used in your site, the Assets view lists

● Name

● Link To

● Type

● Verify Status

For each data object used in your site, the Assets view lists its name.

For each variable, the Assets view lists

● Name

● Type

● Contents

Managing Files
When you click the Files button, the Assets view displays a list of all the files 

associated with your site, both external files and those generated by 

NetObjects Fusion.

File types include:

● HTML

● images

● sound 

● video

● applets/plug-ins

Image files that you place on stacked pages to populate an internal data object do 

not appear in the Assets view. You can manage such files directly on the stacked 

pages. For complete information about data objects and stacked pages, see 

Chapter 12, “Data Publishing.”
Managing Assets 13-3



M A N A G I N G  F I L E S
Editing Files
NetObjects Fusion lets you give assets custom names that are easy to keep track of. 

For example, you can identify an asset by its function rather than just by its filename. 

You might need an image asset that points to the right. You can name this asset 

“Point Right,” use an image file of an arrow, and place it on several pages. If you later 

want to change the image to that of a pointing finger, you just edit the file asset so 

that Point Right uses the pointing finger image file. NetObjects Fusion automatically 

changes the image on all the pages that include the Point Right image asset.

You can edit the name of any file, and you can substitute one file for another. You 

can delete a selected file asset or add a new one. With a single command, you can 

delete all the files that are no longer used in your site. In addition, the File dialog 

displays a list of all the pages in the site on which a file is used. This lets you display 

a relevant page immediately. 

To edit file information

1. Double-click the file in the Assets list.

The File dialog appears:

2. To substitute a new file, click Browse… (Windows) or Select (Macintosh) 
to choose the new file.

List of pages that 
use the file
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The Image File Open dialog appears. In Windows, select a new file from 
the Folders tab or an existing asset from the Image Assets tab. On the 
Macintosh, choose New from File or New from Asset in the dropdown 
list above the Thumbnail region and select a file.

NetObjects Fusion replaces the old file on every page on which it appears.

3. To change the name NetObjects Fusion uses for this asset, change the 
name in the Name field.

To display a page on which a file is used

1. Double-click on an asset to open the File dialog.

2. Select the page you want to see in the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.

To add a file

1. Choose New File Asset… from the Edit menu or press Insert (Windows) 
or zN (Macintosh).

2. In the File dialog that appears, click Browse… (Windows) or Select 
(Macintosh) and select your file.

3. Edit the asset name if you wish and click OK.

If your new asset is an image file, the asset appears on the Image Asset 
tab (Windows) or the New from Asset list (Macintosh) of the Image File 
Open dialog the next time you place or change an image.
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To delete a file

1. Select the file you want to delete and choose Delete File Asset from the 
Edit menu or press Delete.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the selected file. You cannot undo this 
operation, but you can use the New File Asset command to restore the 
file asset if you wish.

To delete all unused files

1. Choose Delete All Unused File Assets from the Assets menu.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes all the file assets whose In Use indicator is 
not Yes. You cannot undo this operation, but you can use New File Asset 
commands to restore any file assets you want. 
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Verifying Files
Verification determines whether all file assets are in their expected directories and 

lets you reset their paths if necessary.

To verify all file locations

1. Choose Verify All File Assets from the Assets menu.

NetObjects Fusion verifies and reports the path status of all files. 

● When a file’s path information is correct, Assets view lists the date 

and time found in the Verify Status column.

● When a file’s pathing information is incorrect and the file or folder 

cannot be found, verification presents this dialog:

2. Resolve the paths of any lost files or folders.

● To specify a new path, click Browse… (Windows) or Select 

(Macintosh) and locate the file or folder. 

● To skip this lost item and continue verification, click Skip. 

Verification gives this file Not Found status and goes on to verify 

any subsequent files or folders.

● To stop the verification process, click Cancel. The verification status 

of the current file or subsequent files is not updated.

3. When verification is complete, click OK in the confirmation dialog.
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Managing Links
When you click the Links button in the secondary control bar, the Assets view 

displays a list of all the links used in your site: external links, internal links, and 

structural links. An external link is a link to a file or address that is outside of your 

Web site’s file structure. This could be a mail address, the URL for another Web site, 

or a file located elsewhere on the server. An internal link is a link within your site 

from one page to another. An anchor is an internal link attached to a specific 

location on a page. A structural (Smart) link is a link to a page in a specific 

hierarchical relation to a particular page: for example, to its parent page. If you 

move a page with a Smart link, the link automatically changes to link to the page in 

the same relation: for example, to its new parent page.

Figure 13-2. List of Links in the Assets View

Links between entries in a data list and their associated stacked pages do not appear 

in the Assets view. You can manage such links directly on the data list pages. For 

complete information about data lists, see Chapter 12, “Data Publishing.”
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Editing Links
You can edit the name and destination of any link. You can change an external link if 

its URL changes. In addition, the Links dialog shows you the list of pages in the site 

on which each link is used.

External links and mailto addresses that exist on several pages in your site can be 

updated centrally.

To update an external link

1. Double-click the external link you want to update.

The Links dialog opens.

2. Change the name in the Name field if desired.

3. Change the URL in the Link To field and click OK.

To display a page on which a link is used

1. Double-click the link in the Assets view.

2. In the Links dialog, select the page you want to see in the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.

List of pages that 
use the link
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To add a link

1. Choose New Link… from the Edit menu or press Insert (Windows) or 
zN (Macintosh).

2. In the Link dialog that appears, enter a name and destination for your 
link and click OK.

To delete a link

1. Select the unused link you want to delete and choose Delete Link from 
the Edit menu or press Delete.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the link. You cannot undo this operation, 
but you can always use the Add Link command to restore it if you wish.

Verifying Links
Verification determines whether all link destinations can be located.

To verify all links

1. Choose Verify All Links from the Assets menu.

NetObjects Fusion displays a progress bar as it verifies and reports the 
status of all link destinations. It accesses the Internet via the default 
connection of your browser to verify external link references.

● When a link’s destination can be found, Assets view lists the date 

and time validated in the Verify Status column.

● When a link’s destination cannot be found, the Verify Status column 

describes the problem.

When verification is complete, the status bar disappears.

2. Resolve the destinations of any broken links by double-clicking the link 
and editing it as described in the previous section.
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Managing Data Objects
Data objects are collections of fields of data. You can use a data object to publish 

data without using CGI scripts or database programming. For complete details 

about data objects, including how to create them in Assets view, see Chapter 12, 

“Data Publishing.”

When you click the Data Objects button in the secondary control bar, the Assets 

view displays a list of all the data objects used in your site.

Editing Data Objects
You can edit the name and field names of an internal data object as well as add new 

fields. Assets view can display these values for an external data object and you can 

change field types, but you cannot edit field names or add new fields.

To edit a data object

1. Double-click the data object in the Assets view.

The Data Object dialog for that data object appears.
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If this is an internal data object, you can edit it as described below.

2. Change the name of the data object by highlighting it and retyping.

3. To display the Data Field dialog, double-click the field in the list of fields.

4. Edit the field name in the Data Field dialog.

5. To add another data field, click the + button.

To delete a data object

1. Select the unused data object you want to delete and choose Delete Data 
Object from the Edit menu or press Delete.

You cannot delete a data object that is in use.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the data object. You cannot undo this 
operation, but you can always use the Add Data Object command to 
restore it if you wish. To learn how to use the Add Data Object 
command, see Chapter 12, “Data Publishing.”
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Managing Variables
Text variables make it easy to update text that appears throughout your site. 

NetObjects Fusion provides standard variables, such as the date and time the site 

was created or last modified. You can also create your own variables. In Assets view, 

you can edit, create, and delete user-defined variables. See “Inserting Variables” on 

page 4-11 to learn how to place variables.

To edit a variable

1. Double-click the variable in the Assets view.

The Edit Variable dialog appears.

2. Edit the name and value of the variable as you wish and click OK.

If you edit the value of the variable, NetObjects Fusion updates all text 
blocks containing that variable with the new value.

To add a variable

1. Choose New User Defined Variable… from the Edit menu or press Insert 
(Windows) or zN (Macintosh).

2. In the New Variable dialog, enter a name and value for your variable and 
click OK.
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To delete a variable

1. Select the unused variable you want to delete and choose Delete User 
Defined Variable from the Edit menu or press Delete.

Do not delete a variable that is in use.

2. In the dialog that appears, click Yes to confirm the deletion.

NetObjects Fusion removes the selected file. You cannot undo this 
operation, but of course you can use the New Variable command to 
restore the variable if you wish.

Asset Management Tips
You might have a particular image file, such as BuiltByNOF.gif, located in several 

different Assets folders. This means you might end up using the identical file from 

different locations: for example, on one page, you use a BuiltByNOF.gif located in 

your site’s Assets folder, and on another page, you use a BuiltByNOF.gif located in 

the original template’s Assets folder. When you stage or publish the page, 

NetObjects Fusion automatically creates a duplicate folder for each instance of a 

BuiltByNOF.gif that has a different path. To avoid this duplication, use only one 

instance of a file throughout your site. The Assets view makes checking and 

correcting this problem an easy task.

The verification feature can only check links for which you have direct read access. It 

might not be able to verify destinations that are on the other side of a firewall or a 

proxy server.

When you stage or publish your site, NetObjects Fusion copies the assets listed in 

the Assets view to the target server. If you subsequently delete assets and update the 

site, NetObjects Fusion does not remove the no-longer-used asset files from the 

server folders. You must use an FTP utility program to remove any stale asset files 

from your server.
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Staging and 
Publishing a Site 14

When you’ve completed your site, you’re ready to publish it as a series of HTML 

pages and associated assets. NetObjects Fusion allows for two types of publishing: 

test staging and final Web-server publishing. Staging is when you set up a site for 

testing or review. You can use your hard disk as a server, use a local-area network 

(LAN), or stage in a restricted-access location on a Web server. Publishing is when 

you upload the finished product to your final Web-server site. The only difference 

between staging and publishing is the final location of the site.

During staging or publishing, NetObjects Fusion takes the site file (.nod) and 

creates the following on a server that you specify: a home page in HTML format; a 

folder containing all the other HTML pages; and, a folder containing all the 

associated assets (for example, pictures, applets, auto-generated images).

NetObjects Fusion uploads the finished site to any Web server using a built-in File 

Transfer Protocol (FTP) client. The Web server must include FTP server capability.

This chapter discusses how to use the Publish view, including

● staging

● publishing

● creating modified sites

● example Internet Service Provider (ISP) settings

● publishing special files

Note: NetObjects Fusion HTML works with any Web server. No special Web-server 
extensions are required.
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Figure 14-1. The Publish view

Configuring your Publish settings is simple, and NetObjects Fusion saves your 

settings for future use. Your configuration shows NetObjects Fusion where your 

servers are and how you want to publish your site. Once you set these parameters, 

you can stage or publish with a single click.

Staging
Before you make your site available to your final audience, it’s a good idea to test it 

on your hard disk, a LAN server, or a “closed” Web server. This is called staging. 

Staging is similar to previewing, except that you can stage your site on a remote 

server—not just on your local hard disk. Staging is also different from previewing, 

because it collects all the assets required for your site and places them in the final 

folder structure.

By staging your site and exploring its structure, you verify that the design is sound. 

When you stage your site on a remote server, you can make it available for others for 

review without revealing it to everyone. To protect the raw site from premature 

access by others, choose a staging server that is inaccessible to your final audience.

Click Stage to 
test your site on a 
local or remote 
server.

Click Publish to 
publish your site 
on a local or 
remote server.

Click Settings… to 
configure staging, 
publication, and 
site versions.
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To configure for staging

1. Click the Publish button in the Control bar.

2. Click Settings….

The Stage tab of the Configure Publish dialog appears: 

3. Choose whether you want to stage the site to a local or remote location.

● For local staging, use the default path Net Objects Fusion 2.0\User 

Sites\mysite\Publish. Or, click Browse… (Windows) or Select… 

(Macintosh), choose a folder on your hard disk or LAN in the dialog 

that appears, and click OK. On the Macintosh, click the Select 

folder name button.

Note: Do NOT locally stage to the root of your hard disk or the root of 
your original site name folder. Use the default path or create a separate, 
empty folder on your hard disk just for local staging.

● For remote staging, click the Remote radio button, click 

Configure…, fill in the fields in the Remote dialog, and click OK.
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Note: This information is specific to your Web server. Contact your 
Internet Service Provider (ISP) or Web server administrator for the 
precise information to enter in these fields. For guidance on the 
questions you need to ask, see “About Your ISP Account” on page 14-14.

4. Select the file options that suit your staging server platform:

● The name of your home page determines the URL of your site. On 

some servers, you can publish the home page as Index to allow the 

URL to end with a hostname or folder name such as http://

www.netobjects.com. If you use the current page name instead, it 

will have a URL such as www.netobjects.com/mypage.html.

● Select .htm or .html as your filename extension. Typically, .html is 

used for Macintosh and UNIX servers and .htm for Windows 

servers.

● The Replace spaces and special characters with underscores option is 

selected by default. When you stage with this option selected, 

NetObjects Fusion converts all spaces and non-alphanumeric 

Enter the name of 
the server.

Enter the complete pathname 
of the folder where the site will 
be published.Enter the complete 

pathname of the 
remote CGI folder.

Enter your user ID.

Click Remember 
Password first and 
enter your password 
in the Password field.

Enter the preferred port if 
different from the default.
14-4 Staging and Publishing a Site



S T A G I N G
characters except periods (.) and hyphens (-) in the assets’ filenames 

to underscores (_). We recommend that you leave this option 

selected. 

● Unless you deselect the Stage changed assets only option, staging 

updates the existing structure with only those assets modified since 

you last staged.

5. When your configuration is complete, click OK.

NetObjects Fusion saves your staging configuration. You do not need to 
reconfigure for the current site unless your staging server changes. 

To stage a site

1. Open the completed site file in NetObjects Fusion.

2. Switch to the Publish view.

3. Click the Stage button in the Publish view window.

NetObjects Fusion generates the HTML and associated files and folder 
structures. It creates the staging site on your local disk or uploads it to 
your staging server via FTP. The root level of the publish site will contain 
the index.html (or other home page) file, an HTML folder, and an Assets 
folder. Modified sites might have multiple index pages and other folders.

4. When the Staging is Complete message appears, click OK.

You can now test the site with your browser, edit the site file (.nod) in NetObjects 

Fusion as needed, and re-stage or publish the site.

If you staged locally, the location of your home page is listed in the Location section 

on the Stage tab of the Configure Publish dialog. If you staged remotely, the URL of 

your home page is the Remote Host and Base Directory as listed in the Remote 

dialog (for example, www.domain.com/username/index.htm).
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Publishing
When your design is complete and you’ve verified that everything in your site 

functions properly, you’re ready to publish it. Publishing generates the HTML and 

associated files and folder structures and uploads them via FTP to your Web server.

To publish your site to an intranet, be sure to choose a Web server that resides 

behind your firewall. This protects the private content of your site from 

unauthorized viewing. 

To configure for publication

1. Click the Publish button in the Control bar.

2. Click Settings….

The Configure Publish dialog appears.

3. Click the Publish tab.

The Publish tab appears:
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4. Choose whether you want to publish the site to a local or remote 
location.

● To publish your site locally, click Browse… (Windows) or Select… 

(Macintosh) and choose a folder on your hard disk or LAN.

Once you find the folder you wish to locally publish to in the 
Select Folder dialog, click OK. On the Macintosh, click the Select 
folder name button.

Note: Do NOT locally publish to the root of your hard disk or the root of 
your original site name folder. Create a separate folder on your hard disk 
just for local publishing.

● For remote publishing, click the Remote radio button, click 

Configure…, fill in the fields in the Remote dialog, and click OK.

Note: This information is specific to your Web server. Contact your 
Internet Service Provider (ISP) or Web server administrator for the 
precise information to enter in these fields. For guidance on the 
questions you need to ask, see “About Your ISP Account” on page 14-14.

Enter the name of 
the server.

Enter the complete pathname 
of the folder where the site will 
be published.

Enter the complete 
pathname of the 
remote CGI folder.

Enter your user ID.
Click Remember 
Password first and 
enter your password 
in the Password field.

Enter the preferred port if 
different from the default.
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5. In the Configure Publish dialog, select the file options that suit your 
server platform:

● The name of your home page determines the URL of your site. On 

some servers, you can publish the home page as Index to allow the 

URL to end with a hostname or folder name such as 

www.netobjects.com. If you use the current page name instead, it 

will have a URL such as www.netobjects.com/mypage.html.

● Select .htm or .html as your filename extension. Typically, .html is 

used for Macintosh and UNIX servers and .htm for Windows 

servers. If your page requires a special extension such as .shtml, see 

“Renaming a Page” on page 2-10.

● The Replace spaces and special characters with underscores option is 

selected by default. When you publish with this option selected, 

NetObjects Fusion converts all spaces and non-alphanumeric 

characters except periods (.) and hyphens (-) in the assets’ filenames 

to underscores (_). We recommend that you leave this option 

selected. 

● Unless you deselect the Publish changed assets only option, 

publishing updates the existing structure with only those assets 

modified since you last published.

6. When your configuration is complete, click OK.

As with the staging configuration, you only have to enter these parameters once 

unless your publication server changes. With the configuration in place, you can 

publish your entire site with a single click.

Note: An FTP client might not be able to communicate with a Web server that is 
behind a firewall. If so, first publish your site to a local folder other than NetObjects 
Fusion\User Sites\your site name\Preview. Then, transfer all of the locally 
published site files (including any CGI files) to the Web server using an FTP utility. 
Be careful to transfer all files and to duplicate the folder structure precisely.
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To publish a site

1. Open the completed site file in NetObjects Fusion.

2. Switch to the Publish view.

3. Click the Publish button in the Publish view window.

NetObjects Fusion generates the HTML and associated files and folder 
structures. It uploads the site to your Web server via FTP. The root level 
of the publish site will contain the index.html (or other home page) file, 
an HTML folder, and an Assets folder. Modified sites might have 
multiple index pages and other folders.

4. When your site is in place, access it with your Web browser.

The URL of your home page is the Remote Host and Base Directory as 
listed in the Remote dialog (for example, www.domain.com/
username/index.htm).
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Using Site Publishing Options
NetObjects Fusion lets you automatically create alternative versions of your site, 

called modified sites, that are optimized for different browsers and viewing 

preferences. You can have NetObjects Fusion generate a site map in either 

NetObjects Fusion or Apple HotSauce™ format, and you can specify whether you 

want published HTML files to include comments.

To create modified sites

1. In the Publish view, click Settings….

The Configure Publish dialog appears.

2. Click the Modify tab.

The Modify tab appears:
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3. Click one or more of the modified site types:

● Text only will generate a site for browsers that cannot display images 

and for site visitors who prefer not to download image files.

● Greyscale creates a 256-shade greyscale version of your site.

● Low Bandwidth creates a site where copies of your image files are at 

half their original resolution. This will speed download time over 

slow connections or during periods of heavy network traffic.

4. Click OK.

When you publish your site, NetObjects Fusion generates separate file 
sets for each site version including your site as you originally created it:

● HTML for a Text only site will exist in the text_only_html folder. 

The default home page will be index_text_only.html.

● HTML for a Greyscale site will exist in the greyscale_html folder. 

The default home page will be index_greyscale.html.

● HTML for a Low Bandwidth site will exist in the 

low_bandwidth_html folder. The default home page will be 

index_low_bandwidth.html.

You can create an initial page (screen door) that lets viewers choose which modified 

site they wish to view. On this first page, you’ll include manual links to the modified 

sites which have unique URLs.
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To make a screen door

1. Publish the home page of the unmodified site with any name EXCEPT 
index.html.

On the Publish tab of the Configure Publish dialog, set the Publish 
Home Page As option to any name but Index. The names of your 
modified versions will be based on this name.

2. Create a new blank site.

This one-page site will be your screen door. Design this page as an 
introduction to your site.

3. On the screen door, add external links to the different versions. 

These links must reference complete URLs. For example, if your screen 
door is located at http://www.gumball.com/maryanne and you 
named the home page of the unmodified site home:

● Unmodified version: http://www.gumball.com/maryanne/

home.html

● Text-only version: http://www.gumball.com/maryanne/

home_text_only.html

● Greyscale version: http://www.gumball.com/maryanne/

home_greyscale.html

● Low-bandwidth version: http://www.gumball.com/maryanne/

home_low_bandwidth.html

4. Publish the home page of your screen door site as index.html.

On the Publish tab of the Configure Publish dialog, set the Publish 
Home Page As option to Index. The browser will automatically open the 
screen door home page which then presents the links to your visitors. 
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To set publishing options

1. In the Publish view, click Settings….

The Configure Publish dialog appears.

2. Click the Modify tab.

3. To include site maps, select the kind you want.

To learn how to create site maps, see Chapter 10, “Using NetObjects 
Components.”

4. If you like, select the Generate HTML comments option to include 
comments in the HTML file that NetObjects Fusion creates for each page. 

The comments identify the beginning and ending of each page’s head 
and body as well as content elements.

5. Do not set the Skip high ASCII character set conversion option unless 
you are working with special characters and are familiar with all their 
related coding issues and trade-offs.
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Publishing with Internet Service Providers
Web servers are expensive, so many Web publishers rent server space from an 

Internet Service Provider (ISP). The following section will help you get the 

information you need to let NetObjects Fusion communicate with your ISP’s server. 

About Your ISP Account 
To complete the Configure Publish dialog and publish your site to an ISP, you must 

know the answers to the following questions. Your ISP’s site for support pages 

should provide all this information. 

1. Who is your service provider? There are hundreds to choose from (see 
http://home.netscape.com/assist/isp/ispdir.html). Each offers a 
range of services; typically, you sign up for an account. A minimum 
account gives you an Internet access connection, while a higher-level 
account—the kind you need—includes server space for your Web site. 
Most ISPs provide space for you on their server for no extra charge. 
However, there might be size restrictions with the free space and a 
requirement that all your files be in one single folder rather than a folder 
structure. NetObjects Fusion output requires a folder structure.

2. What is the name of your server? Usually your server name is the URL of 
your service provider without the http:// prefix. Most Web servers begin 
with www. So, the name of your server probably looks like this: 
www.yourISP.com. Some ISPs require that you store your files on 
another server. Check with your ISP for the preferred server name. 

My server name: ___________________________________________

3. What is your username and password? You choose these or your ISP 
assigns them when you open your ISP account. 

My username:__________________ password: ___________________

4. How much server space comes with your account? The ISP’s description of 
your account should tell you the maximum space you can use. Before 
you publish, you should stage your site, check its size (the size of the 
generated /Publish folder), and confirm that it takes less space than the 
maximum allowed by your ISP. 
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Note: If you have been working on your site for a while, unused files 
might exist that are not needed in the final version of the site. Drag the 
folder set in the local Stage or Publish settings to the recycle bin before 
publishing your final site. This will ensure that only the necessary files 
are used.

5. In which folder of your ISP’s server are you to store your site files? 
NetObjects Fusion needs to know the path to this folder. Almost all ISPs 
store sites in personal folders. The ISP usually names your personal 
folder with your username. The folder name becomes part of the URL 
for your site. The URL for a site stored in your personal folder might 
look like this: http://www.yourISP.com/~username. 

In many cases, the ISP stores your Web site in a symbolically linked 
folder within your personal folder, often called public_html or html. 
Such a folder is like an alias and does not become part of your URL, but 
it is part of the path. 

Path to my site folder: ___________________________________

6. What HTML filename extension does your ISP use? Web servers typically 
use .html. Due to DOS filename limitations, some HTML files end in 
.htm. Some ISPs map one to the other and some don’t care. If it does 
matter, you must tell NetObjects Fusion which one to use. 

My ISP’s preferred extension: _________________________

7. How will you manage files stored in your site’s folder? In almost all cases, 
you can let NetObjects Fusion manage your site files for you. However, if 
you make certain significant changes to your site, such as changing the 
name of the .nod file, or to remove your site or unused portions from 
the server, you must use an FTP client utility to view and delete the files 
and folders. See “Publishing Special Files” on page 14-17.

8. When it contacts your ISP to publish your site, NetObjects Fusion uses a 
standard FTP port number—21—to establish the connection. However, 
your ISP might support several FTP port numbers in addition to the 
standard, and one of the other numbers might offer better performance. 

My ISP’s preferred FTP port number: _________
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Publish Configuration Example
The following example shows the settings you would use when publishing to the 

UUNET ISP. 

Remote Host. UUNET’s server name is www.uu.net.

Base Directory. UUNET users store their sites in a folder called html within their 

personal folder.

CGI Directory. UUNET allows users to store CGI scripts within their personal 

folders. When this field is filled in as shown above, NetObjects Fusion creates a cgi-

bin folder within the folder. Therefore, the URL used to call CGI scripts in the Web 

pages of this site must be: 

http://www.uu.net/~username/cgi-bin/

For more information about publishing to UUNET, go to http://www.uu.net/

web.htm and click the Frequently Asked Questions link.
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S

Publishing Special Files
NetObjects Fusion does not manage all of the files that you might use with very 

complex sites. The following list discusses some of these exceptions:

Pages not generated by NetObjects Fusion. You might want to link a page in 

your site that, due to it’s complexity or special design, you don’t want to recreate in 

NetObjects Fusion. You bring this type of page into your site as an external .html 

file. See “Using External HTML Files” on page 5-16.

Java Helper Files. Some Java applets use external files not included with NetObjects 

Fusion. Add these files through the List option in the Java Applet Files dialog. See 

“Inserting a Java Applet” on page 8-8.

Files called by JavaScript. Some JavaScripts write raw HTML code. This code 

might call for another HTML page or an image file. Because the script itself is not 

generated by NetObjects Fusion, any file called in the script is not managed by 

NetObjects Fusion. Add the file to the Publish folder so it will be automatically 

uploaded. Make sure that the JavaScript points to the correct file location. 
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